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adopté. Bien gu'une premiére mouture ait te vali-

Rhythmbox : nouvelle mise a jour

14 KDE

14 Cryptographie, signature et gestion
de clés sous KDE

16 Lexploration de la Terre avec Marble
17 Command Watch affiche en continu

le résultat d'une commande sur
votre bureau

18 Soundkonverter, nouvelle version :

la musigue facile sous KDE !

dée début juillet par les différents comités charges
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ne lachez plus ce magazine et libérez voire esprit
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- dans un terminal et compiier vous-méme vos prcngrammes

- Optlmisahcﬂ du programme et un qysteme plus personnahs

UNE ANNEE AVEC
GNU/LINUX POUR
LASSEMBLEE NATIONALE

Aprés un an d'utilisation d'Ubuntu a I/Assemblée Natronaie trois deputés
confient leur rapport d'expérience a Berirand Lemaire de CIO Online. Au
terme de cetie année, il s’avere que les utilisateurs se sont adapiés assez
rapidement a leur nouvel environnement au point que certains stages pré-
vus pour cetie adaptation n'ont finalement pas été nécessaires. Certaines
permanences parlementaires ont méme elles aussi passé le cap de luiili-
sation de logiciels libres. Une nouvelle fonctionnalite est appreéciee, celle
de lagenda partagé. qui permet de consulter son agenda sur un téléphone
portable. Linteropérabilité, possibilité pour différents systemes de commu-
niquer entre eux, est egalement un point positif mis en avant.

Ces refours dexpériences positifs devraient permettre a dautres de refle-
chir sérieusement a une migration sous un systéme GNU/Linux.

[7] Sources ;

www.april.org/grou pes/institutions/migration-postes-deputes/
retours-experience cio-online html

www.cio-online.com!entretiensﬂire-trois-deputes-face-a-]inux-
281.html

UNE NOUVELLE VERSION DU
JEU DE COURSE AUTOMOBILE
ULTIMATE STUNTS

Utimate Stunts est un jeu de course automobile
en 3D, remake du jeu DOS, Stunts. Il se carac-
térise par la possibilité d effectuer des loopings
et divers sauts. Le jeu propose un éditeur de
circuit, ce qui permet de ne pas se lasser des
parcours proposes.

La derniére version 0.7.5 améliore I'éditeur
de piste et rend les voitures plus maniables.
Utimate Stunts est un jeu sous licence GPL.
Son installation passe par la compilation des
sources et l'installation au préalable des biblio-
théques SDL, SDL_image, libopenal-dev et
libalut-dev.

-Sn vous souhaitez essayer une nouveiie d;stribution GNUH_mux _ pau SErT 3
quoi ne pas s'essayer a Gentoo qui vient de sortir une version stable ; M Site du jeu : www.ultimatestunts.nl
'Gemoo 2008.0. Gentoo vous conwendra St vous aimez. passer du
n effe ,__tout
';nsta!iat!on seffectue par. la compilation des SOUrCes pour Lne meﬂleur

Configure Player:

P |,er Type: Hunan
L Aioimo e

. Cetle nouvpiie version apporte une nouvelle version du syste istri
~ bution de fogiciels Pcrtage lenoyau2 6 24, gcc41 2.glibc26. et le chalx
o .-de }envlronnement graph;que sur le iwe CD passe de Gn_ me a Xfce.

car
taarbox
Choose
Delete
Ready

Ei Source www.gemoo orgfnewsf
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TUXFISHER

Un nouveau jeu demandant un peu de reflexion est disponible sous GNU/Linux. TuxFisher

ressemble au jeu Rocksndiamonds. On guide ici un Tux au travers de chemins enneiges 5 3 CE ﬂ &
dans le but de ramasser tous les poissons qui y sont parsemés. Mais attention, le parcours bl g s &
est parsemé de boules de neige qui ne doivent pas vous tomber dessus ! En effet, ces ' TRl PR R RER
boules de neige sont bloguées par les chemins de neige, mais, dés que l'onimarche des- el g\\ g gwy&
sus, la neige s'aplatit et laisse tomber les boules. Attention a ne pas se retrouver piege par e N AR S
une avalanche ! Plusieurs niveaux de difficulté sont proposes, ainsi que plusieurs cartes : & e &
différentes selon les niveaux. : e el ﬁ f

Le jeu est disponible pour Windows et GNU/Linux o il peut &tre téléchargé sous la forme e L E%M&\M&\

d’un paguet RPM ou sous forme pré-compilée (il suffit de decompresser I'archive, puis de
lancer le fichier TuxFixher),

Un jeu prometteur qui ravira les amateurs de petits jeux de réflexion.

i Site du jeu : www.tuxfisher.net

OLPC, ~ _  MOZILLA DANS LE
'DONNEZ VOS IDEES t | | \yRE DES RECORDS !

Dans le but de promouveir le projst OLPC (One Laptop Per Child)
~ enFrance, un concours a été mis en place - il estorganisé du fer
 juillet au 15 septembre. Pour: appel, le projet OLPC a pourobjec-
 tif de distribuer des ordinateurs 4 des enfants dans un but éduca-
tif. Uordinateur en question est I'XO identifiable & sa couleurvert
_ pomme et 3 ses deux pefites oreilles présentes sur chague cote
. de l'écran. Le projet avait organisé aux Etats-Unis et auCanadale
 programme G1G1 qui permettait d'acheter un ordinateur XO pour
e prix de deux : I'un revenait a Facheteur ot Fautre étaitdestinea
~unenfant dun pays en voie de développement Cette operation

Linux Pratique Essentiel

"__t_ine-'-_idée_:d_e-.'p_;ojet-_q;z_i _ 3 but éducatif, iInnove gp-prq_.—.'_
~ mouvoirle projet OLPC. Les propositions peuvent étre envoyees
- jusgu'au 24 aolif et les gagnants se verront remetre des ordin s

~ teursXOen vue d'étre utilisés dans le projet a été proposé.

refox 3 avec succes fe
a0B

cord du monde.

m __'SOUR'CBS'Z': . L 7

- http:liolpc-france.org
A l'approche de la sortie de Firefox 3, on pouvait voir sur quel-
ques sites une invitation & faire une promesse de telechar-
gement du navigateur & un jour donné. En effet, pour pro-
mouvoir sa sortie, Mozilla a souhaité établir le premier record
.du nombre de téléchargement d'un logiciel en 24h. Alors que
1.7 millions de personnes dans le monde avaient fait cette
promesse de téléchargement, plus de 8 millions de téléchar-
gements ont eu lieu le 17 juin, jour du Download Day et plus
exactement 8,002,530 Firefox 3 ont &té télécharges. Mozilla
entre ainsi dans le Livre Guinness des records. Les personnes
ayant contribué a ce record peuvent télécharger un certificat
pour montrer leur participation.

http:/lolpc-france.org/reglement.html

] Source: www.spreadfirefox.com/friworldrecord

#3 Linux Pratique Essentiel 5




“ MONT-DE-MARSAN.

LIBRE ET FIERE
DE LETRE !

Créces en 2000, par I'Association Bordelaise des
Utilisateurs de Logiciels libres (ABUL), les Rencontres
Mondiales du Logiciel Libre (RMLL) sont l'occasion cha-
que année, pour la communauté du Libre, de se retrouver
pour travailler ensemble sur des projets et faire découvrir,
au grand public, les logiciels libres ; tout ceci par l'intermé-
diaire de conférences et d'ateliers.

Et cette année, c'est la ville de Mont-de-Marsan qui a eu
le plaisir d’accueillir cette manifestation. Ah quelle douce
région que Les Landes (oui je sais, c’est un département,
mais c'est une expression 14 vous voyez...) ! Locéan (un
peu loin de Mont-de-Marsan malheureusement...), le
canard, le floc de Gascogne, le canard, les kiwis de I'Adour,
le canard, le béret Basque et 'accent du sud-ouest... Prés
de 8H de train, c'est le temps qu'il nous a coté pour nous
rendre aux 9émes RMLL. Mais le jeu en valait vraiment
la chandelle !

Un accueil chaleureux et souriant, d'apparence détendue,
malgre le stress dans lequel tous les membres du comité
d'organisation évoluait depuis des jours. J'en profite pour
remercier & nouveau Jean-Christophe Elineau, président
du comité d'organisation et président de Landinux, ainsi
que toute son équipe, sans oublier les étudiants de I'lUT
informatique de Mont-de-Marsan, qui ont mis tout en
ceuvre pour que ces 9émes RMLL se déroulent sans la
moindre anicroche. Une organisation irréprochable, une
equipe soudée et motivée, une chaleur humaine incon-
testée, sans oublier la gastronomie locale sont la recette
d’'une telle réussite.

Le village des associations des RMLL 2008, installé sous un barnum en plein coeur du
site. L'occasion pour des centaines de visiteurs d'en savoir plus sur les logiciels fibres.

Car oui, avec plus de 4000 inscrits, on peut parler de vraie
réussite | Et la manifestation a également accueilli des
visiteurs d'autres pays (oui, elles sont bien « mondiales »
ces rencontres, non ?) ; pas moins de 40 nations étaient
representées sur le site de Mont-de-Marsan, dont une
délegation tunisienne (impliquée dans la promotion des
logiciels libres en Tunisie) et le CHALA (Club des Hommes
et Femmes d’Affaires du Libre en Afrique), organisateur
des RALL (Rencontres Africaines du Logiciel Libre).

Richard M. Stallman était également présent sur les lisux
et a pris place au repas du Libre parmi les 400 autres parti-
cipants. Pour le plus grand plaisir de tous, il s'est ainsi mélé
a la foule pour vendre (avec beaucoup de succes diailleurs)
ses gnous en peluche... Ces 9émes RMLL ont également
eu 'honneur de recevoir Henri Emmanuelli, député PS
des Landes, Président du Conseil Général des Landes

Madarmne le Maire de Mont-de-Marsan profite du discours d'ouverture pour annoncer fa
migration de la municipalité vers du 100% Libre.
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Une partie de Iz rédaction de GNU/Linux Magazine France et Linux Pratique aux cotés de

Richard M. Stallman.

o

| a fanfare municipale venue jouer quelques morct

ux fraditionne

Jg fe soir du repas du Libre.

ACTUS

et Conseiller Général du canton de Mugron, qui est
quand méme resté — soulignons-le — toute une apreés-
midi sur les lieux. Sa venue était notamment l'occasion
d'un &change constructif autour d’une table ronde, &
laguelle ont pris place a ses cotés Jean-Christophe
Elineau, Jacques Marsant, directeur de Landes
Mutualité et Benoit Sibaud, président de 'APRIL.
Pour s(r que ces 9&me RMLL ne sont pas passees
inapergues dans la sphére politique...

Comme a I'’habitude, chacun pouvait y trouver
son compte parmi les thématiques proposées:
Accessibilité, Collectivités locales, Education,
Solutions d’entreprises, Loisirs numériques, Sante,
Sécurité, Web, Embarqué, etc. Certes, la plupart des
visiteurs appartenaient plus ou moins a la sphére du
Libre, mais le « grand public » n'était pas laissé sur le
carreau : de nombreux ateliers de découverte étaient
a leur disposition, de méme gue certaines conferen-
ces dont le sujet était, disons, moins « peintu » que
d'autres. Un grand bravo au passage a l'équipe Iprod.
org, qui, au travers d'une série d'ateliers tout a fait
cohérente, a permis a des utilisateurs débutants de
se familiariser avec les meilleurs outils libres pour
réaliser un montage vidéo (jusqu'a la production
du DVD...).

Des scoops ? Oui, il y en a eu et pas des moindres :
Madame le Maire de Mont-de-Marsan a annonce lors
du discours d’ouverture que la municipalité allait migrer
entierement vers des logiciels libres. Presque une évi-
dence finalement, lorsque I'on prend conscience des
intéréts a la fois culturels, économiques et sociaux
d’une telle démarche.

Bien entendu, lors de cette édition 2008 fut annoncée
la prochaine destination des RMLL : il s'agit de la ville
de Nantes. Un autre climat, un autre joli coin de notre
beau pays. Les Landais ont mis la barre haute, mais
le défi est relevé pour 2009... B

Fleur Brosseau

I'abus d'aleool est dangereux pour (a santé...
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GNOME DANS LERE DE LA DECADENCE

par Dave Neary

Ce mois-ci, Andy Wingo a lancé un pétard [1]
sur Planet GNOME [2] : selon lui, l& projet
serait en train de stagner sur ses acquis,
plutdt que de chercher des nouveautés qui
pourraient avoir un impact important sur l'ex-
périence utilisateur.

Les réactions n'ont pas tardé — plusieurs per-
sonnes ont exprimé leur accord avec Andy,
dont Alex Graveley [3], auteur de Gimmie {4]
et créateur du projet Pyro [5], grand espoir
pour beaucoup de monde, qui a été décu
par le peu d'intérét qui a été accordé a ses
projets...

D’autres, comme Luis Villa [6] ou Havoc
Pennington [7] ont rappelé que ce n'est pas la
premiére fois que cette discussion a lieu. En
effet, depuis quatre ans maintenant, depuis la
présentation de Nat Friedman a Kristiansand
en 2004, « Swinging the Pendulum » [8}, ce
sujet revient régulierement.

Luis considére qu'il y a une belle opportu-
nité pour intégration de services web libres
4 des applications du deskfop et Havoc
considéere toujours qu’'une premiére étape

| Le projet GNOME a eu une présence
| considérable a LinuxTag 2008. Laconfe-
rence la pi.xs importante d ‘Allernagne;

. sest tenue du 28 au 31 mai a Berlin -
Hormis le stand GNOME, des membres

de la communauté étaient presents SUT

' des stands comme OpenSuse, Fedora,
Ubuntu Maemo ei_ GPE (GPE Pnimmp :

Env.-ronn ent}

e 'Jeud; Ie "9 Joumne Maemu tplateforme- :
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obligatoire pour fixer un cap est d'identi-
fier le public ciblé par le projet.

Encore d’autres ont affirmé qu'ils « s'écla-
tent » toujours avec GNOME et que les
efforts fournis pour dynamiser le projet
commencent deja a porter leurs fruits [9].

L'avenir n'est pas si sombre que ¢a :
avec des projets comme GTK+ 3.0 [10],
Clutter [11], Telepathy {12], GeoClue [13],
LeafTag [14] et d’autres, GNOME a la
potentiel de proposer des fonctionnali-
tés intéressantes rapidement et de faire
un grand pas en avant pour I'expérience
utilisateur.

Au final, une conclusion a laquelle nous
pouvons difficilement échapper s'im-
pose : ceux qui font le travail sont ceux
qui définissent la direction du projet.
Citation particulierement adaptée d'une
personne sur IRC au milieu de la polémi-
que : « je ferais le travail moi-méme, mais
je suis trop occupé a écrire des billets
dans mon blog expliquant aux autres ce
qu'il faut faire ». ®

~ un client Last.fm pour Naemo et ”paua e
'GNOME et Qu;m Gilia préesente a wszon i
de No}\ia pour ce pm}et Maemo

i Jeudi so;r x,etalt la soirée LmuxTag.
une g:ande fete bien arroséel
._ Malheu:eusen‘ent nouset:ons nombreux b

-avon's:préf eprend quéiques 5
des pizzas enormes el discuter jusquau

En savoir plus

P> [1] GNOME in the age of
decadence : http:/fwingolog.org/
archives/2008/06/07/gnome-in-
the-age-of-decadence

P [2] Planet GNOME : http:/fwww.
planet.gnome

P [3] Alex Graveley - http://
www.beatniksoftware.com/
blog/?p=95

P [4] Gimmie : http://
beatniksoftware.com/gimmie/
Main_Page

B~ [5] Pyro : hitp:/lpyrodesktop.org/
Main_Page

P [5] Luis Villa : http:fitiequy.org/
blog/2008/06/11/decadence/

B [7] Havoc Pennington : http://log.
ometer.com/2008-06_html#11.2

{dit Fu.!ce}r de ¢
tuelies avec des appi
lees (dites applianc
par Noveli

i Oestergaard {% orgamsatr
nee)surla fondato \




P+ [8] Présentation de Nat
Friedman : http://nat.
org/NatFriedman-
GUADEC-5-Pendulum.
SXi

[5] Daniel Siegel : http://
home._c¢s.tum.edu/
~siegel/news/2008_06_
12-awesomeness

P [10] GTK+ 3.0 : http:l/
developer.imendio.
com/sites/developer.
imendio.com/files/gtk-
hackfest-berlin2008.
pdf

P [11] Clutter : http:/i
clutter-project.org/

B [12] Telepathy : http://
telepathy.freedeskiop.
org/wiki/

P [13] GeoClue : http:/f
www.freedesktop.org/
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Camme SOn Nom Imdl—

_ que, Gnome Subtitles
est un éditeur de sous-
tfitres pour 'envirenne-
ment Gnome, il sup-
porte les formats de

 sous-titres les plus cou-

rants (Adobe Encore
DVD, Advanced Sub

" Station Alpha, AG Title,
 DKS Subtitle Format.
 Karaoke Lyrics LRC,
 Karaoke Lyrics VKT,
 MacSUB, MlcroDVD
MPlayer, MPIayar i
MPSub, Panimator, =
- Phoenix Japanimation
- Society, Power DivX,
- Sofni, SubCreator T
SubRip, Sub ‘Station
~ Alpha, SubViewer 1.0

et' 2.0 et ViPlay Subtitle
File} et vous permetira

D0:01:39.088
00:01:33.300

echercha apahuln
tant jour.
Paur triomphes, 4 nous faut des résuftats
publial opglicables,
Lequel dentre vous
hain Eix:

UNIVERSITE DE PRINCETON

SEFTEMBRE 1947

F@, 1. Ledition d’m f:chrerde SCUS-EtEES esr’ Vi armenf smw#e oultez fa fichier,
| puis saisissez directement vos modifications en cliguant dane ie texrsl Presdiune

- winglaine de forr"ars de solrs-titres Sont sUpportes.

d'éditer, de traduire ou encore de synchromser les sous-titres. Apres |nsta!iahon Gnome
Subtitles appara‘i‘t dans le mepu Apphcaf;ons = Son et vidéo.

Lmterface diutilisation est tout a fait conviviale. Cestune interface du type WYSIWYG ( es Sous-

 litres sont affiches dans apercu de la meme maniere que vous les verrez aliécran). Diverses

fonctionnalités sont a votre disposition : mise en forme du texte, fonction cherchet/rempia-
cer, undo/redo de p|u51eurs nivealy, msert:onfsunpressmn de sous-titres dans le fichier. etc.

Pour traduire un ﬂchier de sous-titres, rien de pius simple : ouvrez votre fIChter {menu File

| = Ouvrir), puis rendez-vous dans le menu File -> Translation -> New. Une nouveiie colonne
. apparait dans l'interface du logiciel, pour vous permettre de saisir chaque phrase en Vis-2-vis

“dela phrase originale. i suffit de cliquer dans la ligne pour saisir la traduction
correspondante. Vous pauvez. aussi sampiement éditer le fichier pour rectifier

certains. passages

‘\fia le menu View, VOUS pouvez passer d un affichage basé sur les frames

ot sur le temps. En base de temps, Gnome Subtitles affiche le début, Ia fin
ctla duree de l'affichage de chague sous-titre. Ainsi, vous pouvez aisement

' _corrlger {at synchronisation du texte (via le menu Timings > Adjust et Timings
-> Shift) en decalant fout ou partre des sous- —titres du temps nécessaire.

Quire quetques corrections de bugs, cetile derniere version clut la correc-
tion orthographique (s surlignement des erreurs lors de la frapps, vérification

des sous-titres et traductions en différents langages), Iajout du support pour

"les formats AQ Title, MacSUB. Sefnt. SubCreator 1.x et ViPlay subtitle File,

la possibilite dafficher la tradiction avec la vidéo en plus des sous-titres
originaux et Fauto-détection des formats de sous-titres qui a cte ame!mree

Note : Sous Ubuntu Hardy, la création d'un nouveau fichier paut e un crash de
P'application ; l'instaliation du pagquet libmono-i18n2.0-cil résout fe problé

E.B.

4 Site du projet : http:/lgnome-subtitles sourceforge.net/ :

M Dernicre version ou projet - Gaome Subtitles 0.8 (mai 2008 — Paguets
disponibles sur fe site du projet pour Arch Lt Debian, Fedora,
FreeBSD Gentoo, Mandnva Siackware, SUSE et Uburtu
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par Dave Neary i
Bl

L m} L}g;

Un projet qui appartient a la nouvelle génération d'utilitaires Gnome, Do [1], est
utile, petit et est fait avec beaucoup de style et une pointe d’humour (Fig. 1). Aprés
installation (paquet gnome-do), Do vient se loger dans le menu Applications ->
Accessoires de Gnome.

A la base, Do sert 4 lancer des applications. Avec un raccourci [Super]+[Espace],
(la touche [Super] est typiquement la touche [Windows] du clavier), on réveille
rapplication, puis on tape quelques lettres de I'application que l'on souhaite lancer.
Par exemple, pour lancer Gnumeric, le tableau de Gnome, il me suffit de faire
[Super]+[Espace] et de saisir « gnum », puis [Entrée]. Pour passer d’'un champ
d’action a l'autre, on utilise la touche [Tab].

Mais, ce n'est que le début ! Lutilité de Do se manifeste surtout dans son grand
nombre de plugins (greffons), qui permettent d'indexer tout type d’information et
d’y associer des actions de certains logiciels. Pour en bénéficier, n'oubliez pas
d'installer le paquet gnome-do-plugins conjointement au paquet gnome-do. Quelques
exemples illustreront bien pourquoi les utilisateurs de ce petit outil sont tellement
passionnes :

¥ Filesystem : permet d'indexer vos fichiers, de les ouvrir, de les déplacer et de
les visualiser dans le gestionnaire de fichiers (Fig. 3).

P Rhythmbox : Le plugin rhythmbox permet d’indexer sa collection de musique
et, en un clin d'ceil, de jouer un morceau, un disque ou toute la musique d'un
artiste avec votre lecteur de musique (Fig. 4).

D‘Een Terminal Here =
pans aTarminal in 2 guan bcation, ng_ =l

Seorews Tl i Ekeer £ aritar bocation,

Copy to.
‘Cogies a e or okler = arwther ocation.

P Tomboy : permet de rechercher des notes
existantes ou d'en créer directement.

B Thunderbird : vous permet d’effectuer une
recherche dans vos contacts, d'écrire un
email & un contact ou d’envoyer une fichier

(Fig. 5).

GEREZ FACILEMENT VOTRE IPOD AVEC

' L’utilisatian 'c_i‘&n iPod nest pas t_o.ujoufs foute simple etlon se perd dans
Ees togin,ieis prope'-‘-es pour sa gestion SUr o 'd{nateur Avec Floofa, la

de serwces plus ou moins essentiels dont nous vous pmpoqom un o
. apercu. Avec fui, rien n'est pius sxmp!m que d i

particuliere fl
Uvre une petrte_

L droit sur un iiire et Edft:on} tTtre arttste qenre nu
i \.noiume sonore, paroiea, etc 5 i
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P Pidgin ; permet d’envoyer un message instan-
lané & un contact.

B Firefox : permet la recherche sur le Web, dans
plusieurs moteurs de recherche ; indexe les
marque-pages (Fig. 6).

La liste des applications comportant des plugins
est impressionnante [2], surtout avec la derniére
version de Do, la version 0.5. Cela comprend des
applications de communication comme Evolution,
Thunderbird et Pidgin, des applications desktop
comme Rhythmbox, Banshee, Tomboy et Tasque
et des applications web comme Google Calendar,
GMail, Tracks, del.icio.us ou Twitter.

- The computer

|dneanp@siga: —fuc... | B Compose Gpinion pe.
Pour que Gnome Do soit lancé automatiquement ]
au démarrage, n'oubliez pas que vous pouvez
I'ajouter & vos programmes de démarrage via le
menu Systéme -> Préférences -> Sessions (ligne
de commande /fusr/bin/gnome-do).

En résumé, GNOME Do est le type d’application
trés difficile a décrire, dont I'utilité laisse dubitatif
au prime abord, mais dont on ne peut plus se pas-
ser une fois qu'on a passé un peu de temps avec.
Hautement conseillé ! B

i r——y e
Bimpile S Rrad 1o 3

Eask Musk: Payer

En savoir plus =

P [1] GNOME Do : http://do.davebsd.com/

B 2] Plugins for GNOME Do : https:/iwiki.
ubuntu.com/GnomeDo/Plugins

: __ : favorite. Pour cela, il suffit de se rendre
et s i L s e _sitsf_.d"‘u_rfue radio et d'y rechercher.
' les podcasts proposes. On clique alors |
‘sur RSS Podcast et on copie l'adresse
 du lien. La fenétre de podcast de Floola
devrait reconnaitre automatiquement le
lien copié et demande silon'souhaite'sy
\inscrire pour télécharger automatsque-
ment les no VEHF‘S emissions. i

> Ajauter une wdeo ouun fic
provenant d'un site Internet, Depuis le

Plste: {1_| sur ‘g ]
Dusqns _| sur o _]

| 5 P Rechercher un fitre. ou un artl-‘.te :
| Modifier les ;_ sur le site Amazon. Sivous s
e Gl | ameeun ariste et soubaite: |
: rechercher sa musique, alors  |EErEwrTrITTTETE
e g | Floola permet de la rechercher - (ISl Bénas.. PRt e S
[Caveer | . sur Amazon et dacheter un titre . ; :
L [menu Arfiste -> Amazon):

£ g P Télecharger une emission de |
» Ecouter Jes musiques presentes sur - radio. Depuisie menu Manage=> | Télécharger une émission de radio
\yotre iPod tout en visualisant les paro- | Podcast, on va pouvoir sabon-
_les de la chanson dans une fenetre _ peraunliende podeastettete.
_ séparee (menu Lecture- >Afncher | charger, puis ecouter sur son e lye - um o
 les paroles des chansons). Uécoule  baladeur son émission de radio S chwosirivamtc ]
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&= "% DRGANISER SES IDEES

e .nombmux !Gglme}s fo gest;on de._.'
i musique, dont Flooia. Ce site permet AV E c N OT E CAS E
 de scrobbleries musiques que vous
écoutez sur votre iPod. Cela permet
- au site d’approfondir voire profil et de
Vous proposer de la musigue corres-

~ pondant & ce que vous avez I habi-
 fude decouter :

par Aline Gérard

. | NoteCase est un petit logiciel permettant d’organiser
'_ .;11*;2;‘;3-p&,te;—*;ggg;:;;;fﬁﬁ | simplement et efficacement des prises de notes. Ii
iPod, fa recherche de musique sur ressemble & un éditeur de textie, mais vous sera plus

votre ordinaleur, la conversion de

e e aeseee utile si vous avez 'habitude de prendre des notes dans
- des fichiers textes. En effet, le logiciel permet de créer

. retrou Jiement Floola recher-

LR (|usieurs notes dans un méme fichier, puis de les classer
~ les doublonsj s selon certains critéres

§opaemmse  hiérarchiquement. Nous avons [a une petite valise qui

LR R contiendra toutes nos idées : elles ne seront plus

"-'Reparer _\(otre iPQd, Sivous avez perdues |
. effeclue de mauvaises manipulations.
_ Ol si. pour une raison oU Une autre,
. vous avez besoin de e « réparer»,
 celase passe dans Outils -> Avance :
i Reparer iPod. i

(RS R4 3 £} 0% (3 » T Aeeinenne hismare bl

3 geogle -Recherche Geegh

i e e nﬁvij-u ;;.Eﬁlr : ey L
_F‘ou_r conﬁgu_re_r tout c_e} .onssrend o v 1 Presier noeoa
i daﬂs 16 ﬁ‘ienUOufﬂs - Pi‘éférent:éS_. On ) Hon beau petit arbre... va woir une sutre hrancher
peut alors choisir la langue de linter- S 4 L1 Ml du noeudl
face, paramétrer des options commela = | | 7 s ratat
connexion au site I ast fr, a vérification | T p—
de nouvealx podeasts, & conversron de {10 Dewiae dgeen
fichiers audio etvideo, etc. ] = risione et .

2 Premier noeud
Mon beau petit arbre... va voir une autre branche!

Fils du noeudl
Attachmerd #01
Bonjour Flis!

une histoirel
Deuxiemne noeud

Deuxime idee.... une histolre!
Troisieme noeud

En plus d'étre simple d'utilisation, Tins- [Pl

Il talt une fols....
tallation de Floola l'est aussi, puisqu’il el s rossas
suffif de telecharger Farchive présente ol TR s Un petit chat....
ey v } i 5 - 21.1: petit fils;
. sur le site du projet etide lancer l'exe- s e I petit fils1
: _c_ufc—:bie {"IB flch!er F ool QUE‘}QLGS = . ...Iquise promenalt. | rencontra un Tus!
2 ; : : 5+ 3.1.2: petat tils2 patit fils2

aguets sont neapmoins necessaires @
: £d (pour la
- conversion de fichier) et bien entendu

... QUi 5@ promenait. Trop fatigue 1 s'endormit au ple
+ 4ui e promensdit, Trop fatigue il s'endoreit au pied d°unm arbre.

 Sife du projet 1 www.floola.com

Un fichier NoteCase est donc un ensem- nouveau document. Pour commencer &

ble de notes, chacune étant un nceud (en saisir une note, il faudra créer un pre-
anglais node) d'une arborescence. Cette mier noeud depuis le menu Tree -> Insert
arbaorescence, présente sur le coté gau- Node, nceud auquel on attribue un nom.
che, permet d'organiser ses idées que On pourra ensuite créer un deuxiéme
l'on pourra classer, déclasser et reclas- nceud avec le méme bouton ou un neeud
ser en temps voulu. Le bouton New ne fils depuis le menu Tree -> Insert Child
permet pas de créer un neeud, il crée un Node. On retrouve le menu Tree depuis
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un clic droit sur I'arborescence. Celui-ci
permet de gérer les différents nceuds, de
les classer, de les frier.

On comprend que I'arbre peut vite s'enri-
chir et il est donc important de pouvoir s’y
retrouver facilement. Pour cela, NoteCase
permet de le classer par ordre alphabéti-
que, en différenciant les nceuds parents
des nceuds enfants (on pourra classer
les parents dans l'ordre alphabétique
et les enfants dans l'ordre inverse). Une
autre possibilité importante est celle de
pouvoir ajouter une petite icone au debut
d’'un nceud, icdne piochée dans une liste
proposée ou parmi ses propres images,
ceci pour le coté visuel de l'arborescence.

Les notes sont comme une liste de cho-
ses a faire ou de choses faites. De ce fait,
on peut les marguer comme étant termi-
nées (Tree -> Mark node as Completed).
Cela a pour effet de barrer un nceud et
fermer un noeud parent revient a fermer
tous ses fils. On pourra ensuite supprimer

iz

3 T wne ‘Nstasizncd® - HoteCase 1 9.3 [homelalina/une_histaviencd]

43
‘.i Ele Edit View Jres Foemmat gulp
o @dlivysa ShalmmE s rUs P TE

(|7 rremier noed patit fils1

— qu e pramenait Tl rencantra un Tisd

Frise de notes avec
NoteCase

toutes les notes fermées (Tree -> Delete
all Completed nodes).

Dans une utilisation quotidienne, on
aimera créer rapidement un nouveau
neeud, le fermer ou le supprimer. Pour
cela, on utilise des raccourcis cla-
vier assez explicites : [Inser] pour un
nouveau neceud, [Shift]+[Inser] pour

aff{-{{f f EE rsr.g »_"F' u , 2y { -
{ 3’\??%{\ ?\& it e.i; il ?55} i f !i, h;}iﬁﬁ %%3

un nouveau fils, [Espace] pour fermer et
rouvrir un nceud.

La prise de notes avec NoteCase peut
étre plus compléte en y insérant une
image, un lien sur une adresse Internet ou
un lien vers un noeud existant. Ce dernier
lien est assez intéressant, car il permet
de faire une liaison entre deux nceuds et,
ainsi, de naviguer rapidement entre une
idée faisant référence a une autre. Enfin,
on pourra attacher des fichiers & une note
ce qui permet de retrouver facilement ses
documents. La mise en forme d’une note
est possible avec la mise en gras, la mise
en italique, le soulignage, le surlignage et
la mise en couleur. Pour ce faire, on doit
tout d’abord saisir notre texte et ensuite
appliquer un formatage sur le texte que
l'on aura surligne.

Lorsque l'on aura terminé de saisir ses
idées, le fichier s’enregistre sous lI'ex-
tension .ncd et, parce qu'elles peuvent
atre confidentielles, on pourra les enre-
gistrer dans un fichier crypté sous l'ex-
tension .nde. Enfin, pour
exploiter ses notes avec un
autre logiciel, on exportera
ses données dans un fichier
texte (.txt) ou html. Bien
entendu, on retrouve dans
ces deux types de fichiers
I'arborescence des nceuds
et le fichier .ntml contien-
dra les liens et les fichiers
attachés.

Si I'on a I'habitude de pren-
dre des notes dans des
fichiers textes, NodeCase
peut vite devenir indispensa-
ble : il est simple, efficace et
le cryptage des fichiers est
rassurant. H

7] Dsrniére version :
NoteCase 1.9.3 (juin
2008) — Licence BSD
— Paquets disponibles
sur le site officiel pour
Fedora Core 6a 9,
Ubuntu 8.04, FreeBSD
7 et pour l'eeePC.
Disponible également
pour Mac OS X et
Windows.

7] Site du projet: http://notecase.

sourceforge.net

RHYTHMBOX
NOUVELLE
MISE A JOUR

Rhythmbox est le gestionnaire et lec-
teur de musique integre a Fenvironne-
ment Gnome, basé sur le framework
GStreamer. Rhythmbox s'inspire &
Uorigine du célebre iTunes d'Apple et
integre un lot frés convaincant de fonc-
tionnalites : un navigateur de musigque
simple 4 prendre en main et convivial |
un moteur de recherche et des fonc-
tions de tri ; le support des webradios ;
le support des playlists ; Iaffichage
de visuels animés lors de I'Scoute ; le

support de [iPod, des peripherigues

MTP ef des périphérigues de stockage
USB : I'affichage des jagueites de CD
et des paroles de chanson ; la lecture,
'extraction/encodage et la gravure de
CD ; le téléchargement automatigue
des podcasts

Cetie derniére mise & jour (version
0.11.6) requiert une version 2.10:x de
GTK+. Parmi les nouveautes et ame:
liorations, on retiendra : une revision
de la licence, GPL & l'origine, gui
inclut maintenant une exception pour
les plugins GSireamer ; utilisation du
service web Amazon ECS 4.0 pour ia
recherche des jagueties de CDB ; la
memornsation du dernier tat du navi-
gateur pour certains peripherigues
amovibles : la possibilité de trier les
playlists issues de partages DAAP:
|a suppression automatigtie des pod-
casts qui ne sont plus disponibles ;
une amélioration globale du plugin
pour l'iPod ; le passage su nouveau
systeme de sfreammg de last.fm. Les

: sources de cette nouvelle version sont

a récuperer sur fe site du projet, sec-
tion Download.

F.B.
vl Site du projet: http.iiwww.

gnome.orgiprojects!
rhythmbox/ [en]

] Demiere version : 0.11.6
(juillet 2008)
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CRYPTOGRAPHIE, SIGNATURE
ET GESTION DE CLES SOUS KDE

par Nicolas Ternisien

Le bureau KDE propose depuis plusieurs années des mécanismes de chiffrement
au travers d’outils dédiés et de fonctionnalités avancées dans certains logiciels. Les
applications suivantes, parmi d’autres, détiennent ce genre de possibilités : KGpg permet
par exemple de gérer son trousseau de clés numériques, KMail autorise de son coté
le chiffrement et la signature de courriers électroniques, alors que Dolphin permet de
crypter n'importe quel fichier du systeme. Lutilisation de cette technologie n’étant pas
toujours aisée, il semble tout d’abord important d’effectuer un rappel sur Punivers de la
cryptographie et du chiffrement personnel au travers d’OpenPGP.

O INTRODUCTION
SUR LA
CRYPTOGRAPHIE
ET LE STANDARD
OPENPGP

La grande majorité des mécanismes de
chiffrement modernes sont généralement
classés dans deux catégories : les algo-
rithmes symétriques (DES, AES,. ) et
asymeétriques (RSA [1], DSA,...). Dans tous
les cas, la notion de « clé » est & chaque fois
employée et représente simplement un trés
grand nombre, qui, couplé a un programme,
permet de chiffrer et déchiffrer un texte, un
fichier ou un email guelconque.

Les algorithmes symétriques se basent sur
une seule clé, dite « secréte », pour effectuer
ce traitement, et impliquent donc toujours de
protéger au maximum celle-ci, au risque de
laisser une personne tierce accéder a I'en-
semble de ses données privées. A contrario,
les algorithmes asymétriques utilisent une
paire de cles, 'une « publique » et donc libre-
ment accessible a tout le monde, et l'autre

i, Gestionnalre da clés

Hchier Edition Afficher Clés Groupes Options  Alde .

} ; .I‘.’.., 3 5 : 6 3
Chercher | Prapristesde laclé  Signer fes ciés — importer tne cle  Exporter bes clés publisuss  Servewr de cles

* Chercher =

ENOH'I v Adresse élactronique
| - TaBob Siege bsiego@kde.org
’ & ?aleaﬂ-jacques Etienne {Co... jjetienne@yahoo.com
- ¥ jean Jacques Noam jinoem@gmail com
-5 a5 Taedigien G aimpte by nic e
1 El clé secondaire
+ T Lastnize
+~ @liPhoto didentite
‘- oNicolas {Com... nicolas.
pdurand@gmail.com
wjoel@kde.org
pdurand@gmail.com
1

lastnico@gmall.com

-
+ 7 mPaul Durand
= ‘_?l-ewiﬂiam Joel
+ vy Willlam Grorand

Fig.1

Rl CoR .

Confianc Expiration  Taille Crdation

B unlimited 1024 17/06/2008
BN 07/052010 2048 17/06/2008
[ isoszo08 1024 17/06/2008
BT [ AriERons
3 17/06/2008

Identifiant
SZ00BFBB

12000057

1E3ETD4C
HERFRBEES T
OD13EDTS

. z
17/06/2008 3
IT/06/2008  BETGOGEC
17/06/2008  SFTCACAE
17/06/2008  4CTSB14F
0306/2008 52205160

17/06/2010
S -
. -
Unfimited
07/02/2010
Unlimited
[ unlimieed

Faire de clés secrétes

« privée », connue uniquement de son
propriétaire. Un message crypté avec
I'une des clés sera toujours déchiffrable
par sa parente, dans un sens comme
dans l'autre. De par la nature sensible
d'une clé privée, celle-ci est généralement
protégée par un mot de passe (ou phrase
de passe), cetie protection étant toujours
basée sur un algorithme symétrique.

[1] Flus d'informations sur hitp://fr.wikipedia.org/wiki/Rivest_Shamir Adleman

La premiere boite a outils permettant au
plus grand nombre d'utiliser la crypto-
graphie fat le programme PGP (Pretty
Good Privacy), standardisé sous le nom
d'OpenPGP, et proposé dans le monde
open source par le logiciel GnuPG (éga-
lement nommé GPG).

Le bureau KDE intégre en complément
l'application KGpg, qui s'interface avec
I'outil en ligne de commandes GnuPG. Il
devient donc bien plus simple de gérer
visuellement ses clés et la configuration
du chiffrement employé.
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O UN PEU DE
PRATIQUE AVEC
LUTILISATION
DE KGPG

KGpg (Fig- 1) est un logiciel, placé dans
la barre des taches, listant lensemble de
son trousseau de clés électroniques. Un
trousseau détaille les clés personnelles
ainsi que les clés publiques des contacts
actuellement installées sur le systeme.

Au premier lancement, KGpg propose de
créer sa propre paire de clés publique/
privée, bien qu'il soit possible d’annuler
cette action si l'on en posséde déja une.
Une fenétre dédiée demandant certaines
informations apparait (Fig. 2) alors afin
d'y saisir son nom complet (et non pas un
pseudanyme), son adresse email princi-

< Génération de clé - KGpg

Geénérer une paire de clés

.- Miessage chiffré d'une provenance mystérieusa - Kontact
E]mler EdRtion  Affichage E.e!aage LConfiguration &Ide

= es 4 u Sans Serif__ _

pale, ainsi gu'un éventuel commentaire.
L'application propose également de pré-
ciser la date a laquelle cette clé expirera.
Cette date force le propriétaire a recréer
a intervalles réguliers une nouvelle
paire, au méme titre qu'il est conseillé
de modifier le mot de passe d'un compte
personnel réguliérement. D'autres infor-
mations techniques, comme l'algorithme
utilisé (RSA ou DSA) et Ia taille de la clé
(768, 1024, 2048 bits) sont également a
spécifier a ce moment. Notez que plus
cette taille sera grande et plus votre sécu-
rité sera assurée, bien que, légalement,
la réglementation francaise empéche
d'utiliser un mécanisme de cryptographie
dépassant les 128 bits...

Une fois la création effectuée, un réca-
pitulatif est affiché : I'identifiant de la
clé (permettant de retrouver la clé d'un
contact sur un serveur), 'empreinte du
couple et le certificat de révocation,
qui permet, en cas de perte, de déclarer

]Jeuenrle@yahnn com
Commentaire (optionnel)
4 a_npea pearsannel

| Expiration :

3 Hicolas Ternisien Com> camj

Dats : Aujourd'hl 13:55:33

nternisien@melieurtaux.com

Hut mh lnfermaﬂm to check dgnmn u-nllﬂlty
Benjour, f& ne suls pas i d'tre dcrit par mon visitable pmpnetalm

- Kentact

& Enval d'un measege chilfnd &t signe

| Type | Encedage

& chifiré d'une provenance... multipart/signed 75l
i dis Conps:
15 This is 3 dightally signed messs... Signature OpenPG... Tbit

Texte simple quoted-printanle

Heu.m;e ﬁdlﬂun Affichage  Options. 1almine ogm ;:xmgumlon Zide

paul.Guranﬂ@gmalL(m

‘LN message chiffré at signi

comme invalides et vulnéra-
bles ces clés aux yeux de tous
vos contacts. Une derniére
guestion vous demande une
phrase de passe, qui, comme
nous l'avons vu précédem-
ment, permet de protéger
votre clé privée. Cette phrase
de passe vous sera d'ailleurs
redemandée a chague acces
a la clé privée, puisque celle-
ci devra d'abord étre déchif-
frée avant d’étre utilisée.

KDE

—

Parmi les différentes informations de KGpg,
la colonne de confiance affichera une cou-
leur bleue, attestant d’'une confiance abso-
lue dans cette clé.

Il est donc désormais possible d’effectuer
diverses opérations sur votre clé, telle que
la création d’identités secondaires (utile
pour regrouper plusieurs adresses emails
sous la méme identité numérique), ajou-
ter une photo personnelle, modifier votre
niveau de confiance ou encore exporter
votre clé publique vers un serveur de clés.
Cette action est notamment indispensable
afin que vos contacts puissent la récupérer
et valider la provenance de vos courriers
électronigues.

Cette regle s'applique également aux clés
publiques de vos amis, qu'il est nécessaire
d'importer dans votre trousseau pour vous
assurer de la bonne origine de leurs mes-
sages. Cette opération peut s'effectuer
sous deux formes : la premiére consiste
a demander a cette personne
d’exporter sa clé publique dans
un fichier texte, qu'il sera alors
possible de récupérer via le menu
Importer une clé de KGpg. La
seconde demandera de passer par
un serveur de clés. Dans ce cas,
il suffit de cliquer sur Fichier ->
Serveur de clés et de saisir dans
la zone de recherche au choix,
'adresse email, le nom ou l'iden-
tifiant de la clé de son ami. Un clic
sur le bouton Importer ajoutera
alors cette clé a votre trousseau.

Une fois les clés de vos contacts
présentes dans votre liste, il
convient maintenant de créer
un réseau de confiance, ce qui
consiste a valider que chague
clé publique appartient bien a la
personne correspondante. Cette
action se fait en « signant » une cle
donnée, c'est-a-dire en ajoutant sa
signature a la clé publigue de son
contact. Le niveau de confiance
dans linterface de KGpg passera
alors au vert pour cette personne. A ce pro-
pos, des événements nommes Key Signing
Party [2] s'organisent de temps a autre
partout en France pour initier ce genre de
réseaux de confiance et permettent de ren-
contrer physiquement les personnes avant
de signer leurs clés.

[2] Contactez le LUG (Linux Users’ Group) le
plus proche de chez vous poury participer :
http:ffwww.aful.org/gul
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O CHIFFRER ET
SIGNER SES
EMAILS SOUS
KMAIL

Maintenant que votre identité numérique est
transmise & votre réseau et que vous possé-
dez dans votre trousseau les clés publiques
de vos contacts, il va désormais étre pos-
sible de les utiliser dans KMail. Pour cela,
consultez tout d’abord les paramétres de
votre identité principale et cliquez sur I'on-
glet Cryptographie. Spécifiez alors les clés
de signature et de chiffrement en cliquant
sur les boutons Modifier et en sélectionnant
votre clé personnelle.

La fenétre de rédaction d'emails de KMail
propose alors deux nouveaux boutons
(Fig. 3), 'un pour signer son courrier, l'autre
pour le crypter. Notez que les paraméatres de
configuration de KMail permettent d’activer
ces options par défaut (depuis le sous-menu
Sécurité, puis dans l'onglet Editeur).

Avant d'aller plus loin, il convient de détailler
le fonctionnement de ces deux principes.

La signature d'un courrier permet
d'attester de la provenance d'un email.
Techniguement, cela consiste & utiliser
votre propre cle privée pour crypter 'em-
preinte de votre paire. Lorsqu’un contact
regoit ce courrier, son logiciel de messa-
gerie va alors utiliser la clé publique liée
a l'adresse électronique de l'expéditeur et
tenter de déchiffrer 'empreinte chiffrée.
Si I'empreinte correspond, ce message
est donc forcément signé par quel-
gu'un détenant la clé privée liée & cette
personne et I'expéditeur est donc par
extension valable.

Le chiffrement fonctionne par contre
difféeremment. Lorsque l'on rédige un
message que l'on souhaite crypter, on
va alors utiliser la clé publique du desti-
nataire du courrier et envoyer cet email
codé & cette personne. A la réception, ce
destinataire sera le seul a posséder la clé
privée parente, et donc le seul a pouvoir
déchiffrer le message. Ces mécanismes
peuvent également étre combinés, puis-
qu’il est possible de signer un message
que l'on a crypté.

La réception d'un courrier chiffré (Fig. 4)
se fait dans KMail de fagon transparente
et la consultation de celui-ci demande
tout d'abord de saisir sa phrase de passe

afin de laisser 'application utiliser la clé
privée pour le décrypter. Lorsqu’'une
signature est jointe a un courrier, I'appli-
cation procéde alors a une vérification
de celle-ci et un code couleur informe
I'utilisateur de I'authenticité de I'expédi-
teur. La couleur verte confirme la validité
du message, alors que le rouge stipule
que I'email provient d’'un expéditeur falsi-
fié ou d’'une clé expirée. La derniére cou-
leur utilisée est le jaune, qui prévient de
limpossibilité de vérifier la provenance
du courrier. Dans ce cas, il suffit géné-
ralement de récupérer l'identifiant ou
I'adresse électronique jointe & la signa-
ture et d'ajouter la clé publique a son pro-
pre trousseau (en passant par exemple
par l'importation via un serveur de clés
dans KGpg). Vous devrez alors signer
ou donner une confiance absolue dans
cette clé publique pour que le message
passe au vert.

Les applications utilisant la cryptogra-
phie fonctionnent toujours sur ce méme
principe, et, une fois celui-ci bien com-
pris, il devient frés simple d'améliorer la
sécurité de ses échanges électroniques
avec le bureau KDE. B

LEXPLORATION DE LA TERRE AVEC

MARBLE

Depuis 'avenement de logiciels comme
Google Earth, Microsoft Virtual Earth, et
dans une moindre mesure Nasa World
Wind, I'exploration de la Terre depuis
un simple ordinateur a pris une nouvelle
dimension. La communaute open source
et plus particulierement celle gravitant
autour du bureau KDE ne pouvait se
passer de propeser cetie possibilité et
¢'est aulour du projet Marble que cette
volonte s’est capitalisee. Marble fait par-
fie des nouveautés majeures du bureau
KDE 4, au sein de la catégorie KDE
Educations, et, bien qu'en dega de ses
principaux concurrents propriétaires,
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4. Marble Desklop Globe
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Havigation

| Vue dos cartes
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| @ Globs !
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Jvf 84523-commandwatch-g.1.tar,bz2
d commandwatch
mkdir build
cd build

cmake -DCMAKE_INSTALL_PREFIY="kde4-config --prefix

e
udo make install

il propose des a présent une liste de
fonctionnalités bien agreables.

Marble présente une mappemonde ter-
restre, sous la forme d’une sphere ou
d’un planisphére au choix. La naviga-
tion depuis cette vue se fait tout simple-
ment a la souris, la moletie permettant
de zoomer sur une zone précise, et le
bouton gauche autorisant le deplace-
ment dans la carfe. Des informations
de plus en plus localisees apparaissent
sur chague niveau d’'agrandissement,
nous indiquant tour a tour les noms
des continents affiches, puis les pays,
les capitales principales, les villes de
seconde importance, etec. Des donnees
complémentaires (population, latitude,
longitude,...) sont proposees en cliquant
sur ces intitulés, tout comme l'article
Wikipedia li¢ 3 ce point et accessible dans
un onglet dedie.

Diverses vues sont disponibles dans
Warble :

P un atlas geographique, affichant les
données topologiques de la Terre ;

P une carte brute, se contentant de déli-
miter les zones maritimes et terrestres ;

B deux types de cartes satellites repre-
sentant la Terre vue de jour et de nuit.

Notez a ce propos qu'il est possible
d'ajouter de nouveaux modes, tele-
chargeables sur Internet via le menu
Teélécharger de nouvelles données. Des
legendes masquables a souhait permet-
tent d’inclure & méme la carte des infor-
mations additionnelles telles que popula-
tions, capitales nationales, fuseaux horai-
res et autres zones d'intéréts (volcans,
montagnes, aéroports,...). Lintégration
de cartes dans des documents person-
nels est aisée, puisque la vue en cours
peut étre exporiée a tout moment sous
forme d'images (au format PNG ou
JPEG). Enfin, un oufil sommaire permet
de réaliser une estimation des distances

kilométriques entre des points places via
un clic droit sur la carte.

La prochaine version de Marble, prevue
pour KDE 4.1, ajoutera, en complément
a des améliorations de performances,
de nouveaux modes, avec d'un cote des
cartes metéorologigues et, de autre, un
support de OpenStreetMap [1], proposant
les cartes routiéres des pays du monde
entier. Marble fera alors ses premiers
pas vers la création d'itinéraires, gui, tout
comme lintégration de photos issues de
Panoramio et Wikipédia, apporteront de
grosses innovations prévues cette fois-
ci pour KDE 4.2 (date de sortie estimee
début 2008). W

Nicolas Ternisien

En savoir plus

P [1] Plus dinformations sur http:/f
www.openstreetmap.org
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SOUNDKONVERTER, NOUVELLE VERSION :
LA MUSIQUE FACILE SOUS KDE !

par Laurent Bellegarde

Soundkonverter est un Logiciel libre de conversion audio, simple, trés puissant et polyvalent
fonctionnant sous GNU/Linux. Capable de lire les principaux types de fichiers audio wav,
mp3, 0gg vorbis et aiff, wma(r) et bien d’autres, il vous permettra de transformer n’importe

quel morceau musical dans le format et le codec audio de votre choix...

Il existe un paquet soundkonverter dans les
principales distributions GNU/Linux. Il vous
suffit de l'installer avec votre gestionnaire de
paguets. Pour profiter de toutes les fonction-
nalités de Soundkonverter, pensez a installer
aussi les paquets ffmpeg, mencoder, cdparanoia qui
réalisent tous les encodages. Aprés l'instal-
lation, vous trouverez SoundKonverter dans
le menu K -> Multimédia.

Linterface de SoundKonverter est trés sim-
ple (Fig. 1) : un menu de commandes en (1),
les parameétres de conversion audio en (2),
la liste des morceaux a convertir en (3) et le
lancement de la conversion en (4).

O Conversion
d’un fichier
audio

Pour convertir un fichier audio, char-
gez-le (1) avec la commande Fichier ->
Ajouter des fichiers. Le fichier choisi
apparait alors dans la liste en attente
en (3). Dans cet exemple, nous partons
d'un fichier encodé en ¢ag vorbis, et nous
allons le convertir en mpd pour le mettre
dans notre baladeur.

:aat Entrée i i Sortie z Qualité i
|En atznte ' .-orchesba/l-morchesba - enjoy._the_ride.mp3 ..ok - Enjoy The Ride.ogg Defind par Putilisateur |
En attante -jectdl - Querenos Paz - GOTAN PROJECT.mpI .S - Queremos Paz.mp3 Defini par utilisateur sl H
';En attante --otan Projectfl2 - Epoca - GOTAN PROIECT.mp3  ...N PROJECT - Epoca.mpd Défini par Putilisateur g

En attente -+{03 - Chungas Revenge - GOTAN PROJECT.MES ... - Chungas Revenge.mp3 Defini par Pubilisateur

En attente kAR Frojectiod - Triptico - GOTAN PROJECT.Mp3 ... PROJECT - Triptica.mp3 Défini par Futilisateur

En attente -3 Maria {del Buen Ayre] - GOTAN PROJECT.mp3 ...ana {def Buen Ayre).mp3 Défini par Iutilisateur b

En attente 106 - Una Msica Srutal - GOTAN FROJECT.mp3 ... Una MUsica Brutal mp3 Défini par I'utifisateur I

En attenke - El Capitalismo Foraneo - GOTAN PROJECT.mp3 ._apitalizmo Forsneo.mp3 Défini par 'utllisstour | 3

En attente --08 - L35t Tango In Pasis - GOTAN PAOJECT.mp3 ... Last Tange In Paris.mp3 Defind par Iutilisateur }

En attanta: --Projecti0s - La def Ruso - GOTAN PROJECT.mp3 .. O[ZCT - La ded Ruse.mp3 Defink par Putifisateur '

En attente ~-0pecti10 - Vuelvo al Sur - GOTAN PROJECT.mp3 . JECT - Vuelve al Sur.mpd Defin par butilisateur

3

bR L 5
i $

Q‘_é‘hailié }
SRS

Eichier Conversion Outils Configuration  Aide

En (2), dans l'onglet détaillé (Fig. 2), choi-
sissez, comme paramétres de conver-
sion, mp3, avec un débit supérieur ou
égal a 128 kb/s, mode abr, 44100Hz,
steéréo.

Important : ne descendez pas le débit en
dessous de 128 kb/s pour ne pas perdre
trop de qualité audible !

Sélectionnez le fichier a convertir en (3)
avec 1 clic gauche dessus, puis lancez
la conversion en (4). Le temps de conver-
sion dépendra de la puissance de votre
ordinateur. Le fichier converti sera sau-
vegarde dans un dossier soundkonverter/
dans votre dossier personnel.

Il est possible de traiter ainsi plusieurs
fichiers & la suite ou de convertir direc-
tement les titres de vos CD-audio
(via I'option Fichier -> Ajouter des pistes
deCD). H

] Site officiel : http:/iwww.
kde-apps.org/content/show.
php?content=29024

[¥] Derniére version : SoundKonverter
0.3.8 (juin 2008)

1 Vitessa:

Ajouter des fichiers |~ [ pgmamer | [

g y
Tamps restan: 000

Télecharger légalement de Ia musique libre

Supportez le Libre en téléchargeant légalement de la musique libre en 0gg vorbis/mp3 en provenance de sites de
musigue libre comme www.dogmazic.net et www.jamendo.com !
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Fig. 1.
Configurafion de
P'applet horloge

Ce plasmoid a une histoire un peu particu-
ligre, car c'est le tout premier & avoir &té intro-
duit dans Plasma mi-2007, montrant ainsi les
premiers pas des DataEngines. Le principe
est qu'il existe des DataEngines (moteurs de
données) qui publient des informations et les
applets peuvent se connecter a ces derniers.
Par exemple, 'applet « horloge analogique » et
I'applet « horloge numérique » se connectent
au méme moteur de données. Pas besoin de
dupliquer ce dernier, ce serait un gachis. Dans
KDE 3, c’est plus ou moins ce qui était fait.

.. Dispasition du clavier

e
_Dwn?hﬂ . Opiians da baseuizment pticns 1 i

LAPPLET HORLOGE
DE KDE

La configuration de I'applet est extrémement
simple (Fig. 1). Laffichage des secondes est
facultatif, car il réveille le processeur toutes les
secondes, ce qui n'est pas toujours souhaitable
sur un ordinateur portable. Décocher la case
Utiliser le fuseau horaire local permet d'afficher
une horloge dans un autre fuseau horaire.

Enfin, ce plasmoid fait partie des plasmoids
privilégiés de Plasma qui changent d’appa-
rence lorsque le théme de Plasma est change
(Fig.2). =

B. V.

i [ Activer les aptions de Kkl

0 L=ft Stelkuy changes baveuk.
[0 Manu by changes bayouk.
[ Ak+cirl change youk

O Akestife changs layout.
[ ctrsheit changa layout.
[ Right 2k ey changes layout
[ Beth At key= togethar change layouk.

[ Copslocklmy changes layout.

1 et Shifk by shirgsss lapoat

O vefwinkey snitches layet nhie pressed
] might winkey changus layout.

O Scoleck kay changes orous

[ Ecth Sh# keys tagether change lavout,
[ aksCapstock charges layout.

[ Right Corl ey chargus Lyoue

[ shefttCapslock changes layat.

[J Rtk switchos Lyt whils pre

[J Right Win-kary switches layout whia pressed.

[ Right ctot oy
[ Ricte 3hift key changes layvout.

Savez-vous gu'en typographie parfaite, il faut metire les accents, les tréemas et les cedilles
sur les majuscules qui ont pleine valeur orthographique (http:/lwww.academie-francaise.
frilangue/questions.htmif#faccentuation) 2 Malheurcusement, les claviers ne proposent
pas ce genre de caracteres. I existe une maniere trés simple de les obtenir sous KDE.

aAnaloy Clock Scttings

Appearance
| Ghow getards
. Also shaw the time as tad

Timezones

. U= lncal Timezone

Fig. 2 - Avec le théme « Elégance »...

Sous KDE 3. lancez
; rol et sous KRE 4, lan-
; . Rendez-

Régionalisation et accessi-
bilité, puis Disposition du
clavier et enfin dans l'onglet
Options Xkb. Cochez-y la
case Compose Key Position
et Compose est assignee a
la touche Windows droite
(ou toute autre touche de
votre choix). Pour mettre
un accent grave sur vos
¢ a » majuscules, tapez
alors [Win], puis [All Gri+[']
puis votre [A]. Pour mettre
un accent aigu sur le <« E »
majuscule, tapez [Win], puis
[, puis [E]. Pour la cedille 7
Tapez [Win], puis [] et
enfin [C]. Le reflexe vient
fres vite.

Notez que si vous n'avez
pas KDE, la commande
setxkbmap -0pEion comp '
aura le méme effet. H

B. V.
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LES AUTRES ENVIRONNEMENTS GRAPHIQUES

E17 : UN ENVIRONNEMENT DE BUREAU
TRES LEGER ET ESTHETIQUE

par Jonathan Marsaud

Enlightenment DR17, de son petit nom E17, est un environnement de bureau qui sappuie
sur un toolkit graphique autre que GTK ou Qt, nommé ETK. E17, ainsi qu'ETK, sont tras
legers et, ici, le « trés » & toute son importance, puisqu’E17 sera capable de tourner
sur pratiguement toutes les machines, oui, toutes, méme vos ordinosaures qui datent

peut-éire d’une décennie !

Les connaisseurs se diront quE17 nest
pas le seul dans ce domaine. On peut par
exemple citer : E16, Fluxbox, Openbox
ou méme, encore plus l&égers, larswm,
dwm, awesome, etc. Lavantage d'E17 est
qu'il mest pas qu'un simple WM (Window
Manager) comme peuvent I'étre les quel-
ques exemples cités : E17 peut étre utilisé
comme un environnement de bureau com-
plet. Un autre avantage est qu'il peut &tre
trés esthétique et, ici, le « trés » a encore
une fois toute son importance. Et il est
bon de préciser que ce sera sans Compiz.
Etonné(e) ? Vous aurez le droit & quelgues
démonstrations dans les lignes suivan-
tes_ .. Petit complément pour la route :
ETK et, plus récemment, E17 sont parfois
utilisés dans les périphériques embarqués
(UMPC, tableites, téléphones) de par leur
Iégereté et leur réactivité.

O UN PEU
D’HISTOIRE. ..

Il faut savoir que (logiquement me direz-
vous) E17 a été précédé par E16... Oui,
mais E16 n'avait pas les mémes buts que
son successeur : celui-ci n'était qu'un
Window Manager, au méme titre que
Fluxbox ou Metacity par exemple. E16
était d’ailleurs le WM par défaut dans les
anciennes branches du bureau GNOME,
a la place de Metacity actuellement. E17,
se veut, quant a lui, étre un environnement
de bureau plus ou moins complet pour le

moment : en effet, rappelons qu'E17 est a
ce jour toujours en développement inten-
sif. Cela explique entre autres pourquoi
il n'est pas dans les dépdts de certaines
distributions, contrairement a2 E16. Ce
manque dans la plupart des dépéts est
aussi consenti par le développeur prin-
cipal du projet, en attendant qu’E17 soit
release comme une version stable. Cela
peut se comprendre, mais il faut aussi
savoir que le développement d’E17 a
déja quelques années derriére lui. || n'est
pas rare de comparer E17 au projet Duke
Nukem Forever [1] pour les plus geeks.
E17 sera donc souvent disponible pour
votre distribution (c’'est le cas des distri-
butions basées sur Debian, par exemple)
via un dépét tiers.

O INSTALLATION

Nous verrons ici comment installer E17
sous une Ubuntu 8.04. Le dépét tiers
a activer est de confiance, qui plus est
(paquets propres et souvent a jour).
Récuperez la clé des dépdis afin de
garantir I'intégrité des paquets :

wget http://lutln.ifrance.com/repo_key.
asc -0- | sudo apt-key add -

Editez votre fichier /etc/apt/sources.list et
ajoutez-y ces deux lignes (la seconde est
facultative, elle ne sert qu'a télécharger le
code source des paquets binaires) :

INote - Il s'agit bien de Ja lettre O majuscule ef non du chiffre 0...
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deb htip://el7.dunnewind,net/ubuntu/
hardy el7

deb-src hitp:/fell.dunnewind.net/ubuntu/
hardy el7

Rechargez vos depodts et installez le
méta-paquet &17 :

sudo apt-get update &k sudo apt-get
install ell

Je vous conseille également 'installation
des paquets eclair, exhibit, exirackt pourla
suite de cet article.

Déconnectez-vous de votre session
graphique actuelle, puis, dans I'écran de
connexion (menu Options), choisissez
Sessions, puis Enlightenment. A partir
de ce moment, votre écran de connexion
vous propose d'utiliser cette session
Enlightenment par défaut ou juste pour
cette fois. A vous de choisir ;-).

sudo apt-get install xorg entrance
el] eclair exhibit extackt




LES AUTRES ENVIRONNEMENTS GRAPHIQUES

O CONFIGURATION
ET DECOUVERTE
DE VOTRE NOUVEL
ENVIRONNEMENT

CONFIGURATION

Avant d’entrer dans les détails, sachez que
les tableaux de bord sous E17 s'appellent des
« gondoles ». Pourguoi ? Car elles peuvent
« embarquer » des gadgets, c'est donc un jeu
de mot et non une erreur de traduction ;-).

Commengons par le plus important : le pan-
neau de configuration (Fig. 2). Celui-ci vous
permettra de personnaliser tous les réglages
de votre bureau E17, comme la langue du sys-
téme (parfois par défaut en anglais aprés ins-
tallation au lieu de votre langue définie).

S | CEEEE

Linux Pratique

lNUX ﬂﬂﬂUEI i et

513 '7‘ G oo 5 Fig. 4 Firefox 3

ubuntulaok
GTK2+de
Human Theme
(theme par
UnixGarden.com defaut diUBUNIL)

Le panneau de configuration vous permet, un ufilitaire de configuration de 'écran, un
entre autres, de parametrer l'apparence autre pour la configuration du clavier/souris,
de votre bureau (fond d'écran, animé en une catégorie Extensions qui vous permetira
direct ; il ne s'agit pas ici de simples tran- de configurer les gadgets de vos gondales
sitions comme ce que l'on trouve sous ou d'ajouter des « modules », sortes d'ex-
GNOME/KDE/Xfce, mais de réels fonds tensions de votre bureau, contenant certains
d’écran animés ; le théeme, la police, les modules a caractére visuel (sous forme de
effets...), un gestionnaire d’applications, desklets/plasmoides).
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LES AUTRES ENVIRONNEMENTS GRAPHIQUES

800 edte minimaliste rappeile
i d calebre XIMMS, en GTKI.

Fig.6 : Le navigateur de fichier d'E17. sobre; peut-étre trop....

DECOUVERTE

Explorateur de fichiers

Lexplorateur de fichiers d’E17 (Fig. 6)
contient les fonctions vraiment minimales
d’un logiciel de méme classe. Il n'en est que
plus rapide, mais on regrettera cette trop
grande légéreté dans de nombreux usages.
Le comportement de cet explorateur ne
mangue pas de rappeler le célébre mode
spatial de Nautilus (I'explorateur de fichier
de GNOME). L'avantage de I'explorateur de
fichiers d'E17 est qu'il utilise ETK. Quelques
effets sont donc présents lorsque vous admi-
nistrez vos fichiers (par exemple, lors d’'un
glisser-déposer dans un dossier).

Le menu contextuel contient quelques
actions classiques, dont deux a remarquer
car leur emplacement est plutét mal choisi :
Afficher les fichiers cachés et Se souvenir de
Pordre. La deuxiéme option est plutdt prati-
que : elle permet de retrouver I'emplacement
exact de vos dossiers dans la fenétre, si vous
les aviez au préalable déplacés.

La fenétre des propriétés est plutbt classique
pour ce genre d'application et permet la ges-
tion des permissions et de I'icone de l'objet
sélectionné (dossier, fichier...).

Le lecteur de musigue : Eclair

Le lecteur de musique d’E17, Eclair, est, pour
sa part, plutét réussi (Fig. 7). Il ressemble
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Fig.8 . Exhibit, visualisez vos photos rapidement

dans sa conception & XMMS, lecteur en
apparence minimal, avec une bonne ges-
tion des playlists (listes de lecture). Une
fois de plus, Eclair utilise ETK, quelques
effets visuels sont donc au rendez-vous
pour ceux a la recherche de I'environne-
ment eye candy du siécle. ..

Pas grand chose a dire de plus, si ce
n'est qu'Eclair utilise le moteur multimé-
dia Xine par défaut.

Exhibit, visualiser ses photos

Exhibit (Fig. 8) est un visualisateur d'ima-
ges. Celui-ci permet un classement som-
maire de vos photos, une fonctionnalité
de diaporama animé, une gestion des
favoris et une visualisation trés rapide.
Vous pouvez aussi modifier le sens de
vos photos ou y ajoutez quelques effets.

Extrackt, Uextracteur de CD audioc

Extrackt est un extracteur de CD audio
simple et efficace, intégré a E17, son
interface se décompose en plusieurs
onglets, le premier contenant les pistes 4
écouter ou a extraire (Fig. 9), le deuxiéme
concernant I'extraction et I'encodage
(Fig. 10). Le troisieme est, quant a Iuij,
dedi¢ a la configuration de divers para-
métres de l'encodage et de la recherche
du titre des pistes gréace & FreeDB.

Estickies,

les post-it sur vetre hureau
Estikies, a la maniére de Tomboy sous
GNOME ou de Knotes sous KDE, permet
d'accrocher des post-it jaunes a votre
bureau (Fig. 11). Celui-ci peut d'ailleurs
étre piloté au clavier :

P [Ctrl]+[N] : pour créer une nouvelle
note ;

B [Ctrl]+[Q] : quitte 'application :

P [CtrI]+[C)/[X]/[V] : respectivement
pour copier, couper, coller du texte.

Ces combinaisons sont classiques, mais
nous les precisons ici, car elles ne sont
pas accessibles via le menu contextuel
d'Estickies, étrangement. ..

O CONCLUSION

Ce n’est ici gu'une premiére approche
d’E17. Beaucoup de ses qualités n'ont
pas ete citées ici, comme sa gestion
avancée des fenétres, car cela aurait été
trop long et indigeste a la lecture pour
le débutant & la recherche d'un environ-
nement de bureau simple et léger, mais
attirant I'ceil, et plutét stable bien que
celui-ci soit encore en développement
aujourd’hui. W
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LE LIBRE EN TOUTE LEGERETE :
GESTIONNAIRES DE FENETRES ET

DE FICHIERS « ULTRA-LIGHT »

par Fred Scali-West

Les utilisateurs de systemes d’exploitation propriétaires ont peut-étre déja essayé un
gestionnaire de fichiers différent de celui qui leur est fourni par défaut, mais peu
nombreux sont ceux qui se doutent que le Libre permet aussi de choisir entre de
complets environnements graphiques alternatifs pi1.

Les plus connus avec Linux, Gnome et
KDE, demandent un certain niveau de
puissance pour donner leur meilleur. Le
troisiéme commengant a faire parler douce-
ment de lui, Xfce, est déja pensé « allégé ».
Mais, ceux-ci reposant toujours sur un
gestionnaire de fenétres (window mana-
ger en anglais [2]), un moyen supplémen-
taire d'économiser des ressources est den
employer de trés légers, comme IceWM
et Fluxbox, que ce soit pour donner une
interface graphique a un ordinateur assez
limité ou pour consacrer plus de capacités
aux programmes qu'a la gestion des fené-
tres et de l'ordinateur | De méme, a coté
des gestionnaires de fichiers répandus

Flg. 1. Le gestionnaire de fendtres leeWil en action Surune

disfribution Deli Linux,
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comme Konqueror, Nautilus et méme
Thunar, voici deux « poids-plume »,
nommés X file explorer et PC Man file
manager, & découvrir sans plus tarder...

Tout d'abord, un petit lexique permettant
d'illustrer simplement le sujet :

B CLI (Command Line Interface) : inter-
face en ligne de commande (on parle
aussi d'interface texte), permettant
d'utiliser et de gérer l'ordinateur grace
a des commandes entrées 2 I'aide du
clavier. La plupart des programmes
nécessaires a 'usage quotidien sont
présents par défaut dans une distri-
bution libre.

| FICERI I g

e pee.n. g waetlien
BoBHSoHood Baatn

Mllccoooocopos

nsber {from sopyinfo) .
¢Filesr  image fllermmes in open

4 3 paint -nosenubar =srapshort,
| -Ilamlr\g: Unzble to load any usshls fontset

P~ GUI (Graphical User Interface) : inter-
face utilisateur graphique (ou aussi
environnement graphique), permettant
d’ajouter des périphériques d’entrée
supplémentaires (comme la souris)
pour utiliser et gérer l'ordinateur grace
a des commandes entrées a l'aide de
fenétres et de boites de dialogue. La
plupart des programmes nécessai-
res a l'usage quotidien sont présents
par défaut dans une distribution libre,
certains n'étant qu'un moyen graphi-
que prenant & leur charge I'entrée de
commandes disponibles en CL| ou la
modification manuelle de fichiers de
configuration.
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» Window Manager ; gestionnaire de fenétres, le composant logiciel
chargé de la représentation, du placement et de la gestion des
fenétres de la GUL.

B File Manager: gestionnaire de fichiers, le composant logiciel
chargé de la gestion et de l'utilisation des fichiers de l'ordinateur
et de l'utilisateur dans la GUL.

Maintenant que les réles sont clairement définis, voyons ces exem-
ples plus en détail_.

O ICEWM w10

Ses objectifs sont clairement définis, a savoir « Le but d’lceWm est
la vitesse d’exécution, la simplicité d’utilisation et de ne pas trainer
dans les jambes de l'utilisateur ». C'est donc pour cela qu'en plus
de fournir une gestion plus efficace des ressources matérielles,
il est utilisable avec les environnements Gnome et KDE, propose
des bureaux multiples, des raccourcis clavier entiérement configu-
rables, la bascule entre programmes avec [Alt]+[Tab] et une Barre
des taches (avec le menu et pouvant se masquer automatique-
ment) en option. S'il ne gére pas les bureaux 3D, I'esthétisme ne
doit pas pour autant étre sacrifié, puisque de nombreux thémes
sont disponibles.

Seul bémol a la simplicité : sa grande flexibilité se gére a l'aide de
simples fichiers de configuration (aux noms sans équivoque comme
keys, menu, preferences...) dans un répertoire caché de l'utilisateur 51
mais cette procédure de personnalisation peut étre désarmante
pour les utilisateurs de GUI comme Gnome ou KDE, en particulier
les débutants.

Cest pour cela que des programmes supplémentaires ont été creés
pour simplifier cette tAche, comme ces différents utilitaires disponi-
bles ici [6]. Attention, certains ne sont plus maintenus a ce jour. Mais,
la seule lecture des fichiers de configuration (anglais de rigueur)
permet aussi d'expérimenter assez facilement des modifications
dont le résultat peut étre rapidement observé, puisqu’lceWM peut
&tre redémarré sans avoir besoin de relancer sa session [7]. On
peut trouver un bon guide en francais, comprenant des suggestions
de programmes supplémentaires, ici [8] et la [5] pour le detail des
options de configuration et I'ajout d'icones avec idesk. Mais, ily a
aussi dfm, rox, kfm ou gme comme autres choix [19]...

Dernier point qui peut paraitre « bizarre » aux nouveaux, le redeé-
marrage ou I'arrét de la machine est réserve a l'utilisateur root ! Pour
Putilisateur non privilégié, une astuce assez simple (si l'on utilise sudo)
permet facilement d'y arriver :

Avec la commande visudo (avec les droits d’administration), il faut
ajouter l'utilisateur (ou le groupe users s'il est dedans) avec la ligne
suivante :

fusers ALL = NOPASSHD: /sbin/halt, isbinfrebontJ

Puis compléter ainsi les lignes suivantes dans votre fichier .iceun/
preferences :

ShutdownCommand="sudo halt"
RebootCommand="sudo reboot”

Aprés un nouveau démarrage, les possibilités d'arrét ou de redémar-
rage du systéme sont maintenant accessibles a l'utilisateur normal

POUR CEUX QUL

Y AURAIENT
PRIS GOOT...

N'allez surtout pas croire que Fon ait fait le tour du sujet !
Le fait que seuls certains aient accede a une {toute rela-
tive) notariéte cache le grand nombre de gestionnaires de
fenétres existants ou ayant existe.. Bien entendu, fous ne
sont plus maintenus, mais ils conservent tous un intérét
didactique, voire historigue (a T'échelle de linformatigue,
bien sur). Petite photo de famille (approximative et pas aoli-
gatoirement compléete)

P Les « grands-parents » : xwm, de 1985, avant meme
farrivee d'X11 (disponible avee la version X10R4), ce
qui en fait peut-étre le premier . wm, utilise pour le
debogage des débuts d'X11, puis supprime ; et uwm
(Universal Window Manager). ]

» |2 famille Twm (Tab Window Manager, parfois aussi
Tom’s Window Manager, d'aprés son auteur principal
Tom LaStrange), Viwm (pour Virtual) et Ctwm, une
exiension de Claude Lecommandeur.

" » La famille Fvwm, de Robert Nation, descendant lui-

meme de Twm, ayant donne neissance a Fvwma95 (toute
ressemblance a etc.), 8 Scwim mais aussi au plus cele-
bre Enlightenment (meme s'il a entierement ete reecrit
depuis).

La famille inspirée par le systeme d'exploitation
MeXTSTER des ordinateurs NeXT de Steve Jobs (infas
en francais sur cette page http:/lwww.levenez.com/
NeXTSTEP/), avant quiil ne revienne chez Apple et gue
cette expérience ne serve a créer Mac OS X ; AfterStep.
base sur Fvwm, et Window Maker, qui lui ne I'est pas.

P | a famille Blackbox, d'ou vient Fluxbox, mais aussi
Openbox et Hackedbox, ce dernier sans Barre des
Taches ni Slit.

P | a famille autour de la bibliotheque Motif avec son ges-+
tionnaire mwm, disponible sur des Unix commerciaix et
en version libre avec Open NMotif. '

P Lafaniille wm2, ulfra minimale et son extension wimx.
P La famille Openlook, ancien standard sur les stations
Sun, avec Olwm et Olvwm.

Je ne peux que conseiller a ceux guiveulent en savair
plus de parcourir l'excellent site http:f/xwinman.org, ol

' T'on peut trouver toutes es informations concernant ceux
. que jai cités ici, leur page Internet si elle existe encore ou

un téléchargement a partir des archives du site pour les
plus anciens... ®

FSW
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dans le menu général d’lceWM
(Barre des taches ou clic-droit sur le
bureau) ou dans le menu dédié que
I'on peut appeler avec la combinai-
son de touches [Ctri[+[Alf]+[Suppr].

[sLbmenu] (Lect=urs] {I
lexec] [(Cvince) (A niaulnee} <

Preuve de son efficacité, il est pos- S g 2
5 3 7 e 1 [:“:é'l [Eye of E‘%Lgﬁ::tmn{?uﬂ] qzrxmrc!mxnuas)qm-
sible de I'employer sur un vieux [manc] (oTRORD T8age Viamar] L fime ol gtbuab) </use/ oruplssapsfat

portab]e Contura 41 OCX avec un 1 Dl:{::]bl-ﬂ-"fbll\fﬁ":} <fusrishara/vic/ vl xpas

Wlemerd {fusr/binfcfileinnge} </Usrishare/ plxmeps

CPU 486DX2 de 50 MHz et 12 Mo
de RAM (certes la CLI est bien plus
rapide, mais cela reste tout de méme
utilisable) grace a la distribution
Deli Linux (Fig. 1) et il est aussi le
gestionnaire choisi par Asus pour
son eeePC sous Linux Xandros
[9] [10].

O FLUXBOX

(1] [12]

S'il a en commun la Iégéreté et la
configuration par fichiers dans un
repertoire caché de l'utilisateur,
I'expérience que propose Fluxbox
est visiblement différente : il pos-
sede certes une Barre des Téches,
mais le menu n'est accessible que
par un clic-droit @ un endroit quel-
conque du Bureau et toujours pas
d’icdnes | Lambiance minimale donne le
ton. On est loin des habitudes que l'on peut
avoir prises ailleurs, mais c'est ce coté
épuré a l'essentiel qui lui confére sa célérité
(il est capable de fonctionner sur un
Pentium 133 non MMX, voir Fig. 2) I De nou-
veau, Fluxbox est entiérement configurable
et propose egalement des bureaux multiples,
des raccourcis clavier et la bascule entre
programmes avec [Alt]+[Tab].

La aussi, on a le choix entre I'étude et
la modification des fichiers, soit I'utilisa-
tion des utilitaires fluxconf, fluxkeys et
fluxmenu (qui peuvent &tre lancés par
fluxbare) qui permettent d'accomplir cette
tache graphiquement. Pour cela, il suffit sim-
plement d'installer le paquet fluxconf [13], qui
contient aussi les trois autres... De méme, le
paquet gsetroot sera bien utile pour définir le
fond d'écran ou simplement éditer le fichier
~/.fluxbox/init, si Fon en désire un pour son
bureau, mais, attention, a partir de la ver-
sion 1.0-RC, il y a un nouveau fichier qui
permet de sauvegarder ses réglages :
~/.fluxbox/overiay. Celui-ci manquait ici et le
style installé parasitait le choix de I'arriére-
plan. Pour arranger cela, il suffit de le créer
et d'y ajouter les lignes :

I background.pixmap: /chemin/de/1'image

. atigue Es;?enﬁef: #3

=l
2]
[oiec] (KEv Fite Wemer) {lume ioiniat LTmulmiy St Share/pLRaps Aty
erd]

Fluxhax Con guration Tool
|commsnacomimers _rconipan

g fsinrhythmibase AETiEhara Rk b pm
Aerbinffrefor-3.0 Asiisha sinbmansTireto:-3 0.000
Ertinuta Amrisharcipismaps/fu,xpm

AP DS aname-ten L. ooy

rishare plmapsipe tit-icon. wpm

Ainsi, & chaque démarrage et méme si
vous changez de style, 'image choisie
restera en place. Autre astuce, installer
le paquet ivman qui montera pour vous les
médias amovibles (CDROM et USB) si
vous le lancez au démarrage de Fluxbox,
en l'ajoutant dans le fichier ~/.fluxbox/startup
de cette maniére :

ivman &

C’est ici d'ailleurs, dans ce fichier, que
I'on mettra les programmes a démarrer
automatiquement avec Fluxbox. Il faudra
simplement faire attention & les insérer
avant |a ligne :

I exac fusr/bin/fluxbox

car le gestionnaire de fenétres doit tou-
jours étre démarré en dernier !

Divers moyens existent pour donner
un acces plus rapide aux programmes
couramment utilisés, idesk a nou-
veau [14] [15], fbdesk [16] et méme a
l'aide de ROX [17] ! La page suivante [18]
en livre tous les secrets pour y arriver,
ainsi qu'un trés bon détail des différen-
tes options de configuration de Fluxbox

et constitue donc une grande aide pour
ceux qui voudront aller plus loin. Il y a
méme un paquet nommé fbpanel, qui sera
disponible dans Menu -> Applications ->
Systéme aprés installation et qui res-
semble & s’y méprendre a la Barre des
Taches que propose Gnome (jentends
déja les puristes hurler =;).

Mais, voici une méthode plus radicale
et expresse d’'avoir ses programmes les
plus utilisés rapidement sous la main,
sans meme avoir besoin d’icones, une
maniére de rester dans la « logique »
de Fluxbox : puisque les menus sont
configurables a volonté, autant mettre
directement les plus nécessaires au tout
début de celui qui est proposé lors d'un
clic-droit sur le bureau !

S'il y a bien un fichier ~/.fluxbox/menu, il est
encore basique et le programme fluxmenu
n'indique gu'une référence de sous-menu
vers /etc/X1L/Fluxbox/fluxbox-menu. Ce menu
« par défaut » se met a jour automatique-
ment quand on installe un nouveau pro-
gramme. Avec fluxmenu, il est possible
de personnaliser son menu personnel
en y ajoutant des programmes (exécuta-
bles) ou méme des sous-sections. Trois
informations sont nécessaires : le nom



voulu pour le programme, I'endroit ou il
est installé et I'endroit ol se trouve son
icone (en général, un fichier .png ou xpm
dans fusr/share/pixmaps/).

Pour les programmes détectés par
Fluxbox, on peut donc trouver ces
informations dans le fichier /etc/i11/
fluxbox/fluxbox-m2nu et les entrer simple-
ment dans l'outil de configuration. Un clic
sur le bouton Sauver met alors a jour le
fichier ~/.fluxbox/meny pour nous. Une fois
créée, la nouvelle entrée de programme
peut étre glissée-déposée en début de
liste, le menu original (et complet) deve-
nant ainsi un sous-menu en derniére
position (Fig. 3). La aussi, on peut rede-
marrer Fluxbox sans avoir a quitter sa
session. Les changements sont obser-
vables presque instantanément...

Ainsi, en mettant dans votre ordre favori
vos programmes les plus courants (mul-
timédia, communication ou bureauti-
que), vous y avez acces en un éclair,
sans avoir de bureau encombré ou de
barre supplémentaire & gérer (Fig. 3). Et
vous ne perdrez pas I'avantage de l'auto-
matisme, car le sous-menu « original »
continuera & se mettre a jour tout seul.
Bien sir, vous avez encore a la mettre
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,gm

dans vos « favoris » manuellement, si
vous comptez utiliser ce nouveau pro-
gramme fréquemment...

Pour I'arrét et le redémarrage, la démar-
che est identique que l'astuce donnée
dans le paragraphe sur lceWM, & la dif-
férence qu'il faut passer par fluxmenu
pour créer les entrées nécessaires dans
son format. Avec Ubuntu, on modifiera le
fichier /etc/sudoers de la maniére suivante
pour que cela fonctionne correctement :
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Les programmes compatibles s’y
intégrent directement ou ont une
option -4, comme le frés répandu outil
de surveillance systéme GkrellM.
Ainsi, il suffit de le lancer avec la
commande :

gkrellm - &

pour qu'il se retrouve dans le Slit, et
ce, sur tous les Bureaux ! En ajoutant
cette méme commande dans le fichier
~/ fluxbox/startup, on le lancera automatique-
ment avec Fluxbox.

Cet exemple d'outil de surveillance sys-
téme nous améne directement & un petit
programme fonctionnant trés bien avec
Fluxbox : Conky (voir I'article a ce
sujet page 67). Il suffit d'installer

# Cmnd alias specification

Cond_ATias SHUTDOWH_CHDS = /sbin/shutdown, /shin/
halt, /sbin/reboot

Fadmin ALL=(ALL) ALL

# Members of the admin group may gain root privileges

votre utilsateur ALI=(ALL) MOPASSWD: SHUTDOMN_CMDS

le paquet du méme nom, puis de
le lancer avec la commande :

conky & J

pour voir sa configuration par
défaut. On peut librement modi-

L'une des spécificités de Fluxbox est le
Slit, dont la définition « officielle » est
consultable ici [20]. En résumeé, on peut
dire que c'est une portion de l'affichage
du Bureau, modifiable par l'utilisateur
et ol l'on peut placer des applications
« dockables » ou dockapps [21] [22] que
I'on utilise ou observe réguliérement.

fier les fonctions et l'affichage
de Conky en modifiant le fichier
~f,conkyrc. La liste compléte des variables
qu'utilise ce fichier peut étre consultée ici
[21], mais les exemples de configuration,
parfois accompagnés de captures d'gcran,
ne manquent pas sur Internet [22] [23].
L'avantage du Bureau sans icones est clai-
rement visible grace a Conky qui en devient
partie intégrante et permet de garder sous

#3 Linux Pratique Essentiel
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contréle son systéme, sans trainer dans le
chemin de l'utilisateur (Fig. 4).

Maintenant que vous connaissez mieux ces
gestionnaires de fenéfres, agissant avec les
programmes que vous avez déja installés sur
votre systéme, parlons d'un des plus essen-
tiels : le gestionnaire de fichiers ! C'est par lui
que graphiquement on va pouvoir effectuer
les taches courantes sur les fichiers. Donc,
autant prendre pour cette tache quotidienne
un outil congu avec le méme souci de 1égé-
reté, de simplicité et d'efficacité que les
exemples que nous venons de voir.

0O X FILE
EXPLORER (XFE)

XFE [24] est un gestionnaire de fichiers
du francais Roland Baudin, basé sur le
defunt X Win Commander de Maxim
Baranov et qui revendique clairement
une ressemblance dans 'aspect et dans
l'usage a MS Explorer. |l posséde cepen-
dant beaucoup plus de fonctions que ce
dernier et on peut en voir le détail ici [25].

Mais, en réesumé, toutes les fonctions indis-
pensables et attendues pour ce type de pro-
gramme sont présentes (comme le glisser-
déposer, la visualisation des fichiers texte et
des images, la gestion des archives, la vue
en icénes ou liste, en arbre et avec des pan-
neaux multiples...), mais on y frouve aussi
le montage/démontage de périphériques,
la possibilité de lancer un Terminal ou une
commande, ainsi gue d'ouvrir Xfe en tant que
root (ce qui n'est pas sans risque)...

Dans la méme logique qu'un navigateur
Internet, le bouton heme raméne au dos-
sier utilisateur et il est possible de créer
des signets pour les répertoires lointains
auxquels on doit réguliérement accé-
der. Dernier point, Xfe nécessite l'instal-
lation de FOX toolkit [26] pour pouvoir
fonctionner.

O PCMAN FILE
MANAGER

PCMan (Fig. 5), congu par Hong Jen Yee
de Taiwan, est aussi simple que léger ! Ses
fonctions sont similaires & celles proposées
par son collegue Xfe, l'ulilisation d'onglets et
de marque-pages rappelant ici absolument
Firefox. Il est méme possible de dépla-
cer par glisser-déposer des fichiers d'un
onglet a l'autre. Le montage/démontage des

périphériques est géré par HAL, donc
s'il est correctement déetecté par ce der-
nier, il apparaitra automatiquement dans
PCMan.

Il reprend aussi a son compte les asso-
ciations de fichiers définies sur le sys-
téme et supporte I'encodage des carac-
téres non UTF-8. Programmeé en GTK* 2,
il suit les standards de FreeDesktop.org
qui visent a simplifier I'interaction entre
les différents environnements de travail
existants. Ses qualités Iui ont d’ailleurs
valu d'étre choisi par Neuf Telecom pour
son Easy Gate [27] et sa version libre,
I'OpenGate [28]. Cependant, si le mes-
sage d'erreur suivant, concernant les
icones, s'affiche :

« GTK+ jcon theme is not properly
sel. This usually means you don’t
have an XSETTINGS manager
running. Desktop environment like
GNOME or XFCE automatically
execute their XSETTING mana-
gers like gnome-settings-daemon
or xfce-mes-manager
If you don’t use these desktop envi-
ronments, you have two choices :
1. run an XSETTINGS manager,
or
2. simply specify an icon theme in
~/.gtkrc-2.0.

For example to use the Tango icon
theme add a line :
gtk-icon-theme-name="Tango" in your
~l.qtkrc-2.0 (create it if no such
file) »

Il faudra simplement créer un fichier
~/.gtkrc-2.0 avec la ligne proposée
plus haut, adapté aux thémes instal-
Iés, ce que l'on peut vérifier avec la
commande :

1s fusr/share/themes

En guise de conclusion, & vous de tes-
ter et de découvrir la vitesse et puis-
sance de ces outils méconnus, pour les
plus débutants, en vous appuyant bien
sar en paralléle sur un autre environ-
nement comme Gnome. Cela permet
réellement de découvrir ce que le Libre
peut apporter a un ordinateur, en fonc-
tion de son &ge ou sa puissance, pour
qu’il puisse tirer le meilleur usage de
ses ressources et simplifier la vie a son
(ses) usager(s). H

En savoir plus
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UN BUREAU FONCTIONNEL,

RAPIDE, MAIS NEANMOINS
ELEGANT ET ADAPTE A

SA PERSONNALITE, CEST

LE SOUHAIT DE TOUT UN
CHACUN. CEST POURQUOI
NOUS AVONS REUNI DANS

CE DOSSIER DIVERS OUTILS
ET ASTUCES, QUI VOUS
PERMETTRONT DE DONNER

A VOTRE POSTE DE TRAVAIL
ET A VOS APPLICATIONS
FAVORITES UN TOUT NOUVEAU
LOOK. QUE CE SOIT PAR PUR
SOUCI D’ESTHETISME OU POUR
GAGNER EN ERGONOMIE ..
VOILA PEUT-ETRE AUSSI UNE
FACON DE CONVAINCRE DE
NOUVEAUX UTILISATEURS,

QUI SAIT ?

QUOI QU'IL EN SOIT, NE PERDEZ
PAS DE VUE QUE ’ACTIVATION
 D’EFFETS SPECIAUX EN

TOUT GENRE PEUT ETRE
GENANTE A LUSAGE ET
DIMINUER SENSIBLEMENT

LES PERFORMANCES DE

VOTRE SYSTEME. LE DEFIA
RELEVER ICI EST DONC DE
TROUVER LE JUSTE MILIEU
ENTRE LESTHETISME ET LA
 PERFORMANCE...
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APPLICATIONS « EYECANDY >

PERSONNALISEZ
ET AMELIOREZ LLE
LOOK'DE
VOTRE BUREAUR

Gnome, un bureau « discret » ? Pas si sdr...

KDE4, tout nouveau, tout beau !

Window Maker, un gestionnaire de fenétres leger
et épuré

ION3, un gestionnaire de fenétres minimaliste

DECO & GADGETS

Des effets visuels étonnants grace a

Compiz Fusion

Les gadgets de Google sur mon bureau !
Guake, le terminal qui se cache au plafond !
Gérer ses widgets sous Gnome

Kiba-Dock, s’amuser avec la barre de taches !

Cairo-Dock, un dock personnalisable a souhait !

Personnalisez votre navigateur Web !
Terminal transparent et sans menu

Des informations systéme en fond d’écran
avec Conky

Personnalisez Amarok via un fichier CSS

En mettre plein les yeux a son auditoire
avec OpenOffice Impress !

Modifier Pinterface de Mplayer

Quand votre lecteur audio ressemble a Winamp...
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PERSONNALISEZ ET AMELIOREZ
LE LOOK DE VOTRE BUREAU !

DOSSIER

GNOIVIE UN BUREAU
« DISCRET » 7
 PAS SI SUR

par Fleur Brosseay

Lenvironnement de bureau Gnome est souvent considéré comme plus
classique et plus sobre que son homologue KDE. En effet, si vous conservez
les parametres esthétiques configurés par défaut, il n’a rien de vraiment
séduisant. Et pourtant ! Gnome dISpOSB des ressources nécessaires pour
vous en meftre plein les yeux ! Il suffit d’utiliser les outils mis a votre
disposition et de faire preuve d’un peu d’imagination...

S FRE R a son minimum (en décochant I'option Etendre).
. L E TA B L EAU En outre, vous pouvez customiser voire tableau de
bord en modifiant sa couleur d'arriere-plan ou bien

D E B R D en ajoutant une image de fond (mais attention a

0 : la lisibilité 1).

Lajout d’'une nouvelle applet s'effectue via l'option

Le tableau de bord est un élément essentiel de Ajouter au tableau de bord (Fig. 2). Plusieurs outils
votre bureau : c’est le conteneur de tous les outils bien pratiques peuvent ainsi étre toujours sous la
de configuration et de personnalisation du systéme, main (s'ils ne sont pas déja intégrés par défaut au
des lanceurs d’applications et applets. Par défaut, le tableau de bord de votre distribution), comme l'outil

tableau de bord de Gnome comporte trois menus :
Applications, Raccourcis, Systéme, auxquels s'ajou-
tent des lanceurs d'applications (qui peuvent varier
selan les distributions). Sous Ubuntu, vous disposez
en genéral d'un lanceur pour Firefox et Evolution,
ainsi que pour l'aide utilisateur.

Chatelr un #lément & ajoLter pu tblesa da bord : |
=M Surmmila [acthite récean 'il 4

| Moniteur cystéme
a: indicateur de charge systame F'ﬁg, 2

d Montaur de disques
WH  ronte das disques et perpheriques locaus.

Sur la droite, un clic sur la date et I'neure vous offre i B

Eam Line application de prisa de notas simpls et facile & otfizar,

un acceés rapide au calendrier, au gestionnaire de
taches d’Evolution, ainsi guau sélecteur de votre

5} Palette de caractéres

emplacement géographique qui vous permettra de i R

cibler votre ville et d'avoir un czil sur la météo. | = R

Un clic droit sur le tableau de bord affiche le menu A e A R o e

conte)I(tu.eI via |eqUelIV0US.aCCéderez aux pm[?fié‘ @ g:[d(;::l;‘.mm.changw chutilataur, varmouilar 'ézran ou Ateindre Iordinateur i

tés, ainsi qu'au gestionnaire d'applets. Parmi les §E e g s comet dadneases i
e et Ml Pl = une persanne dens woire camet d'adresses

proprietés, vous pourrez positionner votre tableau | 41 Rachercher dans un dictionnaire

de bord ol vous le souhaitez (en haut, sur les cotés e o o '

de I'écran, etc.) et définir son apparence, autrement _ O | Wi |[aoi
dit 'étendre sur toute la longueur ou bien le réduire o,

@7 Applications Faccourcic  Systome [J@Q Flaur Brozseau »ﬁm Bl C lm o jum, 1824 @

Fig. 1 : Un exemple de tableau de bord Gnome, de taille minimale, centré sur 'écran, compartant quelques applets comme le bloc-
notes Tomboy ou les yeux qui suivent le déplacement de la souris...
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de changement d'utilisateur, le bloc-notes, 'applet météo, le lan-
ceur d'applications, 'applet de luminosité (pour contrdler la lumi-
nosité de votre ordinateur portable).

L’ajout d'un nouveau lanceur d'application peut s'effectuer directe-
ment depuis le menu des applications : effectuez un clic droit sur
I'application choisie, puis choisissez l'option Ajouter ce lanceur au
tableau de bord. Chacun des lanceurs ou des applets peut étre
déplacé via un clic droit, suivi de l'option Déplacer. Positionnez
Iélément a l'endroit qui vous convient, puis cliquez pour valider
la position.

D’APPARENCE

Le gestionnaire d’'apparence (accessible via le menu Systeme ->
Préférences -> Apparence ou via un clic droit sur le bureau, suivi
de l'option Changer P'arridre-plan du bureau) est l'interface qui
vous permetira de parer votre bureau du look de votre choix.
Tout y est centralisé : le théme graphique des fenétres, I'arrie-
re-plan, les polices, I'apparence des menus et barres d'outils et
Factivation des effets visuels (procurés par Compiz).

© LES DIFFERENTS
THEMES GRAPHIQUES

Les thémes proposés par défaut (Fig. 3) avec le bureau
Gnome (que vous pouvez visualiser via le menu Systéme ->
Préférences -> Apparence, onglet Théme) sont issus du paquet
nommé gnone-themes. Mais, il existe un paquet supplémentaire,
gnome-chemes-extra, qui permet d'ajouter deux nouveaux themes a
votre liste : « Unity » et « Darklooks », ce dernier étant particulie-
rement élégant (mais il faut aimer le noir...).

w ol [
=
|| P@uyrir||
oW
Claarlopks Contrazte dlevd
irfveres mwsrsi. ande taills

W ]

Qﬂu\-ri

v e

Parsannaliser le thime

du fonitras | _"

Contraste élevd
imersd, granda talla

@Aidg i

Notez la présence de quelques thémes spécifiques au contraste
accentué pour renforcer I'accessibilité du bureau, spécialement
congus pour les personnes souffrant de déficiences visuelles.

En plus des thémes Gnome, vous disposez de thémes supple-
mentaires pour votre distribution, dont la charte graphique esten
harmonie avec les couleurs de la distribution en question.

Chacun des themes peut étre personnalisé en détail, via le bou-
ton Personnaliser (Fig. 4). Pour un theme choisi, vous pourrez
redéfinir le style des boutons de controle, les couleurs des fené-
tres, des zones de saisie, etc., le style des bordures de fenétre,
le jeu d’icones et enfin I'allure du pointeur de souris. Et vaila,
en quelgues clics, vous avez de quoi créer un théme graphique
complétement personnalisé !

@ DES THEMES SUPPLEMENTAIRES...

Outre les thémes « extras » abordés ci-dessus, sachez qu'il
existe également des jeux d’icones supplémentaires pour
Gnome. En plus du théme Gnome Desktop lcon Theme (paquet
gnome-icon-theme) installé par défaut, remarquez que vous
pouvez installer
les jeux d’icones

suivants : gartoon,

blankon, dlig-neu, F“‘“"-"‘-’ii'““'“f]?ﬂwﬂ*“hﬁw eeres [

gperfection2, i

nuovo, suede Fig. 5
et yasis. Il y en f, Cystal VG

a pour tous les 2

golts ! Gartoon se } SR

compose d’icones ﬂ T

ludigues et colo- :
rées, dessinées i
ala maniére d'un

v . . ! Dropline Muovo
dessin animé,
tandis que le =
jeu BlankOn est
beaucoup plus ) oo

classique... B o
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Gnome, un bureau « discret » ?
Pas si sdr.

Pour faire votre choix,
allez faire un tour dans
le gestionnaire d'appa-
rence et dans l'onglet
Themes, cliquez sur le
bouton Personnaliser,
ce qui vous permettra de
choisir un jeu d'icénes
pour le theme graphigue
sélectionné (Fig. 5).

@ LARRIERE-
PLAN

Voila une chose & ne pas négliger, car le choix
de l'arriere-plan du bureau refléte souvent la
personnalité de son utilisateur... Comme pour
les thémes graphiques, le gestionnaire d’appa-
rence offre par defaut quelques arriére-plans
Gnome et specifiques a votre distribution.
Pas beaucoup de choix en somme...

Thima. Armitrs.plan [Bnkcs foancinen | e s

Bapier peint du bureau

Caulours

Caudsur unin -] = . &

[BE i i Ecrmes

Pour en obtenir d'autres, allez faire un tour
sur le site http://www.gnome-look.org, rubri-
que Wallpapers. Vous trouverez a coup sir
un arriére-plan qui vous convient, vu I'éven-
tail d'arriere-plans en tous genres qui vous est
proposé. Lorsque vous avez fait votre choix,
cliguez sur le lien download qui se trouve en
dessous de I'arriére-plan, puis enregistrez
I'image dans le répertoire de votre choix.
Ensuite, rendez-vous dans le gestionnaire
d'apparence (Fig. 8), onglet Arriére-plan, puis
cliquez sur le bouton Ajouter, afin d’aller récu-
pérer I'image précédemment t€léchargée. Et
voila | Celle-ci s’ajoute a I'ensemble de vos
arriére-plans.

Notez que les arriere-plans livrés avec votre
distribution sont généralement stockés dans
/usr/share/backgrounds/. Les arriere-plans
intégrés par défaut a votre environnement
Gnome se trouvent, quant & eux, dans /ust/
share/pixmaps/backgrounds/gnome.
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UN FOND D’ECRAN
ANIME TYPE FEDORA
POUR UBUNTU HARDY

Les versions récentes de Fedora ont la particularité d'in-
tegrer un fond d'écran dynamigue, qui change de couleur
tout au long de la journée. Un effet discret et sympathi-
que. Vous utilisez Ubuntu et vous aimeriez bénéficier de
la méme chose ? Pas de probléme !

Tout d'abord, il vous faut un écran animé. Vous pour-
rez en trouver sur le site http://www.gnome-look.org/,
en lan¢ant une recherche du mot « animated ». Nous
choisissons par exemple I'arriere-plan animé nommeé
« All day Long ». Telechargez l'archive correspondante,

puis decompressez-la sur votre disque. Le répertoire

obtenu contient plusieurs images (une pour chague
moment de la journée), ainsi guun fichier .xnl qui décrit
le comportement du fond d'écran.

Pour ce théme-ci, il suffit d’éditer le fichier .xml et d’y
modifier chague occurrence du chemin vers les images
en fonction de I'endroit ol vous les avez enregistrées :

<static>

<duration>18004.0</duration>

<file>/home/fleur/tmp/Al1DayLong/@8.png</file>

<fstatic>

<l-- i1 ast Bh -->

<transition type="overlay">
<guration>7200.0</duration>
<from>/home/fleur/tmp/A11DayLong/B8. pna</from>
<to>/home/fleur/tmp/A110ayLong/B1.png</to>

<ftransition>

Ensuite, effectuez un clic droit sur le bureau, choisissez
Changer I'arriére-plan du bureau, cliguez sur le bouton
Ajouter dans la fenéfre des préferences, puis, dans le
navigateur, selectionnez le fichier .xml (il faut sélectionner
l'option Tous les fichiers dans le menu déroulant en bas
a droite, sinon votre navigateur n'affiche que les fichiers
au format d'images). Et voila ! Vous aurez le plaisir de
constater le changement tout au long de la journée... W

Un exemple d'arriere-plan « animé » proposé par Edgar Rene Flores
Balacazar sur www.gnome-lock.org ; les couleurs de (fmage changent
en fonction du moment de la journée...
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@ LES POLICES

Dans l'onglet Polices du gestionnaire d’apparence (Fig. 7). vous
pourrez sélectionner une police bien spécifique pour les applica-
tions, le titre des fenétres, les documents et le bureau. Attention,
modifier la police pour les applications signifie que la police des
menus, des différents boutons d'actions et fenétres de dialogues
sera modifiée ; cela peut donner quelque chose de trés sympa-
thique, mais pas forcément toujours lisible & 'usage ! Je conseille
de ne modifier que la police des titres des fenétres et du bureau,
dont 'impact est moindre, dans ce cas...

@ MENUS ET BARRE D’0UTILS

L'onglet Interface vous permettra de modifier lapparence de vos
menus et barres d’outils. Concrétement, vous pourrez supprimer
Iicdne qui se trouve en face de chaque entrée de menu et modifier
les étiguettes des boutons d'actions (voire les supprimer comple-
tement pour n‘afficher que les icdnes correspondantes). Faites le
test, 'apergu vous permet de contréler le résultat...

GNOME-ART : CHANGEZ DE STYLE EN UN CLIG !

Le paquet gnome-ert désigne une petite interface graphique
qui vous permet dlinstaller facilement des themes recuperes
sur art.gnome.org. Une nouvelle entrée est creee - menu
Systéme > Préférences -> Art Manager. Dans la petite fenétre
qui apparait a l'écran, rendez-vous dans le menu Art afin de
sélectionner I'objet de votre recherche. Ici Art-> Backgrounds ->
Gnome. Aussitdt, ceux-ci sont téléchargés depuis le site art.
gnome.org (attention, il y en a pour un moment It).

Une fois tous les fichiers listés, vous pouvez sélectionner I'un
ou l'autre, puis cliquez sur Preview pour oblenir un apercu
de P’arriere-plan en question. S'il vous convient, vous n'avez
qu'a cliquer sur Install, puis vous rendre dans le gestionnaire
d’apparence pour sélectionner votre nouvel arriere-plan.

'@ ’ECONOMISEUR

file At Help

Thémas de léconomiseur d'écran ©
| [T — =18
Hufo's Tunmel
Hyperspace
FaghPull ;
|
Lavalite ks
Lackward
Matridies ;
Matasalls J
MirrorEkab -
maabiuz
| MoebiusGears
Maoleculs g
Morphan ﬂ
rfpeny
ey e e e e s s |
o B : 3
[ Agtiver Péconomizeur d'écran quand lordinateur est nacti f
1 Werrouilier Fécran quand Péconomiseur décran ast acti 'ﬁg" Q
(@aide A} Gestin da Henergis | earmer |
™ 4

L'économiseur d'écran est 'image animée qui est activée aprés un
laps de temps d'inactivité de votre ordinateur. Linterface de gestion
de I'économiseur d’écran est accessible via le menu Systéme ->
Préférences -> Economiseur d’écran (Fig. 8). Pas moins de 80
économiseurs d’écran vous sont proposés. Vous n‘avez qu'a
sélectionner celui que vous préférez, puis définir le laps de temps
a partir duquel votre ordinateur sera considéré comme inactif.

Outre divers effets graphiques, on pourra remarquer 3 cono-
miseurs tout a fait intéressants si vous aimez la diversité : tout
d'abord, le mode Aléatoire, qui, comme son nom l'indique, affiche
'un ou l'autre des économiseurs proposés de facon aléatoire ;
le mode Dossier d’images affiche en mode diaporama les
images contenues dans votre répertoire personnel ; et, enfin,
Photos F-Spot permet d'utiliser comme économiseur un diapo-
rama des photos situées dans vos Favoris F-Spot.

2mentaires avec effets 3D. Rappelons que

Ele At Help

GMOME Backgrounds

Gnome Redblured
Resoluton; 1600x1200
Author: elnays
Gnome Weird colors
Resolution; 1250x1024
Author: eimaya

GMOME Backgrounds

Gnoame Watarmelon
Resolution: 1260x1024

Author: elmays
Gnome Caustics
Rewiugon: 128051024
Author: elmaya
Gnome Tiling
Resciution: 12801024
Authar: efmaye
Gnome Grafitiade
Resolution: 1280x1024
Authar: elmaya
Gname Orange
Resolution: 1200x1024
Author: elmaya

Downloading background 65 /1211

Gnome Nome
Aesolution; 1280x1024

Laliste estlongue ! H
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Gnome, un bureau « discret »
Pas si sir...

Sil'option Verrouiller Pécran
quand I'économiseur d’écran
est actif est sélectionnée (et
il est conseillé de le faire pour
eviter qu'un tiers manipule
votre systéme lorsque vous
vous absentez momentané-
ment...), alors vous devrez
re-saisir vos login et mot de
passe pour vous reconnec-
ter le moment venu. Sachez
que cette boite de dialogue
qui vous demande de vous
identifier est egalement personnalisable.

Vous trouverez quelques exemples de boites de dia-
logue sur le site gnome-look.org, comme toujours,
dans la section Screensavers. Pour utiliser le screen-
saver de votre choix, teléchargez l'archive du théme
choisi, puis decompressez-la et copiez I'ensemble
des fichiers contenus dans le répertoire obtenu,
dans le répertoire /usr/share/gnome-screensaver/.
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Gnome Lock Dialog Silver, proposé par Andreas Holz sur
www.gnome-look.org.

Ensuite, lancez gconf-editor (installez ce paquet
si ce n'est pas déja fait...), puis, dans la section
apps -> gnome-screensaver, modifiez la valeur
de lock-dialog-theme (Fig. 8). La valeur a utiliser est
precisée dans la description du théme, sur le site
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gnome-look.org. Pour notre théme (Fig. 10), nous
entrons la valeur silver. Pour tester votre nou-
veau screensaver, verrouillez votre bureau, puis
reconnectez-vous !

® [’ECRAN DE

CONNEXION

GDM (GNOME Display Manager) permet de gérer
les différentes connexions & votre systéme. Celui-ci
pouvant étre utilisé par plusieurs utilisateurs, GDM
propose une interface de connexion dans laquelle
il faut saisir son login et son mot de passe, et offre
quelques options comme le choix de la langue par
défaut et le choix d'un environnement graphique
(si plusieurs sont installés).

Si l'lllustration et I'allure globale de votre écran de
connexion ne vous conviennent pas, sachez qu'ils
peuvent étre modifiés via le menu Systéme ->
Administration -> Fenétre de connexion, onglet
Locale (cette action nécessite d’entrer votre
mot de passe) (Fig. 11).
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Encore une fois, vous trouverez des écrans de
connexion supplémentaires sur 'incontournable site
gnome-look.org (section GDM Themes). Pour instal-
ler le théme de votre choix, téléchargez-le via le lien
prévu a cet effet et enregistrez-le sur votre disque
(il s"agit normalement d'une archive de théme, sous
forme de fichier .tar.gz). Veillez & bien télécharger la
version « écran de connexion », car certains themes
sont déclinés en splash screen ou en fond d’écran

également.

Ceci fait, rendez-vous dans les préférences de la
fenétre de connexion, onglet Locale, puis cliquez
sur Ajouter afin de sélectionner l'archive gque vous
venez de recupérer. L'image de votre nouvel écran
de connexion apparait dans la liste. N'oubliez pas de
cocher le bouton radio correspondant pour I'activer.



BUREAU

COLOREZ VOTRE BUREAU !

[23 GNOME WOER OOKR 0,23

o :
T AL R L2 5Tia]

Pour personnaliser E
les couleurs de votre
bureau, changer la
police ou la taille des
icones, il existe un
utilitaire assez prati-
gue, nommeé Gnome
Color Chooser (http:/l
gnomecc.source-
forge.net!/). Une
fois installé (paquet
gnome-color-chooser),
il se trouve dans le
menu Systeme ->
Préférences -> Gnome
Color Chooser. Il vous
permetira de changer
la couleur de fond, les
couleurs de la déco-
TS ration des fenétres, la

couleur des bulles d’aide, etc., mais aussi de changer la taille des
boutons, des barres de defilement, etc.

Eichier  2ide

4 couleurglobale  Teblesw de bard | Bureau J Speciigus [ Icanes |}

Tableau de bord
mmnt-plan | Asrigre-plan

narreesl

sushrillance

sélactionng

alt. selectionne.

désactive

Paliee: i Purisa Medium O !

Menu demarrer

Pag encore possible avec GHOME

Dicalage sur M x —T7 Décalaga surFaxa y = |
{das widgat=] O B e ol H§

Prafile: Hena

Linterface de Gnome Color Chooser se divise en plusieurs
onglets : Couleurs globales, Tableau de bord, Bureau, Spéecifigue,
feénes el Moteurs de rendu. |“onglet Couleurs globales corres-
pond aux couleurs des menus et des différentes applications.

1jun 2008 13:26:00 CEST 107 slérment;

Attention, notez bien que seules les applications basées sur . e R
la bibliotheque Gtk seront affectées par vos madifications. [ imidia a0 o ken e oA i 0EABLCEST 0 lank Lianve
En effet, si vous avez installé quelques applications KDE (donc e L
basées sur la bibliothéque Qt), comme Amarok, K3B, eic., cel- : e 12 ms 208 1514 > demanes oz

dim 15 wr 2007 1

les-ci conserveront leurs couleurs d'origine. Et si vous avez pour ; mar 17 i 2358 1 57 154 dienanda dosior
habitude d’utiliser le navigateur web Firefox 3, sachez que vos it U et
modifications affecteront également les boutons d'actions des . R e e
sites de recherche comme Google, Wikipédia, etc., puisque Ia i R
derniére version de Firefox s'adapte au theme graphique de votre Gion mar 17 un 2008 15333 ce57
environnement Gnome. Done, attention au choix des couleurs... w = b e i
Vlous pourrez précisément définir les couleurs d'arriere-plan et it S e
d'avant-plan (qui correspond au texte en fait), et ce, pour chaque Gew panlemalom 555 ce i g
« état » dun élément, autrement dit lorsque 'élément est en mode . e i S
normal ou survolé avec : 3 i R SR e e S
la souris (surbrillance) b3 e e R e

ERTRETE cones Lo caneris (8 ou si vous cliquez des-

RSt e {eokine e cus (sélectionné), etc.
; Pour faire vos choix
de couleurs, il faut
tout d’abord cocher la

case, puis cliquer sur le couleur d'arriére-plan, ce qui permet d'obtenir quelque chose
carré de couleur afin de de beaucoup plus « fun » que la traditionnelle barre grise de
sélectionner la nouvelle Gnome... longlet Bureau, permet entre autres, d'activer la sur-
couleur dans le cercle brillance du texte qui se trouve sous les icones au passage de la
chromatigue. N'oubliez souris ou encore de définir une nouvelle couleur pour la zone de
pas de cliqguer sur sélection. Les couleurs des infos-bulles, quant a elles, peuvent
Appliguer pour valider étre modifiées via l'onglet Spécifigue.

infosbalies wos modiications, Je vous invite a tester par vous-méme ce petit utilitaire tres pra-
Dans l'onglet Tableau tique, d'autant plus que les résultats peuvent étre visualises « &
de bord, Vvous pourrez la volée » dés que vous cliquez sur Appliquer. Et sivous en avez
choisir une police plus marre de toutes ces couleurs, il vous suffira de décocher toutes
originale et modifier la les cases pour revenir « a la normale »... H
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Si vous aimez le change-
ment, n'heésitez pas a sélec-
tionner l'option Sélection
aléatoire, dans le menu
déroulant Théme ; de cette
fagon, I'un ou l'autre des
écrans de connexion de la
liste sera affiché a chacune
de vos connexions.

Remarquez également l'op-
tion Message de bienvenue
tout en bas de la fenétre qui
offre la possibilité d'afficher
un message personnalisé lors de votre connexion.

® LE SPLASH
SCREEN

Le splash screen désigne, de maniére générale, la
premiére image affichée par un logiciel. On pourra
ainsi parler de splash screen pour désigner I'image
d‘arriere-plan qui apparait lorsque votre systéeme
d'exploitation démarre. Vous pouvez visualiser une
telle image si vous avez opté pour un démarrage en
mode graphique et non en mode texte bien sir.

A ce propos, si vous souhaitez passer du démarrage
en mode texte au mode graphigue (ou vice versa),
il suffit d'éditer votre fichier /boot/grub/menu.1st avec
I'éditeur de texte de votre choix (au hasard, gEdit) et,

dans la ligne kernel du systéme que vous démarrez
habituellement, de rectifier les paramétres passés
au noyau : ajoutez l'option quist splash pour un démar-
rage graphique ou, au contraire, supprimez cette
option pour un démarrage en mode texte :

#r ## End Default Options ##

title Ubuntu 8.84, kernel 2.6.24-16-generic
root {hdd,8)
kernel /boot/vmlinuz-2.6.24-16-generic

root=UUI0=9637cdda-447e-4211-8994-
fc9Bcaa2d?o2 ro quiet splash
Tocale=fr_FR

initrd /boot/initrd.img-2,6,24-16-generic

Pour modifier aisément notre splash screen, deux
utilitaires specifiques s'offrent a nous - le Gnome
splash screen manager ou le Gnome start-up
manager. Ce dernier est beaucoup plus complet
puisqu'en plus de la gestion des splash screens,
il permet de configurer Grub trés facilement, sans
avoir a éditer le fichier de configuration a la main.
C'est donc celui-ci que nous allons utiliser.

Pour linstaller, installez le paquet nommé startupmanager
a l'aide de votre gestionnaire de paquets. Ceci
fait, vous pourrez le lancer via le menu Systéme ->
Administration -> Gestionnaire de démarrage
Start-up Manager. Linterface comporte 4 onglets :

Options de démarrage (Flig. 12) : c'estici que vous
pourrez definir le systéme d'exploitation a démar-
rer par defaut, le délai qui doit s’écouler avant que

LE TERMINAL TOUT EN TRANSPARENCE...

Ca n‘a I'air de rien, mais taper
vos commandes dans un ter-

Brher Edeon ffichage Jereimal Gegite Aide

minal transparent peut faire SRS

pas mal d'effet autour de
vous ;-). Pour rendre votre ter-
minal translucide, rien de plus
simple : rendez-vous dans le
menu Editien -> Profils du ter-
minal de Gnome. Sélectionnez
dans la liste le profil que vous
utilisez habituellement, puis
cliquez sur Edition.

Dans l'onglet Effets, acti-
vez l'option Arriére-plan
Transparent ; le curseur juste
en dessous vous permet de
regler finement le niveau de
transparence souhaitée. Cegi
necessite bien sar ractivation
de Compiz (effets visuels en
mode «normal» ou «extra»).
Etvoila! B
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UN LOOK VISTA
POUR UBUNTU !

Installez tout d'abord le paquet enerald a l'aide de
votre gestionnaire de paguets graphigue ou en ligne
de commandes.

Télechargez ensuite les themes el icones suivants
sur le site gnome-look.org :

True Vista Experience (un theme Beryl Emerald
proposeé par Pekny Gleb) ;

LiNsta (LilVsta is Not Vista =) (un theme GTK2 x
propose par Etienne Alaurent) ;

Aero-CrazyFolk-RC1 (icones Gnome proposees par
Oytun Ozdemir).

Puis, rendez-vous dans le menu Systéme -> Préférences -
Gestionnaire de thémes Emerald. Cliquez sur Import,
puis sélectionnez le fichier préalablement télécharge sur
gnome-look.org (51976-vista.enerald). Quittez application.

Dans Systéme -> Préférences -> Apparence, onglet
Theme, cliquez sur Installer, puis sélectionnez
Farchive du theme « LiNsta » précédemment récu-
pérée ; répétez l'opération avec le theme d'icénes
« Aero-CrazyFolk-RC1 ».

Cliguez ensuite sur le bouton Personnaliser. Dans
I'onglet Contréles, sélectionnez le theme LiNsta-
Gtk2 : dans 'onglet Bordures de fenétres, sélection-
nez Human ; dans l'onglet feénes, selectionnez Aero-
CrazyFolk-RC1. Fermez enfin la fenétre de person-
nalisation. Dans le gestionnaire d'apparence, cliguez
sur Enregistrer sous, afin de donner un nom & voire
nouveau theme (par exemple « Vista-like »).

Votre bureau arbore désormais des icones fres simi-
laires a celles que l'on trouve sous Windows Vista et
remarguez que les différentes fenétres sont dotées d'un
effet de transparence (un effet de verre) trés elégant
(d0 au theme Emerald installé precedemment). Il ne
reste qu’a trouver un fond d'écran adéquat et vous ne
reconnaitrez plus votre systéeme Ubuniu! H

le systéme ne démarre automatiquement ou encore quelques

paramétres d'affichage.

Emerald est un décarateur de fenétre gui s’utilise avec Compiz. Il permet de gérer differents the-
mes de fenétres, des fichiers au format .ENEFALE que vous pouvez récupérer str gnome-look.org.
Aprés installation, Emerald est accessible via le menu Systéme -> Préférences -> Gestionnaire
de themes Emerald. L'ajout d'un noliveau theme s'effectus via un clic surle bouten Import. Pour
activer le theme de votre choix parmi ceux que vous avez installés, if suffit de cliquer dessus
dans la liste. Remarquez que vous pouvez modifier n'importe quel théme via l'anglet Edition.
Vous pouvez ainsi changer de moteur de rendu, laspect des boutons, la couleur et l'opacité das
ombres, Faspect des barres de titre, etc.
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Rappel : Grub est le gestionnaire de démarrage ut r de nombre

s Linux, gui per
L'onglet Sécurité permet de mettre en place un mot de passe lorsque plusieurs OS sont installés sur votre disgue.
pour le chargeur-amorce, le mode de secours et les anciennes
options de démarrage. Ceci est facultatif.

Pour la couleur du texte, rien de compliqué : il suffit de sélectionner

L'onglet Configuration avancée permet notamment de limiter le les couleurs qui vous conviennent dans les menus déroulants pré-
nombre de noyaux a afficher (pratique si, 4 chaque mise a jour vus a cet effet. Pour ajouter une image d'arriére-plan, sachez que
du noyau de votre systme, chacune des versions demeure vous pouvez commencer par installer le paquet grub-splashinages,
dans le menu...). qui comporte une quinzaine d’'images differentes. Linstallation de
Apparence : cC'est cet onglet qui nous intéresse particulierement ce paquet crée un répertoire /boot/grub/splashimages dans lequel se
ici (Fig. 13). Il permet de définir les couleurs du menu Grub, de situent toutes les images proposées.

définir éventuellement une image d'arriere-plan pour ce menu Par ailleurs, vous pourrez trouver des images supplémentaires

(attention & Ia lisibilite !) et de définir un splash screen.

pour le menu Grub sur les sites suivants : http:/lschragehome.de/

Intéressons-nous tout d'abord a la « décoration » du menu Grub. splash/ et http://www.schultz-net.dk/grub.html.
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Ensuite, il vous faudra éditer le fichier /boot/grub/meni. st
et ajouter la ligne suivante :

B Ferroer

splashimage=(hd@,)/boot/grub/splashinages/image.xpm.gz

ou (hdB,f) correspond a /dey/sdal (a adapter selon
votre cas) et image.xpm.gz l'image que vous aurez
choisie.

Dans l'interface du Startup-manager, onglet
Apparence, Vous pourrez ensuite activer 'option
Utiliser I'image d’arriére-plan pour le menu de
démarrage et sélectionner l'une des images propo-
sées dans le menu déroulant.

Notez que vous pouvez également créer votre pro-
pre image a l'aide de Gimp par exemple. Dans ce
cas, il vous faudra créer une image de 640x480
pixels et de convertir 'image en couleurs indexées
(menu Image -> Mode -> Couleurs indexées). Dans
la boite de dialogue qui apparait, choisissez 'option
Générer une palette optimale et entrez 14 comme
Nombre maximal de couleurs, puis cliquez sur
Convertir. Ceci fait, enregistrez votre image sous
le nom splash.ipm dans le répertoire de votre choix.
Ensuite, en ligne de commandes ou via un clic droit
dans votre navigateur de fichiers (option Créer une
archive), compressez votre image sous forme d'ar-
chive splash.xpm.gz a l'aide de Gzip.

Pour finir, copiez cette image dans le répertoire
/boot/grub/splashinages et n‘oubliez pas d’'ajouter la
ligne splashinage=... dans le fichier menu.Tst comme
expliqué ci-dessus.

Concernant le splash screen (voir 'exemple Fig. 14),
qui correspond ici au choix du Théme Usplash, le
menu déroulant vous propose de sélectionner une
image parmi celles contenues dans le répertoire
fusr/1ib/splash/. Ces splash screens se présentent
sous forme de fichiers .s0. Pour en récupérer de nou-
veauy, effectuez votre choix sur le site gnome-look.
org. puis desarchivez le splash screen sur votre
disque dur. Ensuite, dans linterface de Startup-
manager, rendez-vous dans l'onglet Apparence,
puis cliquez sur le bouton Gérer fes thémes Usplash.
Dans la fenétre qui apparait, cliquez sur Ajouter,
puis sélectionnez le fichier .50 précédemment récu-
péré. Ensuite, dans le menu déroulant, sélection-
nez le splash screen de votre choix, puis fermez le
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Fig. 74 : fci Fugrooth
usplash theme
‘% Proposé par
L Andreas
J Euchner sur

gnome-look.
org.

startup-manager. Vous pourrez observer le résultat
au prochain démarrage de votre ordinateur !

Notez que vous pouvez également créer votre
propre splash screen, mais ceci est un peu plus
complexe et dépasse le cadre de cet article. Ceux
qui souhaitent néanmoins en savoir plus peuvent
consulter cette page : http://[doc.ubuntu-fr.org/
tutoriel/creer_un_theme_usplash, qui propose
un didacticiel détaillé.

Un autre splash screen que vous pouvez modi-
fier selon vos convenances est celui qui appa-
rait au chargement de votre environnement gra-
phique, apreés vous étre identifié. Il s’agit d’'une
simple image au format .png, qui se trouve ici :
lusr/share/pixmaps/splash/qnome-splash.png. Pour utiliser
l'image de votre choix, déplacez-la dans ce méme
réperfoire, puis renommez-la en gnone-splash.png
(I'ancienne image pourra étre renommée au préala-
ble en gnome-splash_old.png par exemple).

CUCLU

Comme vous avez pu le remarquer, le site www.
gnome-look.org est incontournable si vous sou-
haitez relooker votre bureau (a metire dans vos
favoris !). De nombreux utilitaires graphiques, trés
simples & utiliser, sont & votre disposition pour per-
sonnaliser votre environnement de travail selon
vos golts, alors n’hésitez pas & en user (sans trop
en abuser!). B




¥ BUREAU

par Aline Geérard

KDE4, TOUT NOUVEAU, TOUT BEAU |

Larrivée de KDE4 offre 8 KDE une nouvelle fraicheur avec une interface
completement revisitée qui la rend trés agréable a I'eil. Bien quavec
cette nouvelle version nous pensons tout d’abord « effets de bureau » et
plasmoides, nous allons aussi aborder la configuration de base, valable |
pour n'importe quel environnement de bureau (ou presque). Nous traiterons
egalement la configuration des themes de KDEA4.

Les configurations du gestionnaire de fenétre se déroulent dans
le menu Configuration du systéme -> Apparence (Flg. 1).

KDE4 nous propose un habillage par défaut noir et blanc : le
tableau de bord est noir et le theme de fenétre « Oxygen » se
pare des couleurs blanche et grise. Il est accompagné de nou-
velles icones représentant chaque type de fichier. Cet habillage
pourra vous plaire ou non, mais, dans tous les cas, il est possible
de l'adapter a vos envies. Le regard est certainement attiré prin-
cipalement par les couleurs et les formes, certaines nous étant
plus agreéables que d’autres. Nous allons donc commencer par
modifier les couleurs principales des fenétres et leurs formes. Bien
entendu, nous adapterons le fond d'écran, les icénes et les cur-
seurs de la souris. Précisons dés maintenant qu’il sera peut-étre
necessaire de redémarrer la session pour visualiser les résultats
reels obtenus. En effet, lorsqu'on modifie plusieurs fois un style,
il arrive que ceux-ci se mélangent un peu !

Si GTK est installe, une partie Styles et Polices GTK est pre-
sente dans le menu de gauche permettant de configurer les
applications utilisant GTK, principalement les applications
Gnome, mais aussi Firefox. Dans la partie GTK Styles, on choi-
sit d'afficher ces fenétres selon le style de KDE ou un autre
style installé. Le rendu KDE sur une application GTK n'étant
pas forcément des plus belle. On corrigera cela en installant le
paquet gtk-gi-engine ou gtk-qt-engine-kded, puis en choisissant Use
another style Qt4 (ou Qt selon le résultat obtenu).

On modifie I'apparence des fenétres dans la partie... Fenétres.
Par défaut, on a donc la décoration « Oxygen » qui convient
parfaitement au nouveau style de KDE, mais rien n'empéche
d’en changer en choisissant parmi les décorations proposées.
KDE4 possede également le nouveau théme « Ozone » qui
s'adapte aux couleurs choisies pour la décoration des fenétres
(avec le théme Oxygen, la barre de titre des fenétres garde tou-

jours la méme couleur). Un onglet Boutons per-

met de déplacer facilement par glisser/déposer

les boutons de la barre de fitre des fenétres,

petermine le stvie et les polices utilisés par les applications G1E

BTK Stybes

o | = L= oy KDE sty In STE applicationa
Fanitres J

“."?".

Coulcurs

mmezzsl | Use ancther ater | 06 v

e
Ematicines = Unn muEDE fants in STE applicatians:
1 Use ancther font  Shange..
styla Dejavu Sena ate 101

The Cuiick Brawn Fax Jumped Cer Thae Laz: Rog
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Irrstall Serollnar ...
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Icanes Hite that zhangn madn hars wil anks stk T8 applicatione whan KDE i runring,  To changs the sz and fants ussd by appbeaklens in

d'en ajouter et d'en supprimer.

En troisiéme partie, nous avons les couleurs
qui modifieront grandement le rendu de I'in-
terface. Plusieurs modéles sont proposés,
du plus sombre au plus flashy en passant
par les neutres. Le choix est grand, mais
il est possible de télécharger, directement
depuis cette interface (bouton Get New
Schemes), d'autres modéles disponibles sur
le site www.kde-look.org. Cette option bien
pratique, appelée Get Hot New Stuff, facilite
l'installation d’'un nouveau théme et est dis-
ponible dans d’autres interfaces de configu-
ration, notamment dans la partie Jeénes. Une
fois que I'on a choisi un modéle de couleur,
on peut modifier Ia couleur des differents
éléments d’'une fenétre depuis les onglets
Couleurs et Effets.
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Hig. 3 [cbnes du théme
Enfants

» Revenons & la configuration des fenétres avec

la partie Style qui permet de configurer I'appa-
rence des boutons, des onglets, des barres de
défilement et barres de progression. On retrouve
ici le style Oxygen associé par défaut & KDE4.
Les autres styles proposent des interfaces plus
Ou moins carrées ou rondes.

* Nous avons vu des formes et des couleurs. Pour

completer le tout, on peut modifier le style de
caractéres dans la partie Polices. Ceci est tou-
jours délicat & modifier, une police trop extrava-
gante rendant le plus souvent une lecture des
menus difficile. De nombreux tests seront cer-
tainement nécessaires pour en trouver une qui
corresponde a vos golits et vos besoins.

Nous passons maintenant & I'Ecran de démarrage
(Fig. 2) avec quelques thémes proposés, mais
rien d'exceptionnel | Pour avoir quelque chose
de plus travaillé, on pourra en télécharger un
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provenant du site www.kde-look.org ou créer son
propre théme. Apres téléchargement, le theme
est installé dans ~/.kded/share/apps/ksplash/Themes/
ce qui peut empécher le test du théme depuis le
bouton Test theme. Pour résoudre ceci, on
copiera le dossier du théme dans le répertoire
fusr/lib/kded/share/kded/apps/ksplash/Themes/.

Pour la création de son propre théme, on pourra sim-
plement ajouter un fond d’'écran, le théme de char-
gement par défaut s’appliquera par-dessus. Pour
cela, on aura juste besoin d’un fichier background.png
aux bonnes dimensions. Le plus simple &tant de
reprendre un théme existant ou téléchargé et de
madifier les images en gardant leur nom de fichier
original. Le fichier Thene.rc contient des informa-
tions sur le théme, comme son nom et son auteur.
Il est facilement éditable. Pour un théme entiére-
ment personnalisé, on pourra procéder de la méme
maniére, c'est-a-dire télécharger un théme avec un
jeu d'images plus complet et remplacer les images
par d'autres. On pourra également éditer le fichier
description.txt qui correspond aux étapes d'affichage
des icOnes de chargement.

walipaper

Image
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[Fig. 5: Un bureau « Bonbon » qui a pour configuration : des fenétres
0zone, des couleurs Cherry B10S50M, un theéme d'icones
Infants, je fond diécran La feuille rouge et fe théme de
bureau SHim-glow.

Pour finir et compléter la personnalisation de linterface,
on va choisir le theme d'icones utilisé par KDE. Comme
précédemment, on choisit un theme parmi ceux proposes
ou ceux disponibles sur le site spécifique de KDE. Les
icones (Flg. 3) sont celles représentant les différents types
de fichiers, mais aussi celles du lanceur d'applications ainsi
que celles de KDE présentes sur le tableau de bord. Dans
I'onglet Avancé, on choisira l'apparence des dossiers : leur
couleur et leur taille.

Nous avons vu la tout ce qui se configure dans le menu
Apparence de la Configuration du systéme. Toujours dans
Configuration du systéme, on pourra choisir un théme de
curseur de souris dans le menu Clavier & Souris -> Souris ->
Théme de curseur. C'est aussi dans la Configuration du
systéme, mais cette fois dans la partie Bureau, que 'on
choisira son écran de veille. On a ici des choses assez
classiques, rien de bien nouveau pour KDE4.

Ceci donc pour la premiére partie de la configuration. Mais

ne manque-t-il pas quelque chose ? Peut-étre la person-
nalisation du fond d’écran et du tableau de bord ! Cela se passe
sur le bureau avec un clic droit, puis Desktop Setting. Une fenétre
s'ouvre permettant de configurer ces deux éléments et I'option
Show desktop icons cache les icones du bureau lorsquelle est
cochée (Flg. 4). Ceci permet de rendre le bureau tout propre et
tout joli.

De trés belles images de fond d'écran sont proposees par défaut
dans KDE4 ol la nature est mise en avant. Nous utiliserons celles-
ci dans les captures illustrant la personnalisation du bureau KDE4.
A la suite du fond d’écran, on peut changer 'aspect du tableau
de bord a l'aide des quelques thémes proposes, mais on pourra
également personnaliser celui-ci nous-mémes, pour le moment
en modifiant un théme existant (on peut également en télécharger
un provenant du site de KDE).

Comme pour les configurations qui vont suivre, le plus simple pour
commencer a créer son propre théme est de partir d’'un théme
existant. On copie par exemple le theme par défaut présent dans

Just/1ib/kded/share/kded/apps/desktoptheme/ dans notre répertoire
personnel .kded/share/apps/desktopthene/ en n'oubliant pas dele
renommer. Dans ce dossier, trois éléments nous intéressent -
le fichier metadata.desktop dans lequel on indigue le nom du
projet, le fichier colors qui permet de définir les couleurs du
theme (ce fichier est optionnel) et le répertoire widgets. On
trouve dans ce dernier une série de fichiers .svg définissant
I'aspect des plasmoides et du tableau de bord. On ouvrira
ces fichiers avec un éditeur svg, par exemple avec Inkscape,
afin de les modifier & notre convenance. |l suffit ensuite de
tester le théme. Pour le moment, les thémes disponibles
sont noir ou blanc avec différents niveaux de fransparence,
plus le théme « Fluffybunny » qui ajoute des plumes roses
sur le contour des éléments de plasma.

On pourra également configurer la taille et Femplacement
du tableau de bord & I'aide de la petite icéne plasma pré-
sente a droite de celui-ci. Un clic sur celle-ci ouvre une petite
réglette permettant d'ajuster sa longueur et sa position au
bas de I'écran.

Fig. & : Un bureau « Matrix » qui a pour configuration : des fenétres (xygene, des
couleurs Lion Reversed, ie théme d'icénes Icines Slick, Je fond d'écran
Haute teneur en vert ef fe théme de bureau par defaut.

DE BUREAU

KDE4, cest aussi les effets de bureau que I'on configure depuis le
menu Configuration du systéme -> Bureau. Si votre configuration
les supporte, l'installation de KDE a dd les activer par défaut. Si
ceux-ci sont désactivés, activez-les pour les essayer.

Selon votre configuration, que vous ayez ou non l'accélération
graphique activée, ceci peut mal se passer, I'écran pouvant par
exemple devenir complétement noir ! Dans ce cas, ouvrez la
console ttyl & 'aide de la combinaison de touche [AK]+HCirl]+[F1]
et entrez votre identifiant et votre mot de passe utilisateur.
La commande pkill kuin tuera le gestionnaire de fenétres.
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KOEA ol frolieall dout boa ¢ II'suffit alors de retourner Lacoélération est-efle activée 7 0n peut connaitre cote
’ : : sous KDE a l'aide des tou- information & l'aide de la commande §1X1rT0 | drep

ches [Alt]+[F7] pour retrou- “Qirect rendering” quirenverra 165 ou 0. Sicelle-ci

ver les applications ouver- n'y est pas, i faudra effectuer une recherche surla pos-

tes, mais sans barre de titre. sibilite de le faire avec votre carte graphique. Lactivation

seffectuera ensuite selon le modele de celle-ci. Vous

La fenétr nfiguration
Stre Config trouverez certainement l'information sur fnternet.

du systéme, qui a per-
mis d'activer les effets de
bureau, doit toujours étre
ouverte. On peut donc les composite. Réessayez alors d'activer les effets de
désactiver. Pour retrouver bureau. Quelgues-uns devraient fonctionner.

les bordures, on exécute
la commande knin dans un
terminal que I'on ouvre avec

Avec les effets de bureau, on va certainement pen-
ser « animation du mouvement des fenétres », mais
c'est egalement de la transparence et d’'un apergu
facilité des différentes fenétres présentes sur les
bureaux dont il s’agit. Pour rendre son bureau plus
agréable & I'ceil, on pourra activer l'effet Neige pour
Noél ou activer une ombre sous les
fenétres. Si on aime les graphiques,
on a l'effet Affiche I'im/s qui affiche les
performances de KWin (Flg. 7).

e ——————— SR : Lun des plus interessants au niveau du
el e B _ : i rendu de I'apparence des fenétres est

e e : ¥ I'effet de transparence. En plus d'étre
joli, il s'avére trés pratique surtout
combine a l'utilisation d’'un terminal.
La transparence activée, on va pou-
voir activer celle du terminal de KDE,
ce qui permettra de travailler dans une
console tout en consultant par transpa-
rence les applications en dessous. On
pourra donc disposer d’'un terminal et
d’'une autre application en plein écran,
le terminal au-dessus.

le raccourci [Ali]+[F2] et en saisissant Konsole par
exemple. Si la fenétre de configuration est fermée,
on l'ouvre depuis un terminal grace a la commande
systemsettings.

La transparence peut aussi se trouver
entre deux fenétres d'application ou ren-
dre les menus semi-transparents (utile
lorsgqu’un menu est long et nous cache
des informations). Ceci est a configu-
rer dans les effets de bureau (Fig. 8).

Flg. ¥ : On aici active les effets de
bureau : « Esfompe les
inactifs » et « Affiche Iim/s »
présents en haut & droite et
la transparence.

Les effets de bureau
sont par défaut activés
avec OpenGL, mais
iIs peuvent I'étre avec
XRender qui apporte
une solution si vous
ne possédez pas
d'acceleration graphi-
que. XRender s’active
depuis l'onglet Général
de la partie Effets de
bureau en cliquant sur
Advanced Options. On
choisit alors XRender
dans Type d’affichage

FHlg. @ : Configuration de 'effet Transparence
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Ma propre Konsole

Il est intéressant de configurer la console de KDE avec la gestion de
la transparence. Pour cela, on ouvre Konsole, puis on se rend dans le
‘menu Configuration -> Modifier le profil actuel dans 'onglet Apparence,
ot1 plusieurs styles sont proposés. On en choisi un que I'on configure

depuis le bouton Edition. On peut alors choisir de madifier les couleurs

du théme 'et le niveau de transparence qui, trop éleve, rend 'utilisation
du terminal hasardeuse ! La transparence devra étre au prealable acti-
vée dans les effets de bureau. :

B allne r aline
Fekiar  fiiin  pRcher Haueoue Smen Cegeas Al

Fora 3
aragroundeositives0,
regraundvisited=g8,

[Colozs: Toultip] 2
ackegroundilternat w=255, 248, 205
Backgroundforna =255, 246, 205
Foc ;132 65
DacoratisnHovar=T2. 177 60
‘ForesroundiEtiva=255
Farazzoundinactizo

On utilisera par exemple une transparence a 90% pour les fenétres
de dialogue. Une transparence trop élevée génerait la lecture de la
fenétre active.

Pour finir avec les effets de bureau, voici une astuce qui pourra vous
sauver | KDE4 étant encore en développement, il se peut que votre
bureau plante littéralement. Par exemple, lors de vos manipulations

+ calariess wakery BUI of DT ANd PR Contaning g
v i W STVTOCyTes A leakecytes arsd PRATICT are

pended (= (pasmi]
shcent of chisk oy y3sd 25 2

Elg. © : Des plasmoides utiles, dans [‘ordre - folder view, dictionary, harloge
analogique, minimize all, verrouillage/déconnexion. Le fond d'écran est Champs

de paix avec le theme SilicON.

avec les différents effets de bureau, il peut arriver que
le bureau et le tableau de bord disparaissent laissant
les applications « dans le vide » ! Pour résoudre ce
probléme, une solution consiste a se rendre dans
le répertoire .kded/share/config/ et a modifier le fichier
plasmarc en remplagant par exemple le nom du theme
par celui par défaut. On peut également supprimer les
fichiers plasna*, puis tuer Kdm et le redémarrer en lant
que root. La configuration de plasma reviendra a celle
par défaut, mais au moins un bureau est la !

® LES GADGETS :

PLASMOIDES ET -
SUPERKARAMB

Lune des caractéristiques de KDE4, autre que les
effets de bureau, sont les plasmoides. Dans le cété
supérieur droit du bureau, vous trouverez l'icéne de
configuration de Plasma (une sorte de grosse goutte
jaune) et la méme en plus petit dans le tableau de bord
(pour KDE4.1), nous invite & installer des gadgets sur
notre bureau.

Avec une installation compléte de KDE4, l'offre est
déja grande - horloge de toutes sortes, mini-jeu, pha-
ses de la lune, calculatrice, bande dessinee, defilement
de flux RSS... La fagon la plus simple pour ajouter un
plasmoide sur le bureau ou dans le tableau de bord
est d'effectuer un glisser/déposer depuis la fenétre
Ajouter des plasmoides jusqu’a 'emplacement désiré.
Sur le tableau de bord, le gadget une fois posé ne
peut &tre déplacé. Pour ce faire, il faudra le supprimer
et le réinstaller.

[Fig. 90 : Un peu de distraction avec les plasmoides Picture Frame, Horloge

analogique, Fuzzy Clock, Fifteen Puzzle, Comic Strip. Le fond d'écran
estEnfin 1'été en Allemagne avec e theme S1im-glow.
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Fig. 11 : Des plamoides bien ufiles :
Telgscripteur de nouvelles,
Notes, KGet et Calculator. Dans
le tableau de bord, I'heure est
indiguée de quatre maniéres
différentes ! On a ici le fond
d'scran Le Téye de pogte etle
theme.

Et quelques captures pour vous donner
une idée de ce a quoi ¢a ressemble :
voir figuras @, 10, 11 et 12.

Et comme foujours, il est possible
de télécharger des plasmoides pro-
venant du site de KDE. Avec un peu
d'imagination, on pourra également
créer ses propres créations.

Avant l'arrivée des plasmoides, nous

avions Karamba et SuperKaramba.

Ceux-ci existent toujours et rien ne

P e A A nous empéche des les combiner aux

Big. 12 - Demf gadgets SuperKaramba : Transparent SideBar et FC- plasmoides. Parmi les gadgets de

Monitor-Dualcore o

SuperKaramba (Fig. 12), on retrouve

essentiellement l'affichage d'informa-
tions systéme.

17:12=8% |

Voici une liste non exhaustive des plasmoides
disponibles :

=~ Bip, les bureaux miniaturisés :
» Binary Clock, I'heure en binaire ;

~ Comic Strip, un choix de minis bandes dessinées KDM
dont Garfield, Snoopy et UserFriendly ;

2y Cegeuieiciioge R DXmatives La configuration de Kdm passe par le menu

Indicateur de batterie, pratique pour les ordinateurs Configuration du systéme -> Avancé -»

portables ; Gestionnaire de connexion. Si les modifications

> Minimize All, permet de minimiser toutes les fenétres sont impossibles, il faudra prendre les droits

ouvertes root en exécutant la commande suivante dans
un terminal :

~ KGet, pour se tenir informé des téléchargements en
cours ;

Lsud{) fusr/1ib/kded/bin/systensettings &

Télescripteur de nouvelles, pour afficher des flux RSS.
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KDE4 nous propose de base un bureau assez joli, dans
I'air du temps Web 2.0. Pour les personnes qui n‘aiment
pas le noir, celui-ci est déja bien configurable et certai-
nement encore un peu plus dans les versions a venir. De
nombreux thémes sont proposés sur le site www.kde-
look.org qui est un vrai complément a la personnalisa-
| tion du bureau KDE et vous donnera certainement envie
| E de faire vos propres créations. Le site de KDE propose
Lot ] : méme quelques tutoriels pour vous aider dans cette voie.
Flg. 13 . A mon avis, on a ici un bureau bien personnalisable, haut
' en couleur et trés agréable a utiliser au quotidien. ®
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Tutoriels pour faire ses propres thémes KDE : http://
techbase.kde.org/Development/Tutorials/

SuperKaramba : http://netdragon.sourceforge.net/

La configuration de Kdm passe soit par la configuration de chaque élément ssuperkaramba.html

depuis cette fenétre, soit par le choix d’'un theme. 3
Documentation sur Kdm : http:/docs.kde.org/stable/

Pour utiliser un théme, on coche la case Utiliser un théme d’accueil dans en/kdebase-workspace/kdm/
I'onglet Général, puis on se rend dans l'onglet Théme. On trouvera bien
entendu des thémes & télécharger sur le site de KDE, mais également
dans le paquet kde-kim-themes qui installe des themes dans /usr/share/apps/

kdm/themes/.

Linstallation d’un théme déja téléchargé doit s’installer depuis la méme
interface avec le bouton Install new theme. Aussi, si vous rencontrez des
problémes lors de son installation (message d'erreur), il faudra passer par
le fichier kdnrc présent sous KDE4 dans /usr/1ib/kded/etc/kded/kdn/. Il suffit
alors de modifier la ligne Theme= en spécifiant le chemin du theme & utiliser

UN STYLE MAC 0S X
POUR KDE !

Pour retrouver le style Mac OS X sous KDE, on pourra

et controler que la ligne UseTheme=true existe bien. Les thémes fournis avec le
paquet cité plus haut ne sont pas tout a fait fonctionnels avec Kdm de KDE4
et il faudra s’assurer la présence du fichier KdnGreeterThene, desktop contenant
la ligne [KdmGreeterThene] (et non GdméreeterTheme).

Si on ne souhaite pas utiliser de théme, on pourra dans le premier onglet
choisir la police d’écriture & utiliser. Dans I'onglet Dialogue, on modifie le
message de bienvenue et on choisit ce que l'on affiche dans la zone de logo
prédéfinie : une horloge, un logo ou rien. Il est ici regrettable qu'on ne puisse
déplacer la zone de logo pour une personnalisation fotale. On choisit ensuite
dans 'onglet Fond d'écran limage a afficher en fond et I'aspect a lui donner.
Pour utiliser les fonds d'écran de KDE, ceux-ci sont installés dans /usr/share/
wallpapers/. Dans l'onglet Utilisateurs, on va choisir les icones a attribuer a
chacun et les utilisateurs a ne pas afficher sur la page de connexion, ceci, si
on coche Show list, permettant d’afficher une liste d'utilisateurs dans I'écran
de connexion. |l suffit ensuite de valider et de vérifier la nouvelle apparence
de Kdm lors d'une nouvelle connexion. Cette interface est assez compléte
et pourra servir de support & une configuration personnalisee.

Pour créer votre propre théme, le plus simple est, dans un premier temps,
de copier un autre théme et d'en modifier les images. Pour modifier les
emplacements des différents éléments de la page, il faudra éditer le fichier
xml. Le fichier kdnGraeterTheme.desktop contient, quant & lui, des informations
générales sur le théme comme lauteur du theéme ou encore le fichier xml a
utiliser. Pour plus de détails sur toute les variables et le fichier kdnrc, on se
référera a la documentation de Kdm.

Juste aprés la connexion & la session, le chargement de celle-ci est carac-
térisé par un splash screen que nous avons déja vu avec le menu Ecran de
démarrage. Celui-ci est appelé « Ksplash » et on frouvera les themes par
défaut dans le répertoire /usr/1ib/kded/share/kded/apps/ksplash/Themes/. Pour un
rendu plus joli, on utilisera des themes semblables pour Kdm et pour Ksplash.

installer le paguet twin-bachira gui contient deux themes
de couleur (Aquablue et AguaGraphite), un style de fenétre
(Baghira), un théme d'icdne (crysialsvg) et un nouveau
menu. Le paquet contient également Fapplication bzl
qui permet de disposer a portée de main d'un menu
de configuration permettant de choisir entre les styles
Jaguar, Panther, Brushed, Tiger et Milk. Pour disposer
du menu de lancement d'applications, il faudra ajouter
lapplet Baghira Starter au tebleau de bord. Pour vous
croire sous Mac, ce paguet est parfait, mais il est, pour
le moment, seulement compatible avec KDE 3.x. B

4 Site : http:libaghira.sourceforge.net
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WINDOW MAKER,

UN GESTIONNAIRE DE
FENETRES LEGER ET EPURE

par Fledr Bross

Window Maker, peu avenant au premier abord, est la

solution idéale des ordinateurs disposant de peu de
ressources et des utilisateurs qui privilégient efficacité et rapidité dans leur

choix d’un en\;ironnement de bureau.

® HISTORIQUE ET

INSTALLATION

Window Maker fut originalement écrit par Alfredo
Kojima, un programmeur brésilien, pour I'environne-
ment de bureau GNUstep. |l était au départ censé

: étre une version ame-
lioree du gestionnaire
de fenétres AfterStep.
Certaines distributions
Linux integrent Window
Maker par défaut. Dans ce
cas, il ne vous reste qu'a
choisir ce gestionnaire lors-
que vous ouvrez une ses-
sion utilisateur. Les utilisa-
teurs de Debian et Ubuntu
(et dérivées) devront,
quant a eux, installer le
paquet wmaker au préalable.
Puis, face a leur écran de
connexion,
ils devront
cliquer sur
le bouton
Options et,

parmi les
options,
sélection-
ner Window
Maker comme
gestionnaire
de fenétres

avant d'ouvrir

leur session.

Fly. 2 - Les préférences des bureaux Wind 9 W
permettent de gérer aisément les différents Maker dis-
espaces de travail, mais aussi de désactiver le pose d'un
dock si vous le souhaitez. certain nom-

: 3 bre d'ap-
plications a utiliser comme des docks (Fig. 1),
c'est-a-dire des icbnes qui s’accrochent au céte
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de l'ecran et qui permettent de lancer rapidement
une application. Leur nom commence en géné-
ral par « wm ». Vous pouvez effectuer aisément
une recherche dans votre gestionnaire de paquets
ou bien vous rendre sur le site http://fwww.
dockapps.org/ pour faire votre choix parmi les docks
disponibles. Ces applications dites « dockables »
(aussi appelées dockapps) sont souvent des horlo-
ges ou des applications de monitoring du systéme.

PREMIERE
UTILISATION.

tres, vous serez peut-&tre surpris par la sobriété de
laffichage : pas de barre de menus ici comme sous
Gnome ou KDE. Juste quelques boutons... Le trom-
bone, en haut & gauche, vous permettra de lancer rapi-
dement des applications a partir d'une barre d’icénes ;
les boutons sur la droite sont des « dockapps », qui
permettent de lancer rapidement une application ou
affichent quelques informations sur le systéme.

Par defaut, le dock de Window Maker comporte une
icne pour lancer un terminal de commandes (xterm)
et une icone pour définir les préférences (wprefs). Il
est conseillé de faire un tour parmi ces derniéres et
de naviguer parmi toutes les options proposées, de




BUREAU

maniére a se familiariser un peu avec votre nouveau gestionnaire
de fenétres. Laccés au menu principal, et donc aux applications
installées sur votre systéme, s'effectue via un clic droit sur I'écran.

L’un des atouts de Window Maker réside dans le fait que tous les
fichiers le concernant sont réunis dans un seul et méme répertoire, le
répertoire ~/lilStep. De ce fait, votre configuration peut-€tre aisément
« transposée » d’'un poste de travail a l'autre.

® PARAMETRER WINDOW
MAKER

Les préférences du gestionnaire concernent I'activation des fené-
tres, la gestion des fenétres (placement, comportement lors de
Iagrandissement), I'utilisation des menus (alignement, vitesse de
défilement), la manipulation des icones. Lactivation de l'option Aide
contextuelle peut vous étre utile pendant les premiers temps.

La section Préférences pour les bureaux (Fig. 2) est importante, car
c'est la que vous pourrez éventuellement désactiver le trombone
et/ou le dock et paramétrer la navigation entre bureaux. Il est recom-
mandé de cocher les oplions Switch workspaces while dragging
windows (ce qui signifie que vous n'aurez qu’a faire glisser la fenétre
avec la souris pour la positionner vers un autre espace de travail) et
Automatically create new workspaces, grace a laquelle vous pour-
rez ajouter simplement de nouveaux bureaux en cliquant sur les
petites fléches qui se trouvent de part et d'autre du trombone.

Notez que pour certaines modifications dans les préférences (acti-
vation d'effet, redimensionnement des icénes, etc.), il vous faudra
relancer Window Maker pour observer les changements. Pour cela,
effectuez un clic droit sur le bureau, puis choisissez Session ->
Restart Window Maker.

Dans la section Autres configurations, vous pourrez notamment acti-
ver les animations (qui incluent les quelques effets lors de l'iconification
des applications) et les effets superflus (explosion des icones retirees
du dock et matérialisation spectrale du dock lorsquon le déplace).

Un autre élément incontournable des préférences : la configuration
des raccourcis clavier. Une liste d'actions vous est proposee ; pour
associer une action au raccourci de votre choix, sélectionnez-la
dans la liste, puis cliquez sur Capturer et saisissez votre raccourci ;
celui-ci apparait alors dans la zone de saisie. Attention, veillez & ce
que la touche [NumLock] de votre clavier ne soit pas activée, sinon,
elle sera prise en compte dans votre raccourci !

DE SON GESTIONNAIRE
DE FENETRES

Rien de compliqué ici. Vous disposez d'une entrée Appearance
dans le menu principal, qui vous propose par défaut divers themes,
styles, jeux d’'icones et arrigre-plans. Pour ajouter un nouvel arriére-
plan a la liste, enregistrez celui de votre choix dans le répertoire
~/GiUstap/Library/HindowMaker/Backgrounds. lls apparaitront alors dans le
menu Appearance -> Background -> Images.

Vous pouvez également changer le fond d’écran en utilisant la com-
mande suivante : wnsetbg -5 -u [image.;pgl.

Loption -5 (pour scale) met a I'échelle I'image spécifiée (compor-
tement par défaut) ; l'option -u (pour update) met a jour la base de
données des préférences par défaut de Window Maker.

Notez que le
site http://
themes.
freshmeat.
net/browse/
918/?topic_
id=918
regorge de
thémes en
tout genre
pour Window
Maker. Pour
en installer
un, c’est trés simple : récupérez l'archive .tar.gz, décompressez-la,
puis copiez le répertoire obtenu dans ~/GliUstep/Library/¥indowMaker/Themes.
Ceci fait, vous pourrez appliquer ce nouveau théme via le menu prin-
cipal, Appearance -> Themes.

SUR LES FENETRES

Un double clic sur la barre de titre d'une fenétre permet de réduire
son affichage a cette simple barre.

Un clic sur l'icéne qui se trouve tout & gauche de la barre de titre, en
forme de carré, permet de minimiser la fenétre ; vous obtenez alors
une icone sur le bureau, sur laquelle il suffit de double-cliquer pour
faire réapparaitre la fenétre. Quelques effets sont disponibles pour la
minimisation : zoom, tournoiement, rotation 3D (& définir dans les pré-
férences de WM, section Préférences des icénes ). Pour visualiser ces
effets, il faudra veiller a ce que l'option Animations soit activée dans
la section Autres configurations des préférences de Window Maker.

Un clic droit sur la barre de titre affiche le menu contextuel, via lequel
vous pourrez miniaturiser la fenétre, l'enrouler (ne faire apparaitre que
la barre de titre), la masquer, la redimensionner, etc. Notez en particu-
lier 'option Attributs, qui affiche une boite de dialogue vous permettant
de sélectionner divers attributs pour la fenétre, mais aussi de modifier
l'icéne la représentant ou encore de lui attribuer un bureau initial.

® AJOUTER UNE DOCKAPP

DANS LE DOCK

Pour ajouter une dockapp dans le dock, voici la marche a sui-
vre : lancez la dockapp en ligne de commande dans un terminal
(wmclockmon, umweather+, etc.). Elle apparait alors sous farme d’une icdne
sur le bureau (mais pas dans le dock). Effectuez un glisser/deposer de
cette icone dans le dock. Ceci fait, tuez I'application dans le terminal
(via [Ctrl]+[C]). Licone est toujours présente dans le dock, mais la
dockapp a disparu. Effectuez un clic droit sur l'icone, puis choisissez
Parametres (Flg. 4). La ligne de commande pour lancer I'application
est déja saisie. Il ne vous reste plus qu'a activer l'option Lancer au
démarrage de Window Marker, et, éventuellement, l'option Verrouiller.
Redémarrer Window Maker : votre dockapp est maintenant bel et bien
présente dans le dock !

Il est trés difficile de se sentir & I'aise avec Window Maker lorsque
I'on est habitué a des environnements plus « intuitifs ». Seules une
pratique assidue et un peu de persévérance vous permettront de
« dompter » ce gestionnaire de fenétres. Ceci fait, le « pilotage » au
clavier est trés agréable (c’est un gain de rapidité certain) et l'on appré-
cie sa grande configurabilité. B




PERSONNALISEZ ET AMELIOREZ
LE LOOK DE VOTRE BUREAU !

DOSSIER

Site du projet : http:/l
modeemi.cs.tut.
fil~tuomovfion/

Tutoriel en francais :
http:f/dev.nozav.
orgl/intro_ion.html
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UN GESTIONNAIRE DE
FENETRES MINIMALISTE

par Aline Gerard

Des icOnes qui remplissent votre bureau, des effets 3D a tout va,
de gadget en gadget, votre bureau ne ressemble plus a grand-chose
hormis a un amas de choses plus ou moins inutiles. Et si 'heure était
venue de changer tout ca, de s’aérer au profit d’un bureau minimaliste
ou fout ou presque est a la portée de raccourcis clavier ? Et pourquoi de
par sa simplicité d’aspect celui-ci serait-il moins beau qu’un autre ?

Big. 1 : lon3, un gestionnaire de
fenétres sobre.

® LE CONCEPT

lon est un gestionnaire de fenétres qui s'utilise
essentiellement a I'aide de raccourcis clavier per-
mettant une rapidité d’'acces aux différentes fenétres
ouvertes. Le bureau de lon se divise en cadres col-
Iés les uns aux autres, dans lesquels s'ouvriront les
fenétres, ce qui permet un gain de place important,
mais aussi de pouvoir avoir sous les yeux plusieurs
applications, rien ne se chevauchant. Pour des cas
particuliers, on pourra tout de méme « décrocher »
les cadres pour une utilisation plus traditionnelle
dans un cadre dit « flottant ».

Nous n‘allons pas détailler ['utilisation générale de ce
gestionnaire de fenétres, mais allons nous concentrer
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Fig. 2 : Des dockapps
dans le dock de
lon3
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sur la personnalisation de celui-ci. En effet, bien que
minimaliste, il n’en reste pas moins configurable.
Nous verrons donc au fur et 8 mesure guelle com-
binaison de touches utiliser et comment s'organisent
les cadres cités préecédemment.

La personnalisation du bureau concerne le style des
bordures des cadres, la personnalisation de la barre
de taches, I'ajout d’'un fond d'écran et l'utilisation de
gadgets (eh oui, ici aussi !). Avant de commencer,
on jettera un ceil au manuel de lon disponible depuis
la touche [F1] ou [Alt]+[F1]. Pratiguement toutes les
touches [Fn] ouvrent une invite qui s'ouvre au bas du
cadre actif. Dans le manuel, on parle de la touche
[Mod1] qui correspond le plus souvent a [Ali], mais
celle-ci pourra étre remplacée par [Super] (touche
« Windows ») par exemple. Précisons également
que nous travaillons avec lon3 version 20080207 ;
quelques menus pourront étre différents selon la
version que vous avez installée.
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lon possede par défaut quelques thémes permettant de modifier
l'aspect des cadres, mais on installera le paquet 1on3-scripts afin d'en
posséder un peu plus. On accédera aux différents styles a l'aide de
la touche [F12] qui donne accés a un menu dans lequel on navigue a
l'aide de la touche [Tab] ou en saisissant notre recherche, dans ce cas
styles/look_nomdustyle. On sélectionne alors un style et on confirme
avec [Entrée]. On nous demande alors de sauvegarder ou non le
théme pour la prochaine session, & quoi il faut répondre par j ou .

Les styles sont installés dans /etc/f11/ion3/ (si ce n'est pas le cas,
on effectuera une recherche & l'aide de la commande Tocate Took_)
sous le nom de look nomdustyle.lua. On a ici du code Lua, mais sa
connaissance n'est pas nécessaire. On comprendra aisément les
noms shadow_color et background_color auxquels on applique des codes
couleurs  rien de bien compliqué ! La configuration se porte essen-
tiellement sur les couleurs, les polices d’écriture, le positionnement
de lintitulé d'une fenétre et le style des bordures. On se reférera a
la documentation pour en connaitre les détails.

® CONFIGURATION
DE LA STATUSBAR

La barre de taches de lon (statusbar) permet d’afficher en per-
manence diverses informations en mode texte. Pour y ajouter
des informations, on va, dans un premier temps, copier le fichier
Jetc/X11/on3/cfa_ion. lua dans ~/.ion3 (si celui-ci n'existe pas deja) et s'as-
surer que la ligne dopath("mod_statusbar”) est décommentée (le langage
Lua commente une ligne a l'aide des caractéres --). Dans un deuxieme
temps, on copie le fichier /etc/{11/ion3/cfg_statusbar.lua dans ~/.ion3. La
ligne décommentée précédemment spécifie d'utiliser le module sta-
tusbar d'ot 'utilisation de ce fichier. Dans ce fichier, se trouve une
ligne commencant par template=[. C’est cette ligne qui fait office de
barre de taches. On pourra y afficher des informations provenant de
scripts Lua installés avec le paquet fon3-scripts dans /usr/share/ion3.
Les scripts destinés a la barre de taches portent un nom du type
statusd_script.lua. On les inclut dans la barre avec #script.

Voici un exemple d'utilisation ol 'on ajoute, en plus de la configu-
ration initiale, une horloge binaire (script statusd_binclock.lua) et une
fortune (script statusd_fortune.lua) :

[ template="[ %date || Toad: ¥load || %binclock ]| &fortune ] %fillerfsystray”,

Dans ce fichier, on pourra choisir la position de la statusbar & l'aide
de la variable pos. Par défaut, celle-ci est a bl pour bottom left. Pour
la positionner en haut de I'écran, on utilisera 1} ou tr.

On appliquera les changements a l'aide de [F12] -> sessions/
redémarrer. Cela permet de recharger la configuration en ne fermant
aucune fenétre.

0 UN FOND D’ ECRAN

Un fond d'écran, est-ce possible avec lon pour rernp!acer le fond
noir par défaut ? Oui, & l'aide d’'une commande telle que Esetroot qui
affichera une image de fond dans les bureaux flottants (on détache

une fenétre a l'aide des touches [Alt]+[K] [D] et on ferme un cadre
avec [Alt]+[C]), dans un terminal et un cadre transparent (Des styles
comme look_atme et look_awesome ont des cadres transparents. Pour
cela, on met transparent_background a yes dans le fichier de style).

Pour I'appliquer au démarrage, on place la commande
Esetroot wallpapers.jpg & dans un fichier ~/.xsession qui devrait étre pris en
compte lors du démarrage de la session. Si ce n'est le cas, avec Gdm
ou Kdm par exemple, il faudra au démarrage de Gdm choisir dans la
liste des sessions Lancer le script Xclient et, avec Kdm, on choisira la
session Default. On ajoute alors en derniére ligne du fichier ~/.xsession,
la commande exec iond pour démarrer le gestionnaire de fenétres.

® UTILISATION
DE DOCKAPPS
ET DE GADGETS

lon permet I utllisatton des dockapps du gestlonnalre de fenétres
Window Maker en activant lutilisation du dock, qui sera alors disponi-
ble a I'aide des touches [Al{]+[D]. Pour cela, on procede comme pour
la statusbar en décommentant la ligne dopath("mod_dock") du fichier
cfg_fon.lua. Les dockapps qui seront alors executés s'ouvriront dans
le dock. On peut les lancer au demarrage de lon en les insérant dans
le fichier ~/.xsession avant la commande exec iond.

Sans activer le dock, on peut également réserver l'affichage d'une
application dans un cadre particulier. Par exemple, nous voulons affi-
cher xeyes dans un coin de I'écran. Pour que celui-ci ne s'affiche pas
dans tout I'écran, on splite les cadres a l'aide des commandes [Alt]+[S]
pour séparer un cadre horizontalement et [Alt]+[K] [S] de fagon ver-
ticale. Dans le cadre désiré, on exécute seyes a l'aide de la touche
[F3] qui permet de lancer une application. On sauvegarde ensuite
la configuration des fenétres via [F12] -> sessions/sauvegarder.

Lors du redémarrage de lon, les cadres s'afficheront tels qu'on les a
sauvegardés. Afin que xeyes s'ouvre toujours dans le méme cadre,
nous allons éditer le fichier cfg_ion.lua. Pour cela, on doit connaitre
le nom de la classe et de l'instance de la fenétre. Pour ce faire, on
utilise [Alt]+[M] (ouvre directement la fenétre d'information ou une
invite Henu Contextuel ; dans ce cas, on choisit a 'aide des tabulations
informations-fenétre). On pourra également exécuter la commande
xprop HM_CLASS dans un terminal. Celle-ci vous invite & sélectionner un
cadre afin de vous renseigner sur ses informations.

Il nous mangue maintenant le nom du cadre que I'on pourra renom-
mer en exécutant mod_guery.query_renameframe(_) dans l'invite [Alt]+[F3]
qui permet d'exécuter du code Lua. Ceci vous indigue son nom actuel
que I'on remplace par un nom plus générique. On peut alors ajouter
les lignes suivantes au fichier cfg_ion.lua ot target est le nom que l'on
vient d'attribuer au cadre :

defwinprop {
class = "XEyes",
instance = "xeyes’,
target = "yeux",

On placera ensuite la commande xeyes & dans notre .xsession,

lon est maintenant personnalisé selon vos envies. N'hésitez pas a
consulter la documentation disponible pour modifier des fichiers de
style ou méme les scripts pour la statusbar. B
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Le projet Compiz : http://
compiz.org/

Le projet Compiz Fusion :

http:/iwww.compiz-
fusion.org — Derniére
version 0.7.6 {(mai 2008)

DES EFFETS VISUELS

ETONNANTS GRAGCE A
COMPIZ FUSION

-~ par Fleur Brosseau

Compiz est un gestionnaire de fenétres compaosite qui utilise
I'accélération 3D a travers OpenGL. De ce fait, votre environnement
de bureau peut bénéficier d’effets graphiques trés « eye candy » et
de nouvelles fonctionnalités. Compiz est compatible avec n'importe
quel environnement de bureau base sur X Window System, comme

Gnome ou KDE.
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COMPIZ, COMPIZ
FUSION, QUELLE

Ce sont deux projets bien distincts, I'un comme
l'autre toujours en développement. Compiz est un
gestionnaire de fenétres composite. |l intégre un cer-
tain nombre de plugins de base, qui lui permettent
de fournir a l'utilisateur des fonctionnalités et des
effets spéciaux « classiques » (comms le c&lébre
cube 3D et les fenétres molles). Mais, les possibili-
tés de Compiz peuvent étre largement étendues ; il
est dailleurs considéré en quelque sorte comme le
« noyau » de Compiz Fusion.

En effet, Compiz Fusion est un projet dont le but
est d’ajouter plus de fonctionnalités & Compiz,
au travers de plugins, d'outils et de bibliothéques
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supplémentaires. Il estle
résultat d’'un croisement
entre les projets Beryl
(un fork de Compiz) et
Compiz Extras (un lotde
plugins « extra » congu
pour le projet Compiz ini-
tial). Outre de nombreux
plugins, I'un des ajouts
dont bénéficie Compiz
grace a Compiz Fusion
est l'utilitaire graphique
CompizConfig Settings
Manager (voir plus bas),
qui permet de configurer
aisément tous les effets et les fonctionnalités de
votre bureau.

MATERIELLE

En fonction du modéle de votre carte graphique
(ATI, Intel ou NVIDIA), la procédure a suivre pour
la préparer a un bureau composite 3D différe. La
page http://wiki.compiz-fusion.org/Hardware
vous donnera toutes les indications nécessaires en
fonction de la carte utilisée. Si vous rencontrez des
difficultés a faire fonctionner Compiz, il vous faudra
certainement éditer le fichier de configuration de
votre serveur graphique, le fichier /etc/X11/xorg.cant.
Il est conseillé dans ce cas de toujours faire une
copie du fichier original avant d’effectuer la moin-
dre modification. De cetie maniére, vous pourrez
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revenir a quelque chose qui fonctionne si vos différents tests ne
ménent a rien !

Dans tous les cas, votre carte graphique utilisera XGL ou AIGLX,
qui permettent tous deux I'interaction entre le serveur X et
OpenGL. XGL est un serveur X libre surcouche de 'OpenGL, per-
mettant d'utiliser les capacités 3D des cartes graphiques ; AIGLX
(Accelerated Indirect GL X) est un projet open source issu de la
fondation X.Org et de la communauté Fedora Core, dont le but est
d'améliorer le rendu graphique en utilisant 'accélération matérielle
des cartes graphiques. AIGLX a été fusionné avec le projet X.Org
et fait partie de la version 7.1, ce qui permet aux distributions
intégrant cette version (ou une version supérieure) de lutiliser.

® [NSTALLER ET

ACTIVER COMPIZ

Les paquets requis et recommandés sont les suivants : conpiz,
compiz-core (les paquets de base de Compiz), compiz-gnome (un deco-
rateur de fenétre pour Gnome), compiz-kde (un décorateur de fenétre
pour KDE), compiz-plugins, compiz-fusion-plugins-main et compiz-fusion-
plugins-extra (des collections de plugins qui vous permettent de
bénéficier de divers effets spéciaux).

Pour activer les effets visuels sous Gnome, rendez-vous dans le
menu Systéme -> Préférences -> Apparence, puis dans l'onglet Effets
visuels, sélectionnez le mode Normal ou Exira selon les capacites
de votre carte graphique. Lorsque vous sélectionnez l'une de ces
options, une petite fenétre de dialogue apparait a l'écran pour vous
demander si vous souhaitez réellement activer ces parametres
d'affichage ou si vous préférez conserver les anciens paramétres.

Pour activer les effets visuels sous KDE, installez tout d'abord le
paquet desktop-effects-kde. Il s’agit d'une interface graphique qui
vous permet de sélectionner le niveau des effets : aucun, stan-
dards, supplémentaires ou personnalisés.

® CONFIGURER LES

'EFFETS SPECIAUX

La configuration des effets visuels dus & Compiz peut s'effectuer
trés simplement via un gestionnaire graphique. Pour cela, il existe
deux solutions :

Compizconfig Settings Manager : le paquet a

installer se nomme compizconfig-settings-manager-
Simple Compizconfig Settings Manager : le &

paquet a installer se nomme sinple-ccsn. Son ins-

BoLes plus visités ™ o Classeur t .4

@ COMPIZCONFIG SETTINGS MANAGER (CCSM)

CCSM est une interface graphique via laguelle vous pourrez activer/
désactiver et configurer chacun des effets spéciaux et chacune des
fonctionnalités disponibles trés facilement (Fig. 1). La liste de ces der-
niers est fonction des plugins que vous avez installés, bien entendu.
Pour activer un plugin, il suffit de cocher la case correspondante (et
pour le désactiver, de décocher la case). Puis, pour le parametrer selon
vos préférences, il faut cliquer dessus de mani¢re a afficher linter-
face de configuration, dont les options sont propres a chaque plugin.

La plupart du temps, outre des paramétres spécifiques, vous pour-
rez configurer les raccourcis clavier (et boutons de souris) a action-
ner pour activer et désactiver le plugin. Vous pourrez revenir & tout
moment a la configuration initiale du plugin en cliquant sur licéne
en forme de balai-brosse.

Remarquez que certains plugins dépendent les uns des autres, mais
ceci vous sera notifié lors de I'activation d'un plugin et, le cas échéant,
le logiciel vous proposera d'activer le plugin dépendant simultanement.

A noter que I'activation et la désactivation des plugins s'effectue a la
volée. Il n'est pas nécessaire de vous déconnecter de votre session
pour que les changements prennent effet.

Vous disposerez également d’un champ de recherche vous per-
mettant d’effectuer une recherche par mot-clé parmi les plugins. La
recherche avancée vous permet, quant 2 elle, de naviguer parmi tou-
tes les options de l'ensemble des plugins. Les plugins sont répartis
en 8 catégories, détaillées ci-aprés.

C Général

Cette catégorie contient lensemble des options du « noyau » de
Compiz, les options de base. Dans 'onglet Commands, vous pourrez
par exemple définir un raccourci clavier pour l'ouverture d’un terminal
ou pour la capture d'écran ; d’autres raccourcis peuvent étre définis
pour les actions sur les fenétres dans 'onglet Key bindings et pour le
réglage de l'opacité des fenétres dans Opacity Settings (Flig. 2).

@ Accessihilité

Vous trouverez dans cette catégorie des plugins permettant d'ame-
liorer l'accessibilité de votre bureau. Certains de ces plugins s'avée-
rent particuliérement utiles si vous étes atteint d’'une quelconque
déficience visuelle. Loption Grossisseur par exemple (qui active
I'option Scrutation de la position de la souris) permet d'avoir une
loupe & portée de main (Fig. 3). Tapez [Super]+[M] et un rectangle
grossissant apparait & I'écran : vous n'avez qu'a le déplacer ol bon
vous semble avec la souris pour lire plus aisément un texte écrit trop
petit. Pour désactiver la loupe, [Super]+[M] & nouveau.

L'Aide a la concentration,
activé via [Super]+[P] per-
met de renforcer le contraste
entre la fenétre active et les
autres fenétres ouvertes :
ces derniéres sont rendues
plus opaques de maniére a

wong  Raceourcis

tallation crée une nouvelle option dans 'onglet
Effets visuels du gestionnaire d’apparence de
Gnome, l'option Personnalisé, via laquelle vous

'.;‘rpewmmdnsmme] sty s ailins = (@ 'A- ol

Goggle »

ce que vous vous focalisiez

t performs an action ev| uniquement sur le fenétre

ety _ active. Loption Négatif per-
3 met, quant a elle, de passer
toutes les fenétres en colo-
risation négatif, ce qui ren-
force le contraste entre les
différents éléments.

pourrez accéder directement a Simple CCSM.

Profect ams | DowndMIKA Issues

beep, or {like mek o ‘~

xballd i a tiny weility to & p
=l driver. as of 200880

e support for the PC spad

Ces deux gestionnaires graphiques peuvent s'uti-
liser sous Gnome (menu Systéme -> Préférences),
comme sous KDE (menu Applications ->
Configuration sous KDE4).

<ba3d performs 2 gen actiophier_don't like the defa i
| |program, emulating the PC speaker UsAng your sound ¢ aFault], or playing & PCM enco
|t sound card 72 only avail. able fxbelld is compilad i s support. To convert your favour

= Fig. 3
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mplayer o null ve null -3a pemdfastfila=cut wav audio_fils
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Des effets visuels étonnants gréace

a Compiz Fusion

Bureau

Cette catégorie contient des
plugins qui permettent de
configurer le comportement
de votre bureau, comme
le célébre cube 3D ou l'af-
fichage plan de tous vos
espaces de travail.

Le plugin Afficher le bureau
permet d’obtenir un petit
effet visuel sympathique
lorsque plusieurs appli-
cations sont ouvertes et
que vous cliquez sur le raccourci vers votre bureau
dans la barre des taches. Les fenétres disparais-
sent toutes simultanément et viennent se loger, au
choix, dans les coins de I'écran, sur les cétés, etc.
Vous pouvez regler la vitesse du mouvement, la sur-
face des fenétres qui restera visible, l'opacité, etc.

Les plugins Desktop Cube et Rotate Cube dépendent
I'un de l'autre. Le premier permet de visualiser ses
différents espaces de travail sous la forme d’'un cube
« deplie », via le raccourci [Ctrl]+[Alt]+[Fléche bas]
(raccourci par defaut). Le second permet de metire
le cube en rotation, via les touches [Cirl]+[Al{]+[bouton
gauche de la souris]. Ce cube est transparent (le
pourcentage dopacité est a définir), vous pourrez en
choisir la couleur et également définir la couleur de
l'arriere-plan ou encore utiliser I'image de votre choix
pour illustrer la face supérieure du cube (Fig. 4). De
plus, ce plugin combiné au plugin Fenéires 3D de la
catégorie Effets, permet d'obtenir un effet de relief
sur toutes les fenétres ouvertes (Fig. §). Et avec le

52 Linux Pratique Essentiel #3

plugin Reéflexion du cube (toujours dans la catégo-
rie Effets), c'est encore plus joli (Fig. &) ! D’accord,
concretement ¢a ne sert pas a grand-chose, mais
vous ferez des jaloux dans votre entourage ;-)

La Couche Widget a déja été évoquée dans l'article
« Gerer ses widgets sous Gnome » (voir page 56).
Ce plugin permet d'afficher l'ensemble de vos wid-
gets sur une couche séparee, ce qui permet de les
visualiser uniquement lorsque c'est nécessaire.

Le plugin Exposé permet de visualiser tous ses
espaces de travail via un simple raccourci (par
défaut [Super]+[E]) (Flg. 7).

& Effets

C’est 12 que se nichent tous les plugins procurant
des effets spéciaux, pas forcément utiles, mais
eétonnants | Loption Animations est activée par
défaut. Elle englobe tous les effets liés aux actions

sur les fenétres (ouverture/fermeture, minimisation/
maximisation, focus, etc.). Vous pouvez sélection-
ner autant d'effets que vous le souhaitez et il y a
le choix ! Pliage de la fenétre en forme d'avion de
papier, explosion, fondu, effet dominos, rayonne-
ment, fenétre en flammes, etc.

Attention, les cases a cocher ne prennent effet que
si vous avez selectionné l'option Animation aléatoire
pour tous les événements dans l'onglet Configuration
de I'effet. Dans ce cas, un effet au hasard parmi
ceux que vous avez cochés sera appliqué.
Sinon, c'est voire Sélection d’animation qui est prise
en compte et c'est la premiére animation de la liste
qui est appliquée par defaut.

Loption Wobbly Windows est I'un des effets les plus
célébres si I'on peut dire : elle permet d’avoir des
fenétres « molles » qui ondulent lors d'un déplace-
ment rapide et rebondissent quand on les maximise.

Le plugin Water effects provoque un joli effet d'on-
dulation ou gouttes de pluie, mais ne fonctionne pas
avec toutes les cartes graphiques. Pour ce plugin, de
méme que pour les plugins Blur et Réflexion, voire
carte doit supporter I'extension GL_ARB_frag-
ment_program, qui est incluse notamment dans
les cartes ATl Radeon 9500 & 9800, les cartes Intel
915G et NVIDIA GeForce 6600 a 6800, FX5200
a FX5950. Vous pourrez trouver la liste compléte
des cartes compatibles sur la page : http://lwww.
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delphi3d.net/hardware/extsupport.php?extension=GL_ARB_
fragment_program.

Window Decoration permet I'affichage des barres de titre des
fenétres. Loption Peindre du feu sur I’écran, soyons honnéte, ne
sert strictement a rien, mais c’est épatant : activez-la a l'aide du
raccourci [Shift]+[Super]+ clic gauche et écrivez n'importe quoi sur
votre écran a I'aide de votre souris ! Comme tout plugin, plusieurs
parameétres peuvent &tre réglés ici, comme la taille, la couleur et
la longévité des flammes ou encore la luminosité du fond(Fig. 8).

Ck Extra

Cette catégorie contient un ensemble de plugins qui procurent
de nouveaux outils & votre bureau. Le plugin Annotate par exem-
ple permet de prendre quelques notes directement sur I'écran
(pour l'activer, [Alt]+[Super]+clic gauche ; pour effacer I'écran,
[Alt]+[Super]+[K]). Le tracé s'effectue & l'aide de la souris, ce qui
s'avere peu pratique... Mais I'annotation demeure toujours au pre-
mier plan, ce qui peut permettre par exemple de laisser un mot
a quelquun (& la maniére du miroir et du rouge a lévres dans la
salle de bains...).

Le benchmark permet de lancer un benchmark de Compiz Fusion
(en frames/seconde). Pour l'activer et le désactiver : [Super]+[F1 2].

La prévisualisation des fenétres permet d'obtenir une miniature
de la fenétre au passage de la souris dans la barre des taches ;
les paramétres & configurer concernent principalement I'appa-
rence des miniatures. Le plugin Ecran d’accueil propose l'affi-
chage d'une image (par défaut, le logo de Compiz Fusion) au
démarrage du systéme.

@ Chargement d’image

C’est la que vous pouvez définir les formats d'images qui peuvent
atre chargés et utilisés en tant que texture par Compiz pour le
rendu : JPEG, PNG, SVG et Texte. Par défaut, tous sont activés.
Vous pourrez fixer la qualité de compression pour le format JPEG.

& Utilitaires

Vous pourrez activer ici quelques fonctionnalites supplémentaires,
comme la gestion des sessions, la gestion des crashs, la possibi-
lité d’ajouter des images sur le dessus et le dessous du cube 3D,
I'affichage des dimensions d'une fenétre lors d’'un redimension-
nement, I'activation de la notification d'erreur, etc.

@ Gestion des fenétres

Cette catégorie renferme tous les plugins permettant de gérer
I'affichage et le comportement des fenétres. Loption Sélecteur

en Cascade est particuliérement intéressant :
il vous permet de naviguer d’'une fenétre a
l'autre en les faisant défiler tour a tour a l'écran.

Parmi les paramétres de cette option, vous
pourrez activer ou non l'affichage du titre de
la fenétre, appliguer le style et le position-
nement de votre choix au texte, choisir un
mode de sélection, régler la luminosité de
l'arriére-plan, I'angle des fenétres, configu-
rer les raccourcis clavier ou régler la vilesse
de fondu. Par défaut : [Ctrl]+[super]+[S]
pour activer le sélecteur en cascade, puis
™ [Ctri]+[Super]+[Tab] pour passer d'une fené-

tre a l'autre. Le Sélecteur en Anneau est trés
similaire. Raccourci : [Super]+[Tab] pour passer d'une fenétre a l'autre.

@ SIMPLE COMPIZCONFIG SETTINGS
MANAGER (SIMPLE CCSM)

Simple CCSM est un autre utilitaire graphique, simplifié, vous permet-
tant de piloter les effets procurés par Compiz (Fig. 8). Tout d'abord,
remarquez que Simple CGSM fonctionne par profil, qui differe selon
la quantité d’effets mis en jeu. Longlet Info vous dresse d'ailleurs une
sorte d'état des lieux de votre bureau, en termes d'effets et d'animations.

L'onglet Animations vous permet de définir un effet (parmi une ving-
taine proposés) pour l'ouverture, la fermeture et la minimisation d'une
fenétre. Dans l'onglet Effects, vous pourrez sélectionner 'un des swit-
chers de bureau proposés (en anneau, en cascade, etc.) et activer
certaines fonctionnalités supplémentaires comme le redimensionne-
ment, 'effet de flou et les fenétres molles. Longlet Desktop permet
de définir le nombre d'espaces de travail et éventuellement d'activer
ici le cube 3D (Desktop Cube). Longlet Accessibility contient sans
surprise des fonctionnalités permettant d'améliorer l'accessibilité de
votre bureau (fonctions de zoom notamment).

L'onglet Edges est particuliérement intéressant, car il permet d'as-
socier a chaque coin et zone de votre écran une action particuliere,
qui sera de ce fait déclenchée par un simple mouvement de la sou-
ris vers cette zone. Pour ce faire, cliquez sur 'une des zones du
schéma proposé, puis sélectionnez l'une des actions proposées dans
le menu déroulant. Par exemple, on peut décider de visualiser les
différentes fenétres via I'effet cascade en dirigeant la souris vers le
coin supérieur droit du bureau (Fig. 10).

Simple CCSM permet de configurer moins d'effets que son homolo-
gue présenté précédemment, mais il est tout & fait intéressant pour
qui souhaite aller a I'essentiel ; vraiment simple a utiliser, il cible
surtout les fonctionnalités qui permettent de gagner en ergonomie,
tout en mettant de coté les gadgets purement décoratifs.

Si0

Compiz Fusion peut ainsi transformer votre environnement de bureau
en véritable vitrine pour les amateurs d'effets graphiques en tout
genre. Cela dit, ne perdons pas de vue que si certaines fonctionna-
lites améliorent sans conteste 'ergonomie du bureau (passage d'un
espace de travail a Pautre, d’une fenétre a l'autre, etc. via divers
effets), d’autres ne servent & rien si ce n'est a épater son entourage...
A l'usage, certains effets peuvent méme devenir trés vite agacants,
surtout si les raccourcis sont mal configurés et/ou méconnus... H
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LES GADGETS DE GOOGLE

SUR MON BUREAU !

par Aline Gérard

Google rend ses gadgets disponibles sous Linux en
version alpha. Linstallation de Google Gadget For
Linux passe par une compilation du projet. Pour rap-
pel, on télécharge l'archive .tar.gz, puis on exécute
les commandes suivanies :

tar xzvf gooqle-gadgets-for-Tinux-*.tar.qz
cd google-gadgets-for-linux-#

Jeonfigure

Make

sudo make install

make ¢lean

Vous retrouvez la procédure intégrale d'installation
dans le fichier INSTALL. Aprés un peu de patience
pour le temps de compilation, on exécute Google
Gadget a l'aide de la commande gq1-gtk qui ouvre
un panneau gerant la transparence sur le cété de
I'ecran. On pourra le mettre & gauche ou a droite.
On remarque également une petite icdne de notifi-
cation aux couleurs de Google dans le tableau de
bord. Depuis cette icone, on peut choisir de laisser le
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bandeau toujours a I'écran, tel un tableau de bord
ou le laisser cache par les fenétres. La taille du ban-
deau est configurable : pratique si I'on souhaite le
laisser toujours apparent.

Pour ajouter des gadgets, on clique surle « plus » du
panneau ou depuis un clic droit sur celui-ci. Un grand
nombre de gadgets nous est alors proposé, chacun
classe dans une catégorie pour une recherche plus
performante. Les gadgets sont aussi classés par
langue et on sélectionnera 'anglais pour avoir un
plus grand choix. Les gadgets sont ajoutés dans un
premier temps sur le bandeau. On peut ensuite les
afficher sur le bureau par un simple glisser/déposer.
Chaqgue gadget peut étre « enroulé » pour ne laisser
la place guau titre de celui-ci. Cela permet d’installer
un grand nombre d'objets et de n'afficher que ceux
que l'on désirent.

Les gadgets sont trés variés. On peut ainsi trouver
toutes sortes d’horloges, des jeux, des informations
et des utilitaires divers. Voici une petite sélection de
guelgues-uns :

Virtual Flower Pot : de jolies tulipes sur votre
bureau, qu’il faut penser a arroser pour les
voir fleurir ;

Answer Ball: une
boule bleue qui répon-
dra a toutes vos
questions ;

Catch the Bee : chas-
sez les mouches pour
vous détendre ;

Temporisateur offi-
ciel de nouifle de
PuppetMuppet : il
surveillera le temps
de cuisson de vos
nouilles ;

» System info: pour
connaifre quelgques
informations systéme ;

Performance Meter :
pour connaitre I'état
du CPU et de la RAM
sous la forme d'un
indicateur de tableau
de bord de voiture ;
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Quand on parle de personnalisation de son espace
de fravail, on pense essentiellement fond d'écran,
changement des couleurs des fenétres, gadgets,
mais n'oublions pas le terminal. En effet, celui-ci est
un outil important et méme essentiel de tout linuxien,
méme si les interfaces graphigues font de plus en
plus de choses.

Voici donc Guake, un terminal que 'on aura toujours
sous la main, accessible via la touche [F12]. Guake a
la particularité de se « cacher » en haut de I'écran. Le
raccourci clavier penmet de le rendre apparent etde le
cacher. On pourra choisir sa taille et le raccourci [F11]
Jagrandit en plein écran. Il est bien entendu possible
de modifier son style : police, couleur, image de fond
et transparence.

Flg. 2 : Bureau contenant les gadgets : Answer Ball, Temporisateur officiel de nouille, Virtual Flower
Pot. A gauche : Google News et Performance Meter.

Si la transparence ne fonctionne pas, on pourra 'ac-
tiver en affichant un fond d’écran a l'aide de la com-
mande [sctroot par exemple. On a ici une pseudo-
transparence, puisqu'elle ne concerne gque le fond
National Geagraphic : une jolie photo qui change chaque jour ; d’écran. On ne verra pas par transparence les feng-

Nasa Moon as seen from Earth - la lune en fond d’écran prise par la Nasa. tres présentes sous Guake. Dans ses preferences, on
pourra également choisir de |e laisser ou non au-des-

Google News : l'actualité sélectionnée par Google directement sur le bureau ;

Uinstallation a créé un répertoire .qoogle/gadgets dans votre hone/ ot un repertoire sus des autres fenétres lorsquiil est ouvert. Le laisser
downloaded_gadgets contient les gadgets inslallés sur le bureau et un répertoire toujours au-dessus est assez pratique si sa taille n'est
thumbnails contient les images téléchargées lors de I'apercu de tous les gadgets pas trés encombrante, car cela permet de travailler
disponibles. Le nombre de gadgets estimportant : il y en a pour tous les godts. sur d'autres choses en I'ayant toujours sous les yeux.
Les amateurs seront heureux de son arrivée sous GNU/Linux ! H Un paquet deb ainsi gue les sources sont disponi-

e i bles sur le site du projet. La liste des dependances
Note - La version testée ici est la 0.9.3, la derniére version en developpement soriie au nécessaires pour l'installation et la compilation sont :
moment de I'écriture de Iarticle. python-dey, 1ipotlsZ B-directh-dey, Jibxli-dev, python-rotify,

""" pyihon-vie, sconfZ-dev. Sous KDE, il sera peut-étre
nécessaire dlinstaller le paquet notification-daenon pour
gérer les messages de notification émis au démar-
rage de Guake. Pour un démarrage automatigue a
Fouverture d'une session, il faudra le configurer selon
votre environnement de bureau. H

Site du projet : hitp:/icode.google.com/p/google-gadgets-for-linux/

] Site du projet : http://guake-terminal.org/
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Fig. 3 : Bureau contenant les gadgets : Catch the Bee et Virtual Flower Pot. A gauche :
Temporisateur officiel de nouille, System info.
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GERER SES WIDGETS

SOUS GNOME

par Fleur Bri 1)

Screenlet, desklet, widget, peu importe le terme employé, il s’agit 1a de
petits programmes a positionner sur votre bureau, des gadgets qui sont
loin d’&tre indispensables mais qui ajoutent une touche de fantaisie et
peuvent méme s’avérer trés pratiques selon leur réle. Nous présenterons
ici deux utilitaires permettent d’ajouter aisément tout un tas de widgets sur

votre bureau.

Les atouts de Screenlets résident dans son interface
agréable et intuitive, ainsi que dans le lot de widgets
(appelés ici « screenlets ») proposés par défaut. Une
ancienne version se trouve dans les dépots d'Ubuntu
Hardy. Pour bénéficier d’'une version plus récente,
récupérez le derniére version sur le site GetDeb
(http:/lwww.getdeb.netlrelease/2748) ou ajoutez le
dépot suivant dans votre fichier /etc/apt/sources.list :
deb http://ppa.launchpad.net/gilir/ubuntu hardy main universe.

Une fois installée, le gestionnaire de screenlets se
niche dans le menu Applications -> Accessoires ->
Screenlets (a noter au passage que Screenlets peut
également étre utilisé sous KDE). Un daemon est
installé conjointement & I'application ; il s& matérialise
par I'apparition d’une nouvelle icone dans votre tableau

de bord, via laquelle vous pourrez lancer le gestion-
naire de screenlets, lancer I'un ou l'autre des screen-
lets a la volée ou encore fermer tous les screenlets.

Le gestionnaire de screenlets (Fig. 1) est trés simple
a prendre en main : a droite apparaissent tous les
screenlets mis a votre disposition par defaut et a
droite se trouvent les différentes actions possibles.
Pour installer un screenlet, cliquez dessus avec la
souris puis cliquez sur le bouton Lancer/Ajouter.

Parmi les screenlets proposés vous frouverez un
contréleur de luminosité de I'écran (pour les porta-
bles), une calculatrice, un calendrier, un mini-agré-
gateur de flux RSS, I'affichage de la météo, une
horloge, un contréleur de I'espace disque, un notifi-
cateur de courrier Gmail, votre horoscope, un bloc-
notes, une régle, un apercu des derniéres vidéos
ajoutées sur YouTube, etc.

Une fois installé, chacun des screenlets se confi-
gure via un clic droit, puis
Propriétés. Vous pourrez y

=] _ . - definir les proprietes d'affi-
! i = : o Q chage du screenlet, changer
LancerajoLter K o S . . p
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sélectionnez ensuite I'archive téléchargée : celle-ci
apparait alors dans votre gestionnaire et vous pouvez
linstaller comme tout autre screenlet.

Si vous avez activé les effets du bureau (via le menu
Systéme ->» Préférences, -> Apparence, onglet Effets
visuels, mode Normal ou Extra), vaus pouvez utiliser
vos screenlets comme des widgets, que vous pourrez
faire apparaitre 4 la demande. Pour cela, lancez le
gestionnaire de configuration de Compiz, puis cochez
la case Couche Widgets. Ensuite, effectuez un clic droit
sur tous vos screenlets de maniére a activer l'option
Fenétre -> Widget. Enfin, il vous suffira de faire [F9]
- _ (raccourci clavier par defaut, que vous pouvez redéfinir
2] : . _ dans la fenétre de configuration de Compiz, via un clic
: : sur Couche Widgets) pour faire apparaitre tous vos wid-
gets d’un seul coup, & wimporte quel moment (Fig. 3) ;
un clic de souris vous fait revenir en mode normal.

Sachez que Screenlets vous permet également d'ajou-
: ter des Google gadgets a votre bureau (voir larticle
PR a ce sujet page 54). Pour cela, ouvrez le gestion-

1. 2 - Quelques exemples de screenlels installés ici - Galendar, ClearWeather, naire de Screenlets, puis cliquez sur Installer. Dans
Clack, Flower, Gmail, Notes, Ruler, Sensors et YouTihe. le menu déroulant, choisissez l'option Convert Web
Widget. Dans la nouvelle fenétre qui apparait a l'ecran
(Fig. 4), vous devez tout d'abord trouver le widget a

(section Screenlets). Une fois l'archive téléchargée (elle doit étre convertir parmi : Google Gadgets, Yourminis Widgets, SpringWidgets
de la forme nom_du_screenlet.tar.gz) et enregistrée sur votre disque, et Widgetbox. Nous choisissons ici Google Gadgets. Cliquez ensuite
allez dans le gestionnaire de screenlets, puis cliquez sur le bou- sur le bouton Go to web page pour choisir 'un des gadgets proposés
ton Installer. Choisissez I'option Install screenlet, puis validez ; (Flig. 8).

NE RATEZ PLUS AUCUN RENDEZ-VOUS GRACE A
GDESKCAL !

Gdeskeal est un petit calendrier élégant, translucide et pratique a
positionner sur le bureau. Cencu pour le bureau Gnome, il s'installe
trés simplement via votre gestionnaire de paquets ou en ligne de
commandes (paquet gdesical). Pour le lancer, tapez gdeskeal dans un
terminal ou dans le lanceur d’applications ([Alt]+[F2]). Une fois posi-
tionné sur le bureau, effectuez un clic droit dessus.

1g 11 312
17 finh 19

\fous pourrez positionner le calendrier a I'endroit souhaité via l'option
Déplacer. \lous pourrez effectuer votre choix parmi tous les skins
disponibles via Foption Changer de revétement.

juin 5500
renseignez les differents champs (heure, commentaire, récur-
rence de 'évenement). Par la suite, au passage de la souris
sur fune des dates auxquelles est associé un evenement, un
pop-up apparait pour vous rappeler de quoi il s'agit.

Une petite remargue : contrairement aux apparences, Gdeskeal
est une fenétre a part entiere. C'est pourquoli, si vous cliquez

I

16 l.‘r@u 0
23 24 ’

an

Voicl quelgues-uns des themes proposes pour Gdeskcal

« august », « miderat », « gorillerat ». sur le raccourci vers votre bureau (I'icone dans votre tableau

de bord, qui permet de minimiser toutes les fenétres ouver-
| a date du jour est bien éviderment mise en évidence, mais Gdeskeal tes d’'un seul coup), vous ne verrez plus votre calendrier sur
gere également les rendez-vous (ou dates importantes). Pour ajouter votre bureau : il aura été minimisé comme les autres fenétres.
un rendez-vous (un anniversaire, un événement a ne pas oublier), Pour le « récupérer », il faudra minimiser toutes les fenéires
effectuez simplement un double-clic sur la date concernee, puis une aune. M
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Gérer ses widgets sous Gnome

i &

Gaagle Gadgets

Comverti mimporte quelle page web widget en Sereenlet.

Etspe I - Trouvver b widget 2 corvertic

‘= | Gotawsh page:

Etape 2 = Copser ot Coller le code HTML du widget dans |s boite ci-dessaus

[

Etsos 2 : Danner lui wn nom dans |a bote ci-dessous et ciquar sur OK pour le convertirf ™
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Etape 2 : Donner luiun nom dans 13 bote c-dessous et chquer sur QK pour |e cormeertirll

<eipt=|

cliquez sur

La nary duwidget |Tour Edfel

| le bouton

Ajouter a
votre page
Web cor-
respondant. Vous voila dirige

7| sadgets Goegle pour votre page Web

vers une nouvelle page qui vous
permet de régler les paramétres
d'affichage du gadget (Fig. 8).
Ceci fait, cliquez sur le bouton Obtenir le code.
Copiez/collez la ligne de code HTML générée
dans le convertisseur de Widget (Fig. 7) et
donnez un nom a votre widget, puis validez.
Votre gadget apparait a présent dans votre
gestionnaire de screenlets, vous n‘avez plus
gu'a l'installer comme tout autre screenlet !

Derniére version : 0.1.2

Site du projet : http://www.screenlets.org/ [en]

Uinstallation de GDesklets s'effectue simplement
via votre gestionnaire de paquets (il faut installer le
paguet nommé gdesklets ; il est recommandé d'ins-
taller également le paquet gdesklets-data, qui pro-
pose des applets supplémentaires). Linstallation
effectuée, rendez-vous dans le menu Applications
-> Accessoires -> gDesklets.

Dans la fenétre qui apparait alors a I'écran sont lis-
tées les différentes applets disponibles, organisées
par catégories (ou encore par auteur ou par ordre
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Tarmind

code HTML
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4 gadyet dans vetre pages wab.

alphabétique). Cliquez sur I'une des catégories
pour voir s‘afficher dans la colonne de droite la liste
des applets disponibles (meétéo, calendrier, tempé-
rature du disque dur, état de la batterie, prise de
notes, controle CPU, horloge, etc.). Chacune est
accompagnée d'une courte phrase de description.

Notez I'apparifion également d’une nouvelle icéne
dans le tableau de bord, qui matérialise le fait que
le daemon gdesklet est lance. Un clic droit sur cette
icone vous permet d’accéder a l'interface de confi-
guration, qui vous permet entre autres de définir un
raccourci clavier pour passer en mode flottant. Vous
pourrez également, a partir de cette icone, lancer le
gestionnaire de desklets ou stopper le daemon.
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CAIRO-CLOCK, UNE
JOLIE HORLOGE SUR
VOTRE BUREAU

Encore une horloge me direz-vous ! Oui, mais
comme le souligne son concepteur, Cairo-Clock
exploite pleinement les possibilités dXorg 7.0, asso-
cié a un gestionnaire composite comme Compiz ou
Beryl ainsi qu'aux biblio-
thégues cairo et librsvg,
pour fournir aux utilisa-
teurs une horloge vrai-
ment « eye candy ».

Taille au démarrage

| persannalizée

Pour profiter de Cairo-
Clock, installez simple-
ment le paquet cair¢-clock
a l'aide de votre gestion-
naire de paguets. Veillez
par ailleurs a ce que les
dépendances suivan-
tes soient satisfaites :
gtk+ 2.10.0, cairo 1.2.0,
librsvg 2.14.0, libglade
2.6.0, Xorg 7.0, un ges-
tiohnaire composite
{(Compiz), une carte
graphique supportant

aptions d'affichage
[ Afficher ks S=condas
& Alliclen b Date
& Toujours 2 dessus
[ Affchar dans 1a pagar
|| Afficher dans |a parme des tachas
{_] Adficher sur tows lee buresuse
[ Ltiliser = format 24h
GQualits de lanimation

grossier e %

La fenétre deé bféférsnc'és de
Cairo-Clock.

I'accélération graphigue. Notez gue I'horloge
fonctionne également sans gestionnaire com-
posite, mais cest beaucoup moins joli puisque
vous maurez plus I'effet de transparence...

Rappel : pour savoir si lacceleration graphigue est
activee, fapez la commande {1150 | grep “direct
rendering”, qui doit vous retourner {85, Dans le
cas contraire, la procédure d'activation differe
selon le madéle de chipset et le type de carte. Une
recherche surinfemet avec le modele de votre carte
devrait vous fournir les informations nécessaires.

Une fois installée, Cairo-Clock est accessi-
ble via le menu Applications -> Accessoires
de Gnome. Lhorloge peut étre positionnée
nimporte ou par simple cliquer/glisser avee
la souris. Un clic droit sur I'herloge permet
d’'accéder aux proprietés : dimensions,
theme graphique et options d'affichage.

Pres d'une vingtaine de thémes graphiques
vous sont propesés ; fous ayant ete congu

Divers thémes ont été appliques ici
default, gremlin, ipulse, radium et zen.

avec le logiciel de dessin vectoriel
Inkscape, ils se composent dele-
ments .svg. Vous rouverez des
themes supplementaires sur le
site www.gnome-look.org, dans
la section Cairo-Clock Themes.
Pour installer un nouveau theme,
téléchargez puis decompressez
Farchive du théme qui vous inté-
resse, puis copiez le répertoire
obtenu dans fusr/share/cairo-clock/
thenes. Redémarrez Cairo-Clock
et constatez que votre nouveau
theéme apparait désormais parmi
les choix proposés dans la fengtre
des propriétés de 'horloge. ®

7] Site du projet ; http:iimacslow.
thepimp.net/?page_id=23

Pour installer 'une des applets a partir du gestionnaire, effec-
tuez un double-clic sur celle de votre choix, puis glissez la souris
a l'endroit ol vous souhaitez positionner votre nouveau gadget.
Chacune des applets est ensuite & configurer ; effectuez pour
cela un clic droit afin d’afficher le menu contextuel et cliquez sur
Configurer le desklet. Notez au passage que vous pouvez, via ce
méme menu contextuel, déplacer I'applet, la supprimer ou encore
accéder au code source, etc. Les paramétres a régler varient
ensuite d'une applet a l'autre.

Des desklets supplémentaires sont & télécharger sur le site du
projet... Pour les installer, rendez-vous dans le menu Fichier ->
Installer un paquet, puis sélectionnez l'archive que vous avez
récupérée préalablement.
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Méme si Gdesklets propose pas mal de petites applets bien pra-
tiques, plusieurs sources d’erreur persistent dans 'ajout de cer-
taines applets et nous avons rencontrés quelques bugs lors de
son utilisation. Mais Gdesklets est encore relativement jeune, les
futures versions seront a coup sir plus fonctionnelles... H

Derniére version : 0.36 (fév. 2008)

Site du projet : http:/flwww.gdesklets.de/ [en]

% 7% wnen s B, # )

Fig. § : Gdesklets propose de petits gadgets sous forme de visuels sympathiques a
positionner ol bon vous semble...
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PERSONNALISEZ ET AMELIOREZ
LE LOOK DE VOTRE BUREAU !

DOSSIER

Site du projet :
www.kiba-dock.
org

KIBA-DOCK,

S’AMUSER AVEC
LA BARRE DE TACHES !

Voici un dock sympathique avec de multiples
configurations possibles que nous ne pouvons
pas toutes décrire ! On pourra bien évidemment
définir le comportement des fenétres par rap-
port au dock dans l'onglet Window, configurer
sa taille, son emplacement, son style (choix des

couleurs, de la forme des bordures) et le mas-
quage automatique dans l'onglet Dock, le com-
portement des icénes lorsqu'elles sont survolées
par la souris (on pourra ajouter une ombre, un
zoom plus ou moins important, une couleur, un
rebond) dans l'onglet Effets. Dans l'onglet Titre,
on choisira et configurera l'affichage d'un titre
sous l'icéne lors du passage de la souris. Voila
une configuration plus ou moins attendue dans
P'utilisation d’un dock...

La particularité de Kiba-Dock réside essentiel-
Jement dans onglet Akamaru qui permet un
affichage trés spécial du dock. Akamaru est
un moteur physique permettant de jouer avec
les icones du dock : on pourra par exemple en
attraper une avec la souris pour la lancer dans
Pécran afin qu'elle percute les autres ! Les diffe-
rents modes permettent de jouer au chat et a la
souris avec les icanes, de faire en sorte qu'elles
effectuent des mouvements permanents sur le

o Essentiel #3

bureau, de faire des petits trains d'icones, etc. Tout cela
ne sert bien entendu & rien, juste a s'amuser de temps
en temps !

Nous avons également la possibilité d’ajouter et de suppri-
mer des éléments au dock, comme une barre de taches,
des lanceurs d'application, un menu Gnome ou Xfce, une
corbeille, efc. Dans la barre des taches, on pourra afficher
un apercu des fenétres a la place de Iicone de 'application :
original, mais cela peut prendre un peu trop de place.

Kiba-Dock propose des choses bien sympathiques, mais
quelques bugs peuvent survenir ! Pour revenira une confi-
guration par défaut, il faudra se rendre dans le répertoire
~/.kiba-dock et supprimer le fichier config pour faire simple ou
I'éditer afin de supprimer les options causant des soucis. On
regrettera aussi tout le long de la configuration la présence
d’un bouton Appfiguer pour metire en place une option,
les effets ne s'appliquant pas toujours dans 'immédiat.

Kiba dispose de supports d'installation pour les distribu-
tions Ubuntu, Fedora, Gentoo, SUSE. Si on souhaite pas-
ser par la compilation, on téléchargera les fichiers a l'aide
de la commande :

_ | SV co https:f!kibadock.sun.saurcefcrge‘netisvnr‘notmbadcckftrunk kiba

Le téléchargement installe un répertoire kiba qui en contient
six autres. Avant de compiler, on s’assurera que I'on a
installé les dépendances et les versions -(ev associees :
python-gtk2-dev, automake, autoconf, 1ibtool, gettext, glibZ, gtk+2,
pango, glitz, librsvg, libxist. Pourla compilation, on exécutera
les trois commandes suivantes dans les répertoires amakurus,
kiba-dock et kiba-dock-plugins, les autres étant optionnels.

.fautogen.sh
make
sudo make install

Pour finir, on crée un répertoire vide global_plugins dans le
répertoire /usr/local/1ib/kiba-dock/ & l'aide de la commande
mkdir fusr/local/1ib/kiba-dock/global_plugins. La désinstallation
s'effectuera a l'aide de la commande sudo make uninstall.

Kiba est un projet fait pour fonctionner sur un bureau compo-
site : I'affichage ne sera pas optimal sur un autre bureau. H
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CAIRO-DOCK, UN DOCK
PERSONNALISABLE A SOUHAIT !

par Aling Gérard

Envie d’'une belle barre de lancement, configurable a souhait ?
Essayez Cairo-Dock, une barre de lancement personnalisable et a
theme. Placez-la en haut, a droite, en bas ou a gauche, masguez-
la automatiqguement ou laissez-la toujours visible. Cairo-Dock
contient des lancements d'applications, mais peut aussi contenir
Iicone des fenétres actuellement ouvertes.

En plus de cela, on peut lui ajouter des gadgets : la meteo, un
Tux ou un poisson qui se proménent sur le dock, une horloge,
un indicateur de batterie... et chacun se personnalise ! S'il existe
des thémes préétablis pour Cairo-dock, il est possible de le
configurer soi-méme depuis 'onglet Personnalisation de |a fene-
tre Configuration of Cairo-dock. Plusieurs vues permettent de
configurer I'apparence du dock : vue de face, vue en cercle avec
inclinaison dans le plan, vue parabeligue, etc., avec la possibilite
de choisir une vue différente pour les sous-menus.

Le nombre des configurations est fres important que ce soit pour
les vues, pour I'affichage des icones, pour le compartement de
celles-ci au passage de la souris ou la configuration du plan sur
lequel elles se trouvent. Cairo-dock propose aussi une configu-
ration avancée avec un trés grand nombre d'options. Il ne faudra
pas avoir peur de s’y perdre !

Clest dans le mode avanceé, dans l'onglet Applets que l'on pourra
ajouter des éléments comme la poubelle, un bouton Shutdown,
un controleur Xmms, Alsamixer ou Rythmbox, une horloge pou-
vant faire office d'alarme... Pour ne pas encombrer le dock de
multiples applets, on pourra accrocher ceux-ci sur le bureau, une
fagon dutiliser une seule application pour gerer des gadgets sur
le bureau et un tableau de bord original.

Cairo-Dock dispose d'un support pour Suse, Debian et Ubuntu.
Pour ces deux derniéres, on utilisera les commandes suivantes -

De nombreux applets sur fe dock !

gsitory.cairo-dock.arg/ubuntu/caire-dock.gpg

deb http:// ro-dock.org/ubuntu hardy cairo-dock
sudo apt-get update

sudo apt-get upgrade

sudo apt-get install cafro-dock cairo-dock-plug-ins

Pour la compilation, on télécharge les sources et on execute les
commandes suivanies dans le répertoire cairo-dock, en s'assurant
préalablement que les paquets liticaire?, THibrsyg?-2, Tibghitzl, Tibglitz-glxl
sont installés ainsi que leur version ey :

autorecont -isvf

feonfigure

Site du projet | www.
make cairo-dock.org
sude make install

On s'assurera de posséder une bureau composite pour un meilleur
fonctionnement de F'application, notamment au niveau de la frans-
parence, bien gue la version en développement devrait mieux gerer
celle-ci pour les autres bureatx.

Cairo-Dock est un outil bien sympathique, que l'on apprecie de pou-
voir configurer a son image ! H

Note : Les bureaux dits « compaosifes » sont des gesfi de fanéires tels Compiz
et Compiz Fusion, Beryl, Metacity et Kwin (KDE4 avec s de burea :
qui utilisent des effets 3D et intégrent une gestion de la fransparence complete.
Celte transp ploitée dans lutilisation des docks pour un meilleur rendu.




PERSONNALISEZ ET AMELIOREZ
LE LOOK DE VOTRE BUREAU !

DOSSIER PERSONNALISEZ

—— VOTRE .
ONS | NAVIGATEUR WEB !

par Fleur Brosseau

Comme vous le savez, de multiples extensions permettent de personnaliser
Firefox et d’adapter ses fonctionnalités & vos besoins. Son « look » ne
mangque pas d’attention, loin de la ! Tout d’abord, de nombreux themes
permettent d’en modifier I'allure générale, pour qu'il s’harmonise au mieux
avec voire environnement de bureau. Mais, il existe également pas mal
d’extensions permettant de lui ajouter quelques touches de couleurs et autres
finitions qui le rendront encore plus convivial...

CrystalFox
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® CHANGEZ -

Firefox est installé avec son théme par defaut. Pour en chan-
ger, c'est trés simple : rendez-vous sur le site officiel des
add-on pour Firefox (https:/faddons.mozilla.org/fr/firefox/),
puis choisissez la catégorie Thémes. Un grand choix de
thémes vous est proposé ici. Pour installer celui de votre
choix, cliquez sur Ajouter & Firefox, puis redémarrez
votre navigateur.

Par la suite, vous pourrez vous rendre dans le gestionnaire d'ex-
tensions (menu Outiis -> Modules complémentaires), puis, dans
la section Themes, sélectionnez celui de votre choix et cliguez
sur Utiliser le théme. Aprés un redémarrage de Firefox, celui-ci
arborera le nouveau théme sélectionné.

Nous ne pouvions évidemment pas vous les montrer tous, mais
voici déja une petite sélection de themes parmi les plus originaux :
voir les captures ci-dessous.
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APPLICATIONS

~ EXTENSIONS
CEUEBRIEL

llote : Les extensions qui sont présentées ici sont foules compatibles avec
Firefox 3 of sont & récupsrer sur e site officiel das extensions de Firefox
(https:/faddons.mozilla.org/fi/firefox/) saurf precision contraire.
Pour installer une extension, cliguez simplement surle bouton Ajouter a
Firefox qui se trouve sur la page Web de l'extension, puis validez.

© COLORFULTABS

Une extension trés simple qui permet de colorer tous ses
onglets (Fig. 2) ! Au choix, des couleurs attribuees de fagon
aléatoire ou bien une méme couleur pour chaque onglet du
méme nom de domaine. Un clic droit sur un onglet, suivi de
l'option CelorfulTabs -> Tab Color permet de redéfinir la couleur

In The Dark

Fig. T
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Personnalisez votre navigateur

Web !

Wiruthon Mak, 1o Grmah - B & comnpiz - B8 4 compi - Do, S ascragns:

ColorfulTabs quick-siait guide

de votre choix pour un onglet (Flg. ). Vous pouvez
méme ajouter une image d’arriere-plan, sachant
que le niveau de transparence des onglets se régle
ensuite dans les préférences de I'extension (option
Fading Level). Les options avancées permettent
de fixer la saturation et la luminosité des couleurs.
ColorfulTabs est donc idéale pour améliorer l'identi-
fication et la différenciation de vos onglets.

FoxSaver se « pilote » trés faci-
lement via un clic droit sur l'icdne
FoxSaver qui se trouve en bas a
droite de votre écran. Un clic sur
I'icéne active/désactive I'exten-
sion. L'option Lancer FoxSaver vous permet de lan-
cer le diaporama quand bon vous semble. Quant
2 l'option Minutes d'inactivité, elle vous permet de
régler le laps de temps a partir duquel le diapo-
rama doit &tre lancé automatiquement. Pour stop-
per le diaporama, effectuez un clic droit sur I'écran.

| Choisir les phetes :
Ty R ey

| g1 Photes do FouSaver

| Dassier de mes photos

| ® [fomefeurphatas
@ [homefiaunphetosfimes

& i osmacacans

Extansions par defaut des fickiers dimages: | jpo.gileng|

| Adresses da flux Madia RS5

| Paga Web (URL)
O | Fendfemugoagleom TS F
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e Skl
| {i=Pencourir le dasshar tu <

]!

iemkril 4l ok 1[

Fig. &

Vous pouvez accéder aux prefé-
rences de 'extension via Options
(Fig. 5). Vous pourrez y definir vos
répertoires de photos, activer ou
non les photos issues de FoxSaver,
ajouter des flux RSS de médias et
méme une URL. Longlet Autres
de la fenétre des préférences per-

@ FOXSAVER

FoxSaver permet de lancer un diaporama de vos
photos aprés un certain laps de temps d’inactivité
de votre navigateur Web (Flg. 4). Vous pourrez non
seulement faire en sorte que I'extension utilise vos
dossiers de photos, mais aussi utiliser les photos
« par défaut » proposées par FoxSaver {(que vous
pouvez visualiser sur www.foxsaver.com), qui sont
régulierement mises a jour. En outre, FoxSaver est
compatible avec les flux RSS dimages. Notez égale-
ment gue si vous utilisez deux écrans, Vous pourrez
tout a fait continuer a travailler sur I'un, pendant que
vos photos défilent sur le second écran !

----- —— met de paramétrer plus finement
le comportement de FoxSaver,
notamment le temps d’affichage

de chague image, des effets de fondus pour les tran-

sitions, l'inclinaison des images, etc. Vous pourrez
également dresser une liste d'URL lors de la consul-
tation desquelles FoxSaver ne devra pas se lancer.

Voila un €conomiseur d’&€cran bien plus original !

FIERR

Loin d’étre indispensable, cette extension offre sim-
plement une page d'erreur beaucoup plus agreable
a I'ceil que la page d'erreur standard, avec un joli
logo Firefox en arriére-plan. Observez le résultat sur
la figurs 6 !
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l'user-agent. Enfin, dans la section Divers, vous pour-
rez définir un son qui sera joué au démarrage et regler
I'opacité des différents éléments du splash screen. A tout
moment, un clic sur le bouton Apergu vous permettra de
contréler I'apparence de votre splash screen.

FISSION

Fission permet de visualiser la barre de progression du
chargement de la page dans la barre d'adresse, a la
maniére de Safari (Elg. 10). Vous pourrez choisir la cou-
leur de votre choix parmi les préférences de l'extension

© PERSONAS FOR
FIREFOX

Aprés installation, une nouvelle
icbne apparait en bas a droite
de votre écran : une petite téte

de panda roux. Un clic gauche | [ TE

sur cette icone affiche le menu
contextuel dans lequel vous
n‘aurez qu'a effectuer votre choix
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de théme parmi les plus popu-
laires, les nouveautés, ceux que
vous avez récemment utilisés,
etc. Vous pouvez visualiser quel-
gues exemples sur la figure 7.

Les éléments affectés par le

changement de style sont : la barre d'outils, la barre de navigation,
la barre personnelle et Ia barre d’état. Notez que la modification
du théme s’effectue « a la volée », pas besoin de redémarrer votre
navigateur ici | Pour revenir a la normale, sélectionnez simplement
l'option Use default.

Extension a récupérer sur http://labs.mozilla.
com/2007/12/personas-for-firefox/.

@ SPLASH

Une extension qui permet simplement d’'ajouter un splash
screen amélioré et complétement personnalisable au lancement
de Firefox (Fig. 8). Cette extension supporte le son, l'opacite,
les propriétés CSS et vous pourrez méme afficher I'image de
votre choix !

Votre splash screen se configure via les préférences de I'exten-
sion (Fig. 8). La section Général permet notamment de définir
la couleur d’arriére-plan du splash screen, ainsi que le style de
la fenétre (a l'aide de propriétés CSS). La section Image vous
permettra d'utiliser 'image de votre choix et non le logo Firefox
proposé par défaut. Dans la section Texte, vous pourrez saisir
le texte qui doit s'afficher sur votre splash screen, sa couleur et
le style. Typiquement, on inscrira
{appVersion}, {buildID}, {userAgent}

pour que s'affichent la version de

g 9

Image  Teas

Paramétres de l'image
URL gz Kmage {ex il i Pl 3

Firefox
Chargernent...

et activer ou non cer-
taines fonctionnalités
comme l'affichage de
I'état de connexion
et des liens actifs et
survaolés.

CTRL-TAB
Une extension qui
rappelle le raccourci [Alf]+[Tab] qui vous permet de passer rapi-
dement d’'une application & une autre sur votre systeme. Ici, apres
installation de I'extension, le raccourci [Ctrl]+[Tab] permet de
passer d’'un onglet a l'autre en visualisant un apercu de chacun
au passage... H
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DOSSIER

TERMINAL

TRANSPARENT
ET SANS MENU

par Aline Gerare

d

Un terminal transparent et sans bordure, voila de quoi donner son petit
Sledepple effet. En voici deux : Eterm, qui gére de la pseudo-transparence et qui sera

www.eterm.org

surtout utile pour un gestionnaire de fenétres « minimaliste », et Tilda, qui

géere une transparence compléte qu'on préférera pour un environnement de

bureau tel que Kde, Gnome ou Xice.

arght Klmmapqraotuyezy=
456759 7
5 ansipAagEtoRiiT

En haut, Tilda avec une trensparence compléte et,
en dessous, la semi-transparence d’'Eterm

UN TERMINAL
ORIGINA

Tilda est un terminal qui aime se cacher grace
4 une touche de raccourci configurable {onglet
Keybindings dans le menu des préférences) lui
permettant un acces rapide. Pour linstaller, instal-
lez simplement le paguet nommé tilda. Sa premiére
ouverture lance une fenétre de configuration, ce
quapprécieront les personnes n‘aimant pas toucher
aux fichiers de configuration | On personnalise ainsi

Tilda rapidement et facilement en modifiant notam-
ment les paramétres suivants :

Dans l'onglet General, I'option Display on all
workspace permet un affichage du terminal sur
tous les bureaux.

. Dans l'onglet General, l'option Do not show in tas-
kbar permet de ne pas afficher Tilda dans la barre
de tache du tableau de bord lorsque celui-ci est
ouvert, ce qui permet un gain de place.

Longlet Appearance permet la configuration de
sa taille, la gestion de la transparence, les options
Centered Horizontally et Centered Vertically per-
mettent de le centrer dans 'écran et au centre si
les deux sont cochées.

A partir de l'onglet Scrolling, on supprime les
ascenseurs.

On ajoute une fine bordure depuis l'onglet General,
option Show Notebook Border.

Dans l'onglet Appearance, on décoche I'option
Animated Pulldown afin de supprimer 'animation
lors du masquage du terminal.

La configuration de Tilda est sauvegardée dans
~/.tildafconfig_§f et ~/.tilda/config_-1 si 'on ouvre un
deuxiéme terminal. Lors de la prochaine ouverture
de celui-ci, il prend tout d’abord en compte la confi-
guration config_f. En plus de sa configuration parti-
culiére, le terminal n'oublie pas de gérer les onglets
& l'aide de la commande [CtrI]+[Shift]+[T].

Lors de l'utilisation, un clic droit dans Tilda permet
d'afficher le menu contextuel via lequel vous pourrez
accéder a nouveau aux préférences du logiciel ou
quitter le terminal.

Tilda est un terminal qui peut s'avérer agreable a

['utilisation tout en apportant un plus a la configura-
tion de votre bureau.
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@ ETERM ET
ESETROOT,

UN TERMINAL
COMME FOND
D’ECRAN

Un autre terminal connu pour sa transpa-
rence ou disons sa pseudo-transparence,
car seul le fond d'écran est vu en transpa-
rence (les icdnes et fenéires en dessous
ne sont pas visibles). Eterm gére donc une
pseudo-transparence, mais aussi la sup-
pression des bordures et des menus, ce
qui lui permet d’étre utilisé comme fond
d'écran ! Pour un utilisation « plus clas-
sigue », on pourra modifier I'apparence
des menus et des ascenseurs (scrollbar)
en changeant leur couleur ou en y appli-
quant un style. Ces configurations sont
possibles depuis le menu du terminal, mais
on préférera passer des arguments a la
commande Eterm.

Pour se donner des idées de configura-
tion, on installera le paquet eterm-themes qui
fournit un bon nombre de thémes ou on
en téléchargera sur le site du projet. Les
thémes sont installés dans le répertoire
Jusr/share/Eberm/themes. Pour les tester, on uti-
lisera la commande Eterm -t nom_du_theme. On
pourra utiliser ces themes pour en créer un
personnel en modifiant quelques éléments.

Pour donner un exemple de l'utilisation
d’Eterm, voici une commande qui ouvre un
terminal avec, dans l'ordre des arguments,
pas de bordure, pas de menu, un fond trans-
parent, une teinte jaune sur la transparence,
sans ascenseur et de dimensions 100x50.
L'option -g prend quatre parameétres :
largeurxhauteur+x+y avec x et y les coor-
données du point de départ optionnels :

Eterm --borderless --bu

ttonbar # -0 --tint yellow
--scrollbar 8 -g 84

X/

On pourra ajouter un autre argument inté-
ressant, -0 1, ot n est le numéro -1 du bureau
dans lequel doit s'ouvrir le terminal. Se réfé-
rer au Nan pour connaitre toutes les options
possibles. Pour utiliser la tfransparence, on
appliquera un fond d'écran a l'aide de la
commande Esetroot fournie avec le paquet
Eterm, et ce, méme pour les bureaux Gnome,
Kde ou Xfce, ce gui donnera l'illusion d'une
véritable transparence. H

DES INFORMATIONS
SYSTEME EN FOND
D’ECRAN AVEC CONKY

par Aline Gerard

15:02 =~ 2¢ |

Conky vous ravira si vous aimez disposer d'informations systeme en permanence,
et. méme si vous les consultez peu, il donnera un style bien personnel a votre
bureau. Pour qu'il ne soit pas encombrant, il peut &tre intégré au fond d’écran, sinon
il s'affichera dans une simple fenétre. Sa configuration est simple — pour peu gue
l'on se plonge un minimum dans la documentation — et grandement personnalisa-
ble. On linstalle a partir du paguet conky, puis le lance a l'aide de la commande cifiky.
Il se configure & partir d'un fichier ~/.conkyre. Si le fichier n'est pas présent aprés
Finstallation, on le créera a partir d'une copie du fichier couky.conf {présent dans
Juseishare/doc/conky/exanples/). A partir de ce fichier, on choisit les informations a affi-
cher, leur emplacement et la couleur a leur appliquer. Etudions un peu celui-ci.

L'utilisation la plus courante de Conky est siirement de l'intégrer au fond d'écran.
Pour cela, on utilisera la configuration suivante :

dout
0%

OWn_Wing

naow yes
ow_type desktop

On décommentera la ligne suivante (suppression du caractére #), qui permet, dans
l'ordre, de supprimer les décorations de la fenétre, de positionner Conky sous les
autres fenétres, de le positionner sur tous les bureaux et de ne pas l'afficher ni
dans la barre de tache, nisur le pager :

Iinwn_a."ir:d-a'.a.!_t';iﬁts undecorated,below,sticky,skip_taskbar,skip_pager |

On configure la taille et l'emplacement de Conky a 'aide des lignes suivantes :
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DOSSIER  PERSONMALISEZ

AMAROK VIA
UN FICHIER CSS

par Aline Gerard

Le lecteur multimédia de KDE, Amarok,

posséde une interface personnalisable
comme la plupart des lecteurs audio ou vidéo, mais sa configuration a
la particularité de s’effectuer via un fichier CSS. Ainsi, on retrouve un
fichier stylesheet.css dans les themes d’Amarok. Comme pour d’autres
applications, le plus simple pour commencer a créer son propre theme est
de modifier un théme existant en Padaptant selon le résultat obtenu et désiré.

Un style personnalisé avec un modéle de couleur adapté

Le nouveau théme se charge & partir du menu Dans cet onglet, on en retrouve trois autres a confi-
Configuration -> Configurer Amarok, section gurer : Musique, Paroles et Artiste. Ces onglets,
Apparence -> Style du navigateur de contexte. plus les différentes zones les constituant, sont
Le bouton Télécharger des styles récupeére les caractérisés dans le fichier CSS par le mot-clé box.

styles Amarok du site kde-look.org
et le bouton Installer un nouveau
style installe une configuration CSS
sous la forme d'une archive. Cette
archive est extraite de la configuration
d’Amarok propre a chaque utilisateur (dans
~/.kde/share/apps/amarok/themes/). C'est dans
ce dossier que I'on modifiera un théme
afin de créer le nétre. Une fois le théme
chargé, il apparait dans la liste des styles.

[@ Amaten
Ratndueien Heds Dy omiedie S

o || Le style Danna
g4l teléchargé depuis
Finterface d’Amarok

Le fichier CSS (nommé par défaut
stylesheet.css) ne configure pas toute

Iinterface d’Amarok, mais juste l'onglet il S i
Contexte qui fait office de lecteur audio. af o : |

s

e Essentiel #3
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En prenant un fichier CSS par défaut, on
retrouve dans un premier temps les carac-
téristiqgues générales d’un onglet avec I'élé-
ment body{}, puis les liens, qui sont le titre
d'un album ou le fitre des chansons, sont
bien entendu définis par I'élément a{} et,
enfin, on définit I'aspect général d'une boite
a l'aide des sélecteurs suivants :

box{}

.box-body{}
.box-a{}
.box-header{}
.box-header-title(}

On pourra ensuite définir des propriétés
propres a une zone en appliguant les sty-
les #current_box pour la zone d'information
d’un titre en cours, #faverites box{} une zone
qui apparait lors de la lecture d'un titre,
#albums_box{} pour Vos nouveaux albums et
Albums Favoris, sachant que, pour chacun,
on retrouve les styles définis précédemment
(par exemple, on aura #album_box-header{},
#album box-a{}).

On peut ensuite modifier 'apparence de
chaque propriété d'un album ou d'un titre a
l'aide des styles .album-header{}, .albun-image{},
.album-title{}, .album-song-title{} ou encore
.song{}, .song a{}, .song-artist{}. Ceci est une
liste non exhaustive des styles existants,
mais elle vous permetira de repérer les
éléments importants.

Pour chacun de ces slyles, on jouera sur-
tout sur les couleurs, les bordures et les
images de fond pour apporter sa propre
touche a Amarok. Pour modifier les images
de fond, on pourra ouvrir celles d’'un théme
existant, avec un logiciel de retouche
d’'image pour les modifier afin de garder la
bonne taille d'image. On modifiera chacun
des éléments les uns apres les autres, tout
en controlant de temps en temps le résultat
obtenu sur l'interface du lecteur audio. Pour
cela, il suffit de recharger le style en pas-
sant d’'un autre style au sien. Pour complé-
ter notre configuration, on adaptera le style
du reste de linterface a partir du menu
Configuration -> Configurer Amarok ->
Apparence ol I'on modifiera la partie
Modéle de couleurs.

Grace a ce fichier CSS, la personnalisa-
tion dAmarok est a la portée de tous. La
connaissance de quelques éléments CSS et
un peu d'imagination suffisent pour appor-
ter une touche personnelle au logiciel ! B

Amarok, détail de la GSS : http:/famarok.
kde.org/wiki/C85_Styles#Setting_your_
CSS_style_in_Amarok

Styles & télécharger : http:/iwww kde-
look.org/index.php?
¥contentmode=55

B __SUITE : DES INFORMATIONS SYSTEME EN FOND D’ECRAN AVEC CONKY

La ligne stigpled_borders o affiche un contour en pointillés ol plus la valeur est petlite,
plus les pointillés sont rapprochés. Pour les supprimer, on utilisera dray_borders no.

On choisira les cauleurs par defaut a 'aide des trois lignes suivantes, qui corres-
pondent respectivement aux couleurs du texte, aux couleurs des ombres et aux
couleurs de contours :

default_color white
default_shade_color black
default_outline_color black

On trouve encore quelgues €léments de configuration, puis une partie TELT qui
contient toutes les lignes qui seront affichées. On a ici un ensemble de variables
définies entre 5{}, le reste est du texte brut. Pour specifier une couleur a une ligne,
celle-ci débutera par une variable de couleur ${color 53 coulesr}. On positionnera
un élément par rapport au précédent en ufilisant, au début de Ia ligne, la variable
S{uoffsel nhauteur} pour la hauteur et la variable ${offser alongueur} pour la longueur.

Il y a ici un grand nombre de variables que I'on peut afficher. Nous n'allons pas
toutes les décrire. Pour connaitre leur signification, on consultera le résultat obtenu
al'écran et, pour plus de détails, la documentation de Conky qui les decrit toutes.
On pourra par exemple afficher des informations sur F'utilisation du CPU, l'es-
pace disque utilise, les processus en cours, les applications utilisant le plus de
mémoire, des informations de connexion, mais aussi des informations provenant
d'un lecteur de musique tel gu’Amarok ou Xmms ou ['affichage d’'informations
d’une boite mail.

A coté des informations systéme, la variable ${iir} trace une ligne horizontale et
${stippled_fr}, pour une ligne pointillée, ${alignr} permet d'aligner a droite et §{alignc}
de centrer.

Pour l'intégration dans le fond d’'écran, on utilise une pseudo-transparence qui
nest effective qu'avec l'utilisation de commandes telles que Esetroot installé avec
Eterm, fbseihg lutilitaire de Fluxbox ou encore fell qui permettent I'affichage de fonds
d'écran. Dans un environnement comme Gnome ou Kde, il faudra donc utiliser cette
commande en plus du fond d'écran affiché par I'environnement de bureau.

Si la documentation de Conky vous inspire peu, vous trouverez facilement des
fichiers de configuration disponibles sur Internet. W

M Ssitedu projet - http:ficonky.sourceforge.net/
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DOSSIER N METTRE PLEIN LES YEUX
A SON AUDITOIRE

AVEC OPENOFFICE
IMPRESS !

par Fleur Brosseali

Depuis la derniére version 2.4 de la suite bureautique OpenOffice.org,
e outre de multiples nouvelles fonctionnalités, le module de présentation
OpenOfficeor Impress bénéficie d’un nouvel éventail de transitions 3D, basees sur
OpenGL. De quoi en mettre plein la vue a votre public lors de vos

conférences et autres présentations...

| Erchoa lﬂ.u- Efiage jasartien Pl Gl Du;wm.uw- =3 ‘_';___
= e ’im"_ P A s SR e : OpenOfficeorg 2.4 i
o e - —— = . o - 'mnnmo.ﬂrﬂh'h"'-'f‘mdi”-";f:ﬂm et e =
@ o efoie 2 [ 2 ot e R e e o Ubuntu, Mandriva, SUSE,
I‘x:',"'“"" 1 i n::smvw 1 H H
&m}w P 18 > prane e opmccsonzar Frugalware. La distribu-
z U aiee & silactiznnias ) 000-; i stems Inc. .
%5 ; Tﬁim""““'ﬁ"ﬁ: o g:pﬁ;:?tu;angcre‘epar;eg:ns}:ndubmubasuur & tion Fedora est un cas
#an | Buswars vericals . ol ik eI - =
£t e | S| 2 e T i a part, car elle propose
e g Bl e sl ste : une version modifiée
& Linux Pratique Essentiel s g e O e 2
oot i e e e d’OpenOffice.org, non
& i aK 1 A -
sd i e J basée sur coo-build.
Dismend Exiions e g | Fig. 4 : Pour savair quelle édition Sachez que les transi-
3 d'OpenOffice.org est installée tions 3D sont incompati-
sur votre systéme, rendez-vous 15 A :
e bles avec I'édition Va[nlia,
i e d'Openofiice.org. Ici, on voit qu'il donc seul le systeme
| S S ne s'agit pas de I'édition Vanilla, Linux peut bénéficier de
mais dune édition créce par ces nouvelles transitions

Debian et Ubuntu.

pour le moment ; les utili-
sateurs Windows devront
patienter (ou migrer sous
Linux...) {voir Fig- 1).

L'édition « Vanilla »
est I'édition la plus
populaire d’'OpenOf-
fice.org, la version
officielle créée par
Sun Microsystems.
C’est la version que
I'on peut obtenir sur
le site http://www.
OpenOffice.org et
c’est la version qui est
utilisée par les utili-
sateurs de Windows.
Mais, il existe d'autres

éditions d’OpenOffice. ' i ;

org, toutes basées sur [Fig. & Transition « Rochade » : l'une des ; e
2 jus élégantes ; la diapo apparalt " 5 e, :

le module ooo-build. gmgmsgwemem o e?fecrﬁznr Fig. 4 : Transition « Flipping tiles » : la diapo

C’est le cas des ver- une courbe depuis le fond, jusqu'a apparait sous forme d'un damier qui
sions d’OpenOf‘ﬁce.org f'avant-plan, tout en se reflétant au apparait progressivemnent.

intégrées a Debian, BT

troducing a New Product
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Pour bénéficier des transitions 3D :

> Les utilisateurs d'Ubuntu (version Hardy) et de Debian (Lenny et Sid) installeront le
Introducing a New Product paquet nommeé openoffice.org-ogltrans.

Les utilisateurs de Mandriva 2008 installeront le paquet openoffice.org-core, version 2.4
ou supeérieure, qui inclut le fichier 06LTrans.unc.so (une recherche sur http:/frpmfind.
net de ce fichier vous permettra de récupérer le paquet adéquat).

» Les utilisateurs OpenSuSE installeront le paquet Openoffice_org, version 2.4 ou supé-
rieure, incluant le fichier 06LTrans.uno.so (une recherche sur http:/frpm.pbone.net de
ce fichier vous permettra de récupérer le paquet adéquat).

Ceci fait, dans la liste des transitions, vous devez visualiser maintenant 14 nouvelles
transitions : tile-flip, outside-cube, revolving-circles, turning-helix, inside-cube, fall,

g, §: Transition « Turning helix » : la diapo turn-around, iris, turn-down, rochade, venetian3dyv, venetian3dh, static et finedissolve.
apparalt progressivement, apres rotation Vous pouvez en visualiser un apercu sur les captures qui illustrent cet article...
des différentes sections horizontales qui la
constituent. Votre présentation est préte, le diaporama peut étre lancé... et, désormais, de jolis effets

de transition sont & votre disposition! m

_IVIODIFIER L’INTERFACE DE IVIPLAYER

oar Afm‘f‘ Gerard

s _.__ﬂ
MPlayer |

Assis devant son ordinateur pour écouter de la musique ou regarder une
vidéo, on passe un moment agréable devant son lecteur multimédia favori.
Pour accompagner ce moment, on va personnaliser son lecteur multimédia
a l'aide d’'un skin, une nouvelle peau pour notre application, qui lui apportera
un petit plus. Le lecteur multimédia Mplayer permet ce changement de P T ance e
tenue et dispose de plusieurs skins a télécharger directement depuis SOn ~  melayerhg.hu

site Internet. Voici un apercu de ce que l'on peut y trouver... Al dipigecdesistny

www.mplayerhg.hu/
design7/dioad.html

Les fichiers telecharges doivent étre décompresseés (commande
tar azvl skin.Lav.gr) dans ~/.nplayer/skins/. On créera le répertoire
skins si celui-ci n'existe pas. Ceci fait, effectuez un clic droit sur
l'interface de Mplayer, puis choisissez I'option Skin Browser dans
le menu contextuel. Le skin que vous venez dinstaller doit main-
tenant apparaitre dans la liste, vous n‘avez plus qu'a faire votre
choix. Le changement d'habillage s'effectue « a la volée ».

Ces skins ont ete mis a disposition par des personnes ayant créé
elles-mémes leur theme. Il est donc possible pour nous de faire
de méme. Avec un peu de travail, on pourra créer un theme de
A a Z ou juste reprendre une forme existante et en modifier les
images. Cette deuxieme solution est bien entendu la plus simple,
car il suffit d'ouvrir chaque image a l'aide d'un éditeur d'images
pour les madifier en respectant leur taille et en conservant le nom
du fichier original.

Pour une configuration plus en detail, on pourra également partir
d’un theme existant. Un theme est un dossier comprenant les
images de l'application et un fichier de configuration nomme skin.
It paurra également contenir un fichier font.fnt pour la gestion
des caractéres.

De Ja coufeur avec le théme Krystal ’
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¥
MPlayer 5
)

D'autres thémes : http://
themes.freshmeat.net/
search/?q=mplayer

La documentation :
www.mplayerhg.hu/
DOCS/HTML/fr

Site d’Xmms : www.
Xxmms.org

Site du plugin wmdisco-
tux : hitp:/ffragment.
stc.cx/?page=
wmdiscotux
Téléchargement de
paquets Debian : http:ff
packages.debian.org/
etchfxmms

| Les skins de Winamp :
http:/fwww.winamp.
com/skins

LE LOOK DE VOTRE BUREAU !

DOSSIER

Modifier I'interface de Mplayer

De la mécanigue avec fe theme Terminatord

Le fichier skin se compose d'une secfion corres-
pondant & Papplication entiére qui en contient
plusieurs autres correspondant aux différentes
parties de I'application : la fenétre principale (1ain),
la sous-fenétre (sub), le menu (nent) et la barre de
lecture (playbar). Dans chacune, on définit chague
élément la composant de la maniere suivante :
menétément = panaml, param?, parand. Chaque élément
posséde des parametres quilui sont propres. Ceux-
ci sont normalement décrits sous forme de com-
mentaires juste avant leur déclaration (les lignes
commentées commencent par un point-virgule). On
entend par « élément » les boutons de linterface,
les différentes décorations, etc. Le fichier skin a donc
une structure semblable a ceci :

section = movieplayer
window = main
: éléments de 1a fenétre principale

end

window = sub

; Eléments de Ta sous-fenétre
end

Window = menu

; Eléments du menu

end

indow = playbar
. &léments de la la barre de lecture
end

end

Théme MPlayer Red.

Les images que l'on insére dans linterface sont des
images de type bitmap. Elles sont identifices dans
le fichier de configuration par leur hom de fichier
sans l'extension. Pour spécifier limage du bouton
de sortie du logiciel, on utilisera Ja ligne suivante ol
sxit correspond a l'image &xit.png se trouvant dans
le dossier du théme. Les quatre autres parametres
correspondent au point de départ de limage, de sa
largeur et de sa hauteur. Le dernier parametre est le
message genéré lors d'un clic sur ce bouton.

[ button = exit, 412, 47, 19, 2, evExit

Les images jouent un grand role dans la configura-
tion de l'interface, mais on peut egalement jouer sur
le positionnement des éléments et I'affichage des
informations concernant la lecture en cours. Le posi-
tionnement des eléments est certainement la partie
de la configuration la plus délicaie. On se référera
a la documentation fournie sur le site de Mplayer en
plusieurs fraductions pour plus de détail.

Pour finir, nous allons nous attarder sur un mode
intéressant de Mplayer : Ia possibilite de regarder
un film en mode texte ! On se doute bien que l'on
ne regardera pas un film en entier de cette maniére,
mais l'on pourra s'en servir pour eréer un fond decran
par exemple. Pour cela, voici deuix options a utiliser
en ligne de commande : nplayer -vo aa mon_film.avi
pour du noir et blanc et wplayer -vo caca mon_filn.avi
pour avoir de la couleur : voir figure ci-dessous. H

Big Bug Bunny avec la bibliotheque ASCI Art
en couleurlibcaca



QUAND VOTRE LECTEUR AUDIO

RESSEMBLE A WINAMP...

parAline Gerard

Il existe un grand choix de lecteurs audio pour
Linux et la possibilité de personnalisation de
celui-ci pourra faire toute la différence. Citons
trois applications, Audacious, Xmms et Noatun
qui utilisent skins et plugins de visualisation.

Audacious est assez ressemblant a Xmms,
puisqu'il dérive indirectement de celui-ci, mais
n'en posséde pas tous les plugins. Noatun est,
quant a [ui, le « Xmms » de Kde. Tous les trois
sont donc assez ressemblants, utilisant des
plugins de visualisation qui, une fois activés,
ouvrent une nouvelle fenétre affichant des gra-
phiques se comportant au rythme de la musi-
que. Avec ces lecteurs ressemblant au lecteur
propriétaire Winamp, il est possible d'utiliser les
skins de ce dernier.

Pour cela, il suffit de télécharger depuis le
site de Winamp le skin qui nous plait et de
I'installer dans le bon repertowe (par exemp]e
~f.xmms/Skins ou /us |

skins de Winamp sont des fichiers .usz
décompressent avec la commande
décompression n'est pas nécessaire pour
Audacious et Xmms, mais l'est pour Noatun.

Un apercu du lecteur Audacious (on utilise les
menus Préférences -> Modules d’extension et
Préférences -> Apparences pour la configura-
tion) : voir

Pour Noatun, les configurations s’effectuent
depuis le menu Configuration -> Configurer
Noatun dans les onglets Modules externes et
Interfaces. Noatun posséde, en plus de ses pro-
pres skins, trois types de revétements : Winamp,
Kaiman et K ofol Les thémes Wmamp smstal—
lent dans

: Noaiun et ses pluging de visualisation

i} APPLICATIONS

Hg. 1:Lesp
d'Audacio

Configurer Noatun -> Winskin en ayant
auparavant coché Interface Winamp
dans l'onglet Interfaces de la partie
Modules externes. Noatun installera
lui-méme le théme depuis le bou-
ton Installer le nouveau revétement.

Xmms posséde différentes visua-
lisations dans le méme esprit que
ses confréres, mais aussi Wmdiscolux
qui se différencie des autres. Il s'agit
d’un plugin affichant un Tux qui
danse au rythme du morceau joué. Il
est possible que celui-ci ne soit plus
présent dans vos depots, notamment
sous Ubuntu Hardy. Si c'est le cas,
on téléchargera les paquets .deb de
xmms et de wndiscotux (en version 1.3.3)
depuis le site de Debian. On pourra
autrement compiler les sources

Aythical Sirens Sunsel
Winamp sur Audacious

14:51 ==

Filg. 4 - Un grand nombre d'inferfaces pour Noatun

in Africa de Winamp sur Xmms

Site d'’Audacious : hitp://
audacious-media-player.org/

" Site de Noatun : http:/f

noatun.kde.org/
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WEB : NOTRE SELECTION

Hormis les célebres sites gnome-look.org et kde-look.org souvent évoqués dans ce magazine
et qui ont d'ailleurs €té présentes dans le numero precedent, il existe pas mal de sites axés
sur le coté « eye candy » que peut presenter le systeme Linux. En voici une petite sélection...

A iruzshot
S Bl ot e Pl R B et PRt |

| MuaLrme sontmeors

M http:/iwww.linuxshot.org

Un site qui repertorie les plus beaux screens-
hots de bureaux Linux. Vous y frouverez une
sélection des screenshots les plus « eye
candy », classes par environnements de bureau
et gestionnaires de fenétres et vous pouvez
bien entendu 'y déposer le votre. Si vous n'étes
pas encore convaincu des possibilités qui vous
sont offertes dans ce domaine, allez y faire un

tour pour vous en mettre plein les yeux !! H

| hitp:/lart.gnome.org/
Voila un autre site indispensable aux

Le célébre site Freshmeat, qui
indexe des projets open source,
dispose d’une section dediée
aux themes graphiques. Une
fois sélectionnée dans le menu
déroulant en haut de la page,
cette section vous propose de
naviguer parmi les thémes selon
les applications (Boot Splash,
Galeon, GKrellM, Mozilla,
MPlayer, Nautilus, XMMS...), les
environnements de bureau ou
les themes graphiques. B

M http:/lwww.youtube.com !

Loin de nous l'idée de vous présen-
ter un site Web aussi célébre | Nous
souhaitons juste souligner ici le fait
gue YouTube regorge de vidéos sur
Compiz et ses nombreux effets. C'est
un bon moyen notamment de visualiser
les tous derniers plugins disponibles,
avant de chercher & les installer sur
votre systeme. B

i : : iz-fusion.org/
ment GNOME. L& aussi, vous retrou- : M http://planet SO PISIHSINLOTG ] 3

verez un choix considérable de fonds
d'écran, de themes de fenétres, de
jeux d’icones, d’écrans de connexion
et de splash screens, le tout d'une
grande qualité graphique. Les fonds
d'écran sont classés par catégorie
(Gnome, Nature, Abstrait ou Autre).
On appréciera la simplicité et la clarté
du site. H
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Pour étre au plus proche de Factualité de

‘Compiz Fusion, le site a consulter réguliere-

ment est sans aucun doute celui-ci. Une poi-

gnée de passionnés sont réunis ici pour vous

faire part de leurs connaissances et décou-

vertes : nouvelles fdhctionnalités-_. nouveaux
- plugins, utilisation, conseils et astuces. B




JAVASCRIPT

introduction
et notions fondamentales

JAVASCRIPT
— INTRODUCTION
ET NOTIONS
FONDAMENTALES

Cet ouvrage s'adresse a tous ceux qui souhai-
tent ajouter des éléments dynamiques & leurs
pages Web. Bien qu'il se destine a l'origine a
des lecteurs experts, son contenu et sa struc-
ture sont tout & fait adaptés a un lectorat qui
débute dans ce langage. La connaissance du
langage (X)HTML est bien entendu indispen-
sable, mais l'auteur n'oublie pas de rappeler
toutes les bases nécessaires pour utiliser cor-
rectement le langage JavaScript.

Comment insérer du JavaScript dans une page
Web ? Quelle est la syntaxe ? Comment décla-
rer les variables ? Quels sont les opérateurs
a utiliser ? Comment déclarer une fonction ?
Toutes les notions de base sont abordées ici.
Sans oublier un incontournable rappel de ce
qu'est la notion d'« objet », JavaScript étant un
langage orienté objet. Un chapitre entier est
consacré aux gestionnaires d'événement, la
clé de linteractivité qui caractérise le langage
JavaScript. Les événements les plus utilisés
sont cités et illustrés par des exemples. Un autre
chapitre est dédié a l'utilisation du JavaScript
dans le contréle de formulaires, 'une des appli-
cations les plus fréquentes de ce langage.”

Le style de l'auteur est tout a fait didactique :
toutes les notions essentielles sont abordées et
illustrées par des exemples pertinents. Ce livre
est tout a fait recommandé pour quicongue sou-
haite apprendre le JavaScript en douceur. B

Maitrisez l¢ Héveloppement ;¥
d'un site Web dynamigtie et interactif

Voila un gros ouvrage, complet, précis, qui
g'adresse a tous les niveaux de connais-
sance. Dans la premiére partie du livre,
aprés un bref historique et un rappel sur
les conventions d’écriture, l'auteur aborde
la mise en ceuvre d’'une base de données
MySQL : introduction aux bases de don-
nées relationnelles, les bases du langage
SQL, utilisation des fonctions MySQL,
construction d’'une base de données, etc.
Dés que vous vous sentez suffisamment
a l'aise pour aller plus loin, vous pourrez
jeter un coup d'ceil au chapitre dédie aux
techniques avancées avec MySQL. La
seconde partie de 'ouvrage est dédiée
a PHP (version 5). Comme l'on peut s'en
douter, I'auteur commence par rappe-
ler les bases du langage PHP, explique
comment utiliser et écrire des fonctions
PHP, comment gérer les erreurs et les
formulaires, comment gérer les sessions,
pour finir par l'interaction avec une base
de données MySQL.

C’est un ouvrage trés dense, une véritable
mine d’informations sur le sujet, illustré de
nombreux exemples, qui le rendent acces-
sibles méme a ceux dont les connaissances
en PHP/MySQL sont encore fraiches... B

GIMP 2.4 - DEBUTER

EN RETOUCHE PHOTO
_ET GRAPHISME LIBRE
(3EME EDITION)

Gimp est sans aucun doute une référence en
matiére de retouche d'images et plus géné-
ralement une référence du Libre. Mais voila,
il n'est pas toujours simple de se servir de
cette immense boite & outils quand 1) On ne
soupgonne méme pas la présence des outils
qui se cachent, 13, tout au fond 2) On n'utilise
pas ses outils de fagon optimale. Alors oui,
vous allez me dire que des guides utilisateur
pour Gimp, il y en a a foison sur Internet,
de méme que des tutoriels en image et des
Scripts-Fu. Mais, franchement, a l'usage,
c’est plutdt bien d'avoir son guide sous la
main, pendant que l'on travaille sur I'écran.

Qui plus est, cette troisiéme édition est
particuliérement soignée. Toutes les nou-
veautés de Gimp 2.4, les techniques de
retouche et de transformation d'images,
sans oublier la maitrise des couleurs et
l'utilisation des calques, tout est passé en
revue au travers de plus de 30 tutoriels.
Les explications sont claires et abon-
damment illustrées et I'on apprécie par-
ticulierement la présence de certaines
annexes en fin d'ouvrage comme le réca-
pitulatif des modes de calque, un point
sur les formats de fichier, ainsi que le réca-
pitulatif des fichiers et répertoires utilises
par Gimp sur votre systéme. Un livre indis-
pensable donc pour tous les passionnés de
retouche photo. B

Auteur : Luc Van Lanecker [ Editions : ENI
— avril 2008 / Collection : TechNote / Livre
(broché) — 17x21cm [ ISBN : 978-2-7460-
4240-7 / Nb de pages : 200 pages [ Prix : 10€/
Niveau : Expert

[Vl Auteur: Olivier Heurtel / Editions : ENI
— mai 2008 / Collection : Ressources
Informatiques / Livre (broché) — 17x21cm /
ISBN : 978-2-7460-4230-8 / Nb de pages :
623 pages / Prix : 27.14€ [ Niveau : Initié &
confirmé

[Vl Auteur : Dimitri Robert / Editions :
Eyrolles — avril 2008 / Collection : Accas
libre / Livre (broché) — 15x20cm / ISBN :
978-2-212-12295-4 / Nb de pages : 316
pages / Prix : 15€ / Niveau : Debutant
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SURVEILLER L'ETAT
DES DISQUES GRACE A SMART

SMART ou Self-Monitoring, Analysis and Reporting Technology
est un ensemble de spécifications définissant une technologie
de surveillance des disques durs. Le but est d’'obtenir des infor-
mations permettant de prévoir les défaillances des disques.

Obtenez ensuite les informations avec sudo smarfct] -a /dev/nda.
Vous y trouverez :

P Les informations générales :

Avec Ubuntu ou Debian, le support de SMART peut étre obtenu
via le paquet smartmontools. Celui-ci propose un systéme complet de
surveillance. Apres installation, il vous suffira de parametrer votre
fetc/smartd.conf et de redémarrer le service.

smartctl version 5.36 [i686-pe-linux-gnul
Copyright (C) 2002-6 Bruce Allen

Home page is htip://smartmontools.sourceforge.net/
Mais les fonctionnalitts SMART permetient également d'obtenir des
informations trés intéressantes sur les disques, méme sans installer
un support complet. Pour cela, utilisez la commande snarictl et activez
SMART pour un disque :

=== START OF INFORMATION SECTION ===

Device Model: Maxtor 6L1GOPH

Serial Mumber:  L3DFIBRH

Firmware Yersion: BAJ41G20

User Capacity: 163 928 684 672 bytes

Device is: ot in smartct] database

ATA Version is: 7

ATA Standard is:  ATA/ATAPRI-7 T13 1532D revision §
Local Time is:  Fri Mar 28 13:22:86 2068 CET
SMART support is: Available - device has SMART capability.
SMART support is: Enabled

$ sudo smartcil -s on /dev/hda
smartet] version 5.36 [1686-pc-linux-gnuj Copyright (C} 2062-6 Bruce Allen
Home page is http://smartmontools.sourceforge.net/

=== START OF ENABLE/DISABLE COMMANDS SECTION ===
SMART Enabled.

UN DEUXIEME SERVEUR X DANS VOTRE SESSION

Vous est-il jamais arrivé, pour une raison x ou y, d'es-
sayer de lancer Gdm, Kdm ou Xdm alors que celui-ci est
deja lance 7 Il peut paraiire evident gqu'on ne puisse pas
en lancer deux en méme temps, mais rien n'est impos-
sible sous Linux ! Avec Xephyr ou encore Xnest, deux
serveurs X, nous pouvons aller dans ce sens. Prenons
I'exemple d’'un environnement de bureau encore en déve-
loppement, par exemple Kde4 a ses debuts. Nous avons
envie de le tester, mais, aprés installation, celui-ci ne
demarre pas ou laisse un bureau bien noir et bien vide !
Pas de souci. Avec Xephyr, on va pouvoir depuis notre
session Kde3 lancer Kde4, soit un deuxiéme serveur X.
Cela ressemble a une émulation, mais ce n'est pas le
cas. En procédant comme ceci avec Xephyr, il sera pos-

Xephyr s'installe depuis le paquet xserver-zephyr. La premiére commande
nous ouvre une fenétre a laquelle on attribue un numéro de serveur X.
Pour ouvrir une application dans celle-ci, nous devons au préalable attri-
buer cette valeur a la variable d'environnement DISPLAY. Les commandes
qui suivront le feront sur le serveur X numéro 1, soit dans Xephyr. Une
fois nos manipulations terminées, on appliquera la valeur 0 & la variable
DISPLAY.

Pour revenir a Gdm, Gnome possede un utilitaire permettant d'ouvrir celui-
ci dans sa session, alors qu'un processus est déja démarré : il s'agit de
gimfiexiserver. En exécutant la commande gdnflexiserver -xnest, une appli-
cation de Gdm
s‘ouvre dans
une nouvelle
fenétre sans

sible de modifier une session et de confroler 'impact des
modifications sans se déconnecter de notre session. Si
aucun probléme n'est rencontré, on pourra alors démar-
rer sur cette session.

Comment procéder ? Cest simple et rapide. Trois petites
commandes suffisent :

Xephyr :1 -ac -screen 808x608 &
DISPLAY=:1
fuse/1ib/kded/bin/startkde &
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gue l'on ait
besoin de se
déconnecter
de sa session.
Cet outil est
assez pratique
pour tester des
themes Gdm
que 'on aura
créés. H




B Les données constructeur :

=== START (F READ SMART DATA SECTION ===
SMART overall-health self-assessment test

General SHART Values:
[l

result

: PASSED

P Les valeurs SMART :

Ici sont mis en évidence, le nombre d’heures de service, le nombre de démarrages
et la température. Les données retournées sont variables selon le modéle de disque.
Ci-dessous, celles d'un QUANTUM FIREBALL EX12.7A :

TRUCS & ASTUCES
R R R

CONNAITRE
LE TYPE D’UN
FICHIER ?

Un fichier inconnu dont vous ne
connaissez pas le type. En général,
n'importe quel navigateur de fichiers
qui se respecte lindiguera pour vous.

En ligne de commande, vous pourrez
SMART Attributes Data Structure revision number: 16 cependant étre content d'utiliser la com-
Vendor Specific SMART Attributes with Taresholds: mande file sur le fichier. file Untitlad
104 ATTRIBUTE_NAKE FLAG  VALUE WORST THRESH TYPE  UPDATED WHENFAILED Yollo fenveyan { HEE e el it
RAH_VALUE JEIF standard 191, vous pourrez étre sQr
3 Spin_Up_Time Ox0027 252 252 063 Pre-fail Always 192 que c'est un fichier JPEG dont vous
4 Start_Stop Count gx0032 253 253 680 Old_age  Always 1 avez oublié I'extension lors de son
5 Reallocated Sector Gt  #x833 253 253 @63  Pre-fail Always f SHEUlEEIEn
6 Read_Channel_Margin pxgEpl 263 253 1@ Pre-fail O0ffline i
7 Seek_Error_Rate gx0@ga 252 252 E@8  0ld_zge  Always i
§ Seek Time Performance Ox@027 248 240 187  Pre-fail Always 3783
9 Power_0On_Hours fxfp32 213 213 698  01d_age  Always 55671
16 Spin_Retry Count gxggzp 252 252 157 Pre-fail Always ]
11 Calibration_Retry_Count fxp@2b 252 252 223 Pre-fall Always ]
12 Power_Cycle_Count fxgg32 753 253 00 01d_age  Always 69
192 Power-0ff_Retract Count 0xB32 253 253 @80  (O1d_age  Always i c ACH ER U N
193 Load _Cycle_Count 0xf632 253 253 0B0  Old_age Always )
194 Temperature_Celsius  0x0932 938 253 06  (O1d_age Always 38 FICHIER /
195 Hardware_CC_Recovered Bxf6fa 253 252 606  0ld_age Always 11868
196 Reallocated_Event Count §xBO@8 253 253 4¢@  0Oid_age (Offline I
g . DOSSIER DANS

NAUTILUS

Comme vous le savez, les fichiers et
dossiers cachés sont reconnaissa-
bles de par le point qui précede leur

nom. La commande |5 -¢ permet de
10# ATTRIBUTE_NAME FLAG  VALUE WORST THRESH TYPE  UPDATED MHEN_FAILED les visualiser dans un terminal ; dans
RAN_VALUE votre navigateur de fichiers graphiques,
1 Raw Read Error Rate  §x029 186 160 020  Pre-fail Offline ] il faut en général activer laffichage des
3 Spin_Up_Time pal 052 06 025 Pre-fail Always 81 et e i
4 Start_Stop_Count Ox0032 899 699 @98 Oldage  Alwiays 973 Z’a";‘; EZZTESS”’;::;‘;'\?;I:’: I‘;"rgr‘;gﬁf
5 fealiocated Sector Ct  Ox0633 108 186 020  Pre-fail Always ] i ;;oint devant, il suffit de
T Seek_Error_Rate OxgEgb 1686 166 @23  Pre-fail Always ] créer un fichier texte nommeé .hidden
9 Power_(n_Hours gx@p12 @55 @55 @A1  01d_age  Always 30189 dans le répertoire contenant I'elément
11 Calibration_Retry_Count 0xf613 166 169 @28  Pre-fail Always i a cacher, et dy inscrire le nom de
12 Power_Cycle_Zount IEE32 099 099 608 Old_age  Always 900 EeideHio
13 Read_Soft_Error Rate  @xaggb 100 160 023  Pre-fail Always i Naviguezc_janslle repertoire en question
109 UDMA_CRC_Ervor Count  BuB0la 208 208 030 Oldage  Always g Efﬁpcai“ua!”fﬁin‘t?ﬁéf’ﬂiii i
qu'avec Nautilus. Si vous lancez un 1s

dans un terminal, vous pourrez tout a

fait visualiser le fichier en question. H

Le nombre d’heures de service est quelque chose de trés important si vous achetez, par
exemple, un disque d’occasion. Il faut savoir qu'un disque dur alimenté et qui fonctionne
est un disque dur qui meurt, in¢luctablement. B
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toto@desktop:~$ emacs

[1i+ Stopped
toto@desktop:~$ bg &1
[11+ emacs &
toto@desktop:~$

toto@desktop:~§ jobs -1
[11+ 7576 Running emacs &

CONNAITRE LES POLICES DE CARACTERES

Lorsque 'on souhaite configurer une appli-
cation, il nous est parfois possible de définir
une police de caractéres (font) spécifique. Il
existe plusieurs outils permettant d’en lister
et d'en rechercher. La commande xisfonts affi-
chera dans le terminal toute une liste de poli-
ces. On affinera la recherche en spécifiant
un modéle a la suite de l'option -fi. Par exem-
ple, x1sfonts -fn "*misc-*normal*-B-*isoB88h0-4+"
donnera le résultat suivant :

Sélection de polices avec Xfontsel

On pourra egalement utiliser tkfont
qui, lui, affiche directement une liste
de polices de caracteres dans lesquel-
les on piochera. Depuis le menu File,
on pourra copier le nom de la police,
visualiser les fichiers d'installation et
visualiser l'affichage des différents
caracteres (possible également avec
un clic droit sur le nom d’'une police).
L'affichage des caracteres s'effectue a
l'aide de la commande xfd qui affiche
sous la forme d'un tableau. B

-nisc-fixed-nedium-r-normal--8-88-75-75-c-50-1508859-9
-misc-fixed-medium-r-normal--8-88-75-75-c-58-1508859-9
-misc-fixed-medium-r-normal--8-88-75-75-c-50-1508859-9

Select a charactar

st b ' uppor Left: 0wb00000 (0.0}
Avec une interface graphique, on pourra T3 it oo i
utiliser xfontsel ou encore thiont. Xfontsel e i
permet de former et de visualiser des poli-
ces de caractéres qu’il sera ensuite facile
de recopier ou de coller a l'aide du bouton
select. La fenétre de I'application contient
deux bandeaux. Le premier permet de choi-
sir les parameétres (famille, dimension, espa-
cement...) de notre police et le deuxieme
affiche le nom de la police ainsi formé. En
dessous, on visualise I'affichage obtenu avec
une telle police de caractéres.

Cm|ElE = e =] N .
ol B0 R M= CE I N AN T R R =

o|lw|olmlal--|ml=]z]|a]<|n|o|e|a|=

clo|lo|=]"|m|lzla|a|a|w]|n|w|=|a|=
ofm|lo|mc|w|lelo|e e |c|m|nfr|o

J|w|z|=lp|-|=|lc|le|w|lo|z|r|-o

olo|o|ml| o s|a]a | fw|m|a]..
B | 2| 2| || [=le|=]a|=|=|s]|1|a|=
o || o e|a]a]e|a]=|=|v]-

|+ |0 [x|n
ofe|=|m




CONNAITRE

SA RESOLUTION D’ECRAN

Une toule petite commande & connaitre pour se remermorer sa résolution d'écran

en une seconde :

fleur@firefly:~$ xrandr -

Screen B: minimum 328 x 200, current 1280 x 1624, maximum 1792 x 1344
VBA-F disconnected (normal left inverted right x axis y axis)
DVI-6 connected 1280x1074+0+0 (normal left inverted right x axis y axis) 376mm x 301mn

1280x1624 bf. 8+ 59.9
1152864 75.8

1024758 4.9 75.1

B3zx624 74.6
BE0x640 75.0
640x488 5.0
1205408 8.1

6.4

66.3
6.0

5-yideo disconnected (mormal left inverted right x axis y axis)

Vous pouvez visualiser toutes les resolutions disponibles pour I'écran connecte.
Uastérisque désigne la résolution qui est active. H

':PASTEBlN COM :
LE DEBOGAGE COLLABORATIF

‘Un fichier de conﬁguratlon vous pose probleme ? Vous ne comprenez pas les

~ pasetvousne parvenez, pas a

trouver lerreur ? Vous aimeriez

 en faire part & fun de vos amis

. quisyconnait ?Lasolution:le

site http:/ipastebin.com.
Vous n'avez qu'a y copier/col-
_ ler les lignes de code gue vous
souhaitez montrer a un tiers,
saisir votre nom (ou un pseudo

peu ;mporte du moment que
. votre ami peut vous identifier 1),

~ sans oublier de sélectionner la

. période pendant laquelle votre

post doit étre conserveé en ligne
{un jour, un mois ou toujours).
Vous pouvez éventueilement

_utiliser la coloration syntaxi-

que en fonction du Iangage
utilisé. Ceci fait, cliguez sur

Send. Votre: post est desor-

- mais con.su_ttab_}e par guicon-
‘que visite le site, y compris
‘votre ami ! Un moyen tout sim-.
ple de s'aider a distance.. H

e messages d'erreur retournés par votre systeme ? Votre programme ne fonctlonne

TRUCS & ASTUCES

LES
« DIVERTISSEMENTS »
DE KDE

Tux dans un vaisseau !

Pour se changer les idées pendant que I'on
travaille sur son ordinateur, on peut instal-
ler le paquet kdetoys qui comprend quelques
« amusements » de bureau :

P lodo qui mesure la distance parcourue par
votre souris ;

B inor une petite bestiole, chat, diable,
Tux ou fantdme, qui se proméne sur
votre bureau et s'installe sur les fenétres
actives ;

P Lieatime s'installe dans la barre des notifi-
cations pour surveiller le temps d'infusion
de votre the ;

B lworldclock, une horloge planétaire ;

P {iux, un écran de veille présentant Tux
dans 'espace. H

Les amusements de Kde
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JOUEZ AVEC
OPENOFFICE

Petit moment de détente pendant l'utilisation
d'OpenOffice grace a ces quelques scripts
de jeu. Ces scripts utilisent des macros que

Commencer. On peut placer cing cou-
leurs. Pour former une combinaison, il
suffit de cliquer sur une couleur, puis
sur une position. On clique ensuite
sur Tester pour voir s'afficher, sur la
droite, la combinaison et le résultat de
couleurs bien placées et mal placées

(Fig. 1).

(Sudoku) plusieurs grilles sont pro-
posees tout a droite de la feuille
Affichage. On en sélectionne une
gue l'on copie sur la grille 82:J16.
C’est sur cette grille que l'on travaille.
Les informations a cété de la grille
permettent de nous aider a la remplir.
Si on bloque vraiment, on utilisera les
boutons départs et suite qui permet-

g?:b\;e:dd?ggigg:l\;grhﬁgizcggaggzudrﬁg to‘;l: > ITe s{cj:riPt BOOolier est unlpetntjgu ou tent de remplir plus ou moins com-
i e ﬂp_:’ Fon doit ramasser les boules S pletement la grille. Les explications
S SR s bent en bougeant un panier a l'aide sur ces aides sont présentes dans la
Options -> Sécurité -> Sécurité des macros des touches [fléche droite] et [fléche . i :
Gl i TR y feuille Explications (Fig. 3). H
et on choisit Niveau de sécurité moyen. Ce gauche]. Les meilleurs scores sont
niveau nous demandera a l'ouverture d’un conservés dans la troisiéme page du
document comprenant des macros de les tableur (Fig. 2). ; K
R P blourdfi ) v] Ces scripts sont téléchargeables a
P> Un Sudoku avec aide a la résolution cette adresse : http://fr.openoffice.

Voici quatre jeux présents sur le site
d'OpenOffice.org :

» Jouez au MasterMind de deux facons :
soit en aidant I'ordinateur a trouver la
bonne combinaison, soit de la fagon tra-
ditionnelle en faisant chauffer vos ménin-
ges. Dans le script Haster, on commence
le jeu en page trois avec le bouton Lancer
le jeu qui nous ouvre une nouvelle fené-
tre. Une combinaison de couleurs consti-
tuant I'énigme s’affiche avec le bouton
Commencer et l'ordinateur fait une propo-
sition. A nous de Iui indiquer les couleurs
bien placées et celles présentes, mais
mal placées...

P> Master2 est un peu plus intéressant, puis-
que c'est a nous de jouer. En cliguant sur
le bouton Lancer le jeu, une fenétre de jeu
se lance en page trois. Dans la nouvelle
fenétre, on sélectionne la difficulté du jeu
en fonction du nombre de cases consti-
tuant la combinaison, puis on clique sur
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